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SAFETY PRECAUTIONS
(Make sure to read before training)

When designing a system, always read the relevant manuals and give due consideration to safety.
In addition, pay careful attention to the following points for proper handling during training.

[Precautions during training]
Danger

● To prevent electric shock, do not touch the terminal block while the power is supplied.

● When opening the safety cover, turn off the power, or make sure that it is sufficiently safe.

Caution
● Follow the instructor's directions during training.

● Do not remove training machine units or change wiring without permission.
Doing so could cause a breakdown, faulty operation, injury, or fire.

● Turn the power OFF before mounting or removing a unit.
Doing so while the current is ON could cause a breakdown or electric shock.

● If the training machine emits a strange odour or sound, press the "Power Switch" or the "Emergency
Switch" to stop the machine.

● If any trouble occurs, contact the instructor right away.
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REVISIONS

* The textbook number is given on the bottom left of the back cover.

2018 MITSUBISHI ELECTRIC CORPORATION
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February 
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SH(NA)-081926ENG-B Added or modified parts
Cover, Appendix.10

This textbook confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. 
Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may 
occur as a result of using the contents noted in this textbook.
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Introduction

This textbook is a "basic edition".
Practice how to use Mitsubishi Graphic Operation Terminal exercising the training in this textbook.

[Basic edition]
Learn basic subjects relating to Mitsubishi graphic operation terminal skills.
Course content:

1. GOT2000 series function, performance and system configuration
2. GOT basic operation and setup procedures
3. Figure and basic object function

(Text, numerical display, numerical input, lamp display, comment display, touch switch, etc.)
4. Sequence program monitor (ladder) and device monitor functions

[Practice edition]
Learn efficient methods to create control screens using Mitsubishi Graphic Operation Terminal.
Course content:

1. GOT operation and GT Designer3 basic operation
2. How to use advanced object functions

(Layer, graph, comment display, language switching, library, parts movement, alarm function)
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Relevant manuals

The following table lists the relevant manuals for this product.
Refer to this table as needed.

* Stored in GT Works3 in PDF Format.

Copyright notice

GOT is a registered trademark of Mitsubishi Electric Corporation.
Other company and product names herein are either trademarks or registered trademarks of their respective owners.

Manual title
Manual number

(model name code)

(1) GT Works3 Installation Instructions Included in the product

(2)
GT Designer3 (GOT2000) Screen Design Manual

(Sold separately)*
SH-081220ENG

(1D7ML9)

(3) GOT2000 Series MES Interface Function Manual For GT Works3 Version1 SH-081228ENG

(4)

GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1
(Sold separately)*

SH-081197ENG
(1D7MJ8)

GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) For GT Works3 Version1 SH-081198ENG

GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) For GT Works3 Version1 SH-081199ENG

GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For 
GT Works3 Version1

SH-081200ENG

(5)

GOT2000 Series User's Manual (Hardware)
(Sold separately)*

SH-081194ENG
(1D7MJ5)

GOT2000 Series User's Manual (Utility)
(Sold separately)*

SH-081195ENG
(1D7MJ6)

GOT2000 Series User's Manual (Monitor)
(Sold separately)*

SH-081196ENG
(1D7MJ7)

(6) GT Converter2 Version3 Operating Manual For GT Works3
SH-080862ENG

(1D7MB2)

(7) GT SoftGOT2000 Version1 Operating Manual SH-081201ENG
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1. What is the GOT?

1.1 About the GOT
The GOT (Graphic Operation Terminal) is an electronic device used as an electronic operation panel to operate/display 
different operations such as switch operation, lamp display, data display and message display, which had been 
conventionally implemented with a control box.

Advantages of using the GOT
(1) Downsizing the operation panel

The GOT replaces physical switches and lamps with graphical ones, saving I/O points on the PLC and reduces 
the size of operation panel. 

(2) Reducing wiring costs
The graphical user interface of the GOT eliminates the time and cost of wiring components inside the operation 
panel.

(3) Standardizing operation panels
GOTs are flexible, allowing you to build or modify projects without changing the PLC program or system wiring, 
which facilitates standardization of operation panels.

(4) Value-added HMI (Human Machine Interface)
GOT can also display graphics, text and alarms in addition to switches and lamps, contributing the value 
addition to entire equipment.

POINTPOINTPOINT

What is the GOT?

"G" …Graphic  "O" …Operation  "T" …Terminal

The GOT (Graphic Operation Terminal) is a programmable display manufactured by Mitsubishi Electric 
Corporation.

GOT

Space saving

Cost savingConventional 
operation panel
1. What is the GOT?
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1.2 Procedures for monitoring the PLC CPU by GOT

Stop

Data

Run

0

Run lamp

Run Run lampStop

Data 600

GOT

Personal computer

Personal computer

USB cable

(Ethernet cable)

Run
Run lamp

Stop

Data 0

GOT

Run Run lamp
Stop

Data 600

PLC CPU

1) Create a screen to be displayed 

in GOT using GT Designer3, 

software

2) Transfer the created screen 

data to GOT.

3) Start monitoring after 

connecting to PLC CPU.

Display panel figures known as 

objects, such as the switch, lamp, 

and numerical display, etc., are 

pasted to create the screen.
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1.3 GOT2000 series features
(1) High-speed processing

Easily operate the screens even during high-load processing, such as logging, script, alarm or device data 
transfer. (Monitor performance is 2-fold or higher*1)

*1 Compared to GOT1000 series GT16 models.

(2) Increased memory capacity

• Design screens without worrying about the data capacity.
• The compression technology allows up to 128 MB of actual space to be used without an SD card.*1

*1 An SD card may be required depending on the project data.

(3) Easy operations with gesture function (GT27 only)

Use intuitive gestures to zoom in/out and to scroll.
• Screen Gestures

Zoom in to easily operate small and hard to reach switches. After zooming in, scroll the display to show the 
area you want to operate.

• Object Gestures
Scroll or zoom in and out the displayed contents of the objects by gestures such as a flick.
(Applicable objects: Alarm display (user), alarm display (system), simple alarm display, historical trend 
graph, historical data list display, and document display)

(4) Crisp display with outline fonts and PNG images
Customize screen designs using parts library and fonts that are crisp even when enlarged or reduced.

(5) Enhanced lineup (The white model is only for GT27 and GT25.)
• The new white model GOT provides an additional color option.
• The flush frame without the USB port can be cleaned very easily.
• The GOT can be installed vertically for extra flexibility when installed in confined spaces.

(6) 2-point press operation prevents incorrect operations (GT27 only)
Prevent accidental operations by designating two pressing points for critical operations.

For the details of the features of the GOT2000 series, refer to the following manuals.

GOT2000 Series User's Manual (Hardware)

GOT2000 Series User's Manual (Utility)

GOT2000 Series User's Manual (Monitor)
1. What is the GOT?
1.3 GOT2000 series features
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1.4 GOT function list
The following table shows the function list for each GOT model.
For the details of functions, supported controllers, and connection types, please refer to the GOT2000 series manual or 
Help.

●: Supported —: Not supported

Category Function name Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000

H
ar

dw
ar

e 
sp

ec
ifi

ca
tio

ns

Sc
re

en
 s

iz
e

15" ● — — —

12.1" ● ● — —

10.4" ● ● — —

8.4" ● ● — —

5.7" ● — ● —

4.3" Wide — — ● —

4.5" — — ● —

3.8" — — ● —

R
es

ol
ut

io
n

XGA 1024 × 768 ● — —

Flexible 
resolution

640 to 1920 × 
480 to 1200

SVGA 800 × 600 ● ● —

VGA 640 × 480 ● ● —

QVGA 320 × 240 — — ●

Other — —

GT2104-R: 480 
× 272

GT2104-P: 384 
× 128

GT2103: 320 × 
128

C
ol

or

65536 colors ● ● ● ●

Monochrome (black/white) 32 
shade grayscale

— — ● —

Touch panel simultaneous press (two 
points)

● — — —

Human sensor ●*10 — — —

M
em

or
y

Memory for storage (ROM)
Other than 

below: 57 MB
GT2705: 32 MB

32 MB

GT2105, 
GT2104-R: 9 MB
GT2104-P: 6 MB
GT2103: 3 MB

57 MB

Memory for operation (RAM)
Other than 

below: 128 MB
GT2705: 80 MB

80 MB — —

In
te

rfa
ce

RS-232 ● ● ● ●*12

RS-422/485 ● ● ● ●*12

Ethernet ● ● ● ●*11

USB host ● ● — ●*13

USB device ● ● ● —

SD card slot ● ● ●*14 ●*13

Extension interface, side 
interface

Communication units, 
option units ●*11 ●*11 — ●*11
1 - 4 1. What is the GOT?
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Sc
re

en
 d

es
ig

n

Fi
gu

re
/o

bj
ec

t f
un

ct
io

ns

Figure ● ● ● ●

Logo text ● ● ● ●

Touch switch ● ● ● ●

Lamp ● ● ● ●

Numerical display, numerical 
input

● ● ● ●

Text display, text input ● ● ● ●

Date display, time display (Battery) ● ● ● ●

Comment display ● ● ● ●

Parts display
(SD card or USB 
memory)

● ● ●*16 ●

Parts movement
(SD card or USB 
memory)

● ● ●*16 ●

Historical data list display
(SD card or USB 
memory)

● ● ●*16 ●

Simple alarm display ● ● ● ●

System alarm display ● ● — ●

Alarm display (user)
(SD card, USB 
memory, or battery)

● ● ●*16 ●

Alarm display (system)
(SD card, USB 
memory, or battery)

● ● — ●

Recipe display (record list) ● ● — ●

Line graph ● ● ● ●

Trend graph ● ● ● ●

Bar graph ● ● ● ●

Statistic bar graph ● ● ● ●

Statistic pie graph ● ● ● ●

Scatter graph ● ● ● ●

Historical trend graph
(SD card or USB 
memory)

● ● ●*16 ●

Graphical meter ● ● — ●

Level ● ● ● ●

Panelmeter ● ● ● ●

Slider ● ● ● ●

Document display SD card ● ● — ●

●: Supported —: Not supported

Category Function name Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
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 p
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ba

ck
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 G
O

T

Logging
(SD card, USB 
memory, or battery)

● ● ●*6 ●

Recipe
(SD card or USB 
memory)

● ● ●*16 ●

Device data transfer ● ● ● ●

Trigger action ● ● ● ●

Time action (SD card or USB 
memory)

● ● ● ●

Hard 
copy

File output SD card or USB 
memory

● ● ●*6 ●

Serial printer output ● ● ●*6 ●*2

PictBridge printer 
output Printer unit ● ● — ●*2

Project, screen script ● ● ● ●

Object script ● ● — ●

●: Supported —: Not supported

Category Function name Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
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Sc
re

en
 d

es
ig

n

Fu
nc

tio
ns

 u
se

d 
w

ith
 p

er
ip

he
ra

l d
ev

ic
es

Barcode function ● ● ●*6 ●

RFID function ● ● ●*6 ●

GOT Mobile function License, (SD card) ● ● — —

VNC server function License ● ● — —

Remote personal computer 
operation function (Ethernet) License ● ● — —

Remote personal computer 
operation function (Serial)

RGB input unit or 
Video/RGB input unit ●*8 — — —

Video display function
Video input or Video/
RGB input unit ●*8 — — —

RGB display function
RGB input unit or 
Video/RGB input unit ●*8 — — —

Multimedia function
Multimedia unit, CF 
card ●*8 — — —

External I/O function External I/O unit ● ● — —

Operation panel function External I/O unit ● ● — ●

RGB output function RGB output unit ●*8 — — —

Report 
function

Serial printer output (SD card or USB 
memory)

● ● ●*6 ●*3

PictBridge printer 
output

SD card or USB 
memory, printer unit

● ● — ●*3

Sound output function Sound output unit ● ● — ●

Server function, client function ● ● — —

Mail send function ● ● — ●

FTP server function
(SD card or USB 
memory) ● ● ●*15 —

File transfer function (FTP 
transfer)

SD card or USB 
memory ● ● ●*15 —

File transfer function (GOT 
internal transfer)

SD card or USB 
memory ● ● — —

MES interface function License, (SD card) ● ● — —

Wireless LAN function
(Wireless LAN 
communication unit)

● ● — —

USB mouse, USB keyboard ● ● — ●

●: Supported —: Not supported

Category Function name Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
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O

T 
fu
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tio

ns

Base screen ● ● ● ●

Overlap window ● ● ● ●

Superimpose window ● ● ● ●

Dialog window ● ● ● ●

Mobile screen ● ● — —

Key window ● ● ● ●

Language switching ● ● ● ●

System information ● ● ● ●

Operator authentication 
function

(SD card or USB 
memory)

● ● ●*16 ●

Operation log SD card or USB 
memory

● ● — ●

Startup logo ● ● ● ●

KANA KANJI conversion ● ● — ●

FA transparent ● ● ● —

SoftGOT-GOT link License key ● ● — ●

Backup/Restoration
SD card or USB 
memory

● ● ●*6 —

Multi-channel function

●*9

Four channels 
(Up to three 

units)

●
Four 

channels (Up 
to three units)

●*6

Two channels 
(No units can be 

mounted.)

—

Station No. switching ● ● ● ●

GOT network interaction ● ● — ●

Screen gesture function ● — — —

Object gesture function ● — — —

Security key authentication 
function

● ● — —

IP filter function ● ● — —

File manager
(SD card or USB 
memory) ● ● — —

Vertical display *5
●

(Rotate 90° to 
left)

●
(Rotate 90° 

to left)

●
(Rotate 90° to 

right)
—

●: Supported —: Not supported

Category Function name Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
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*1 Necessary units when using GT27, GT25, GT23, or GT21 are shown. Parenthesized devices are required depending on 
conditions of use.

*2 Data is output to the printer that is recognized by the personal computer.
*3 CSV files are saved in the virtual drive of the personal computer so that it is recommended to output the files to printers.
*4 Only the GOTs with SVGA or higher resolution are supported.
*5 Remote personal computer operation function (Ethernet) cannot be used.

The following screens are displayed horizontally:
Utility screen, monitor and data management screens that are displayed from the utility screen (sequence program monitor), 
video camera images in the multimedia and video display functions
For the details of other GOT operations when placed vertically, please refer to the appropriate manuals or Help.

*6 Excluding GT2103-PMBLS.
*7 GT2104-RTBD only.
*8 Excluding GT2705.
*9 To use multiple units such as extension units, barcode readers, or RFID controllers with a GT2705, the total current consumption 

of the units should be less than the value that the GT2705 can provide. For the details, please refer to an appropriate GOT2000 
series manual.

*10 GT2715, GT2712 only.
*11 For the applicable units and interface boards, please refer to appropriate manuals.
*12 Use the standard interface of the personal computer
*13 When using functions that require a USB memory or SD memory card, a virtual drive in the personal computer is used.
*14 GT2103 requires an SD memory card unit (GT21-03SDCD) separately. GT2103-PMBLS does not allow for SD cards.
*15 GT2104-R, GT2103-PMBD only.
*16 On GT2103-PMBLS, only the functions that do not require SD card can be used.

M
ai

nt
en

an
ce

 fu
nc

tio
ns

Device monitor ● ● ● —

Sequence program monitor
(Ladder)

SD card or USB 
memory

● ● — —

Sequence program monitor 
(SFC)

SD card or USB 
memory

● ● — —

Network monitor ● ● — —

Intelligent module monitor ● ● — —

Drive recorder
(SD card or USB 
memory)

● ● — —

Servo amplifier monitor ● ● — —

R motion monitor ● ● — —

Q motion monitor ● ● — —

Motion SFC monitor
SD card or USB 
memory

● ● — —

CNC monitor ●*4 ●*4 — —

CNC data I/O
SD card or USB 
memory ●*4 ●*4 — —

CNC machining program edit ●*4 ●*4 — —

Log viewer
(SD card or USB 
memory)

● ● — —

FX list editor ● ● ●*7 —

FX ladder monitor ● ● — —

iQSS utility SD card or USB 
memory

● ● — —

System launcher ● ● — —

MELSEC-L troubleshooting ● ● — —

●: Supported —: Not supported

Category Function name Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
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1.5 Equipment required for using GOT
 GOT external appearance and interface

[Front face]

[Rear face]

iF Design 
Award 
2014

* GT27 and GT25 only. The USB host is on 
the rear face for the white model.

* The USB device is on the rear face for the 
white model and GT21.

* GT27 (15" and 12.1" only)

The GOT detects an operator and 
displays its screen automatically.
When no one is around, 
the backlight turns off to 
save energy.

The stylish and simple design with 
a linear motif is sleek and 
complements any machine design.

Data can be transferred without 
opening the cabinet.

The long life cycle minimizes 
maintenance and replacement costs.

Screen data can be transferred and 
data in the GOT can be 
retrieved using a USB memory.
A USB mouse and keyboard 
can be connected.

Communication and option units 
can be mounted.

Various FA devices, barcode reader, 
serial printer can be connected.

A large amount of data including 
alarms and logging data 
can be saved.

Various FA devices can be 
connected.

Up to four types of controllers from 
different manufacturers* can be 
connected simultaneously 
by Ethernet.

A wireless LAN communication unit 
can be mounted.

A USB memory can be mounted 
to save alarms and logging data.
A USB mouse and keyboard can 
be connected.

* GT27 and GT25 only

* This image is GT2712.

* Up to two types of controllers for GT21

* GT27 and GT25 only

*GT27 and GT25 only

The GOT can be connected 
to a personal computer 
to transfer data.
* White model only

Human sensor Simple design

LED backlight

USB device

USB host

Extension interface

Ethernet

RS-422/485

SD card slot

Side interface

USB hostRS-232

USB device
1 - 10 1. What is the GOT?
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 Required equipment
The equipment required to connect the GOT to the PLC CPU is shown below.

*1 The communication unit varies depending on the PLC connection type.
When the GOT is connected with a PLC by using an interface built in the GOT (Ethernet interface, RS-232 interface, or RS-422/
485 interface), no communication unit is required.

*2 The connection cable varies depending on the connection type.
The connection cables used for each connection type are shown below.

*1 The connection cables are exclusive products. (Only the Ethernet connection cable is commercially available.)

Equipment name Application

[1] Personal computer Device to be used for writing the data stored in GOT.

[2] GT Works3 Device to be used for writing the data stored in GOT.

[3] USB cable Cable to connect with the personal computer and GOT.

[4] Communication unit Unit to connect the PLC CPU connection cable.*1

[5] Connection cable Cable to connect with the GOT and PLC CPU.*2

Connection type Connection cable*1

Ethernet connection, CC-Link IE Field Network 
connection

Ethernet cable

Direct CPU connection
RS-232 cable

For RS-232 connection

For RS-422 connection
RS-422 cable
RS-232/422 conversion cable

Computer Link connection
RS-232 cable

For RS-232 connection

For RS-422 connection
RS-422 cable
RS-232/422 conversion Cable

Bus connection Bus connection cable

CC-Link connection CC-Link dedicated cable

MELSECNET/H connection, MELSECNET/10 
connection, CC-Link IE Controller Network connection Optical fiber cable

For optical fiber cable connection

For coaxial cable connection Coaxial cable

Communication unitGT Works3

Personal 

computer

PLC

USB cable Connection cable

[5]

GOT2000
[1]

[2]

[3]

[4]
1. What is the GOT?
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 What is GT Designer3
GT Designer3 is software to create screens for GOT2000 series and GOT1000 series.
This software enables you to create and simulate a project, and transfer data between the GOT and a personal 
computer.

GT Designer3 consists of the following drawing software.
• GT Designer3 (GOT2000): Drawing software for GOT2000 series
• GT Designer3 (GOT1000): Drawing software for GOT1000 series

The supported drawing software is started for making project, depending on the selection of GOT type. The title 
bar of the window indicates which drawing software you are operating.

This textbook uses GT Designer3 (GOT2000) for explanation.

Personal computer (GT Designer3)

Data transfer

GOT

Project creation 

Simulation

The name of the drawing software in operation is displayed.
1 - 12 1. What is the GOT?
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 Operating environment for GT Designer3

Item Description

Model Personal computer that Windows runs on.

OS (English, Simplified 
Chinese, Traditional Chinese, 
Korean, German, or Italian 
version)

• Microsoft Windows 10 Enterprise (32 bit, 64 bit)*1*2*4*6

• Microsoft Windows 10 Pro (32 bit, 64 bit)*1*2*4*6

• Microsoft Windows 10 Home (32 bit, 64 bit)*1*2*4

• Microsoft Windows 8.1 Enterprise (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8.1 Pro (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8.1 (32 bit, 64 bit)*1*2*4*5

• Microsoft Windows 8 Enterprise (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8 Pro (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8 (32 bit, 64 bit)*1*2*4*5

• Microsoft Windows 7 Ultimate (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Enterprise (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Professional (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Home Premium (32 bit, 64 bit)*1*2*4

• Microsoft Windows 7 Starter (32 bit)*1*2

• Microsoft Windows Vista Ultimate (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Enterprise (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Business (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Home Premium (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Home Basic (32 bit) Service Pack1 or later*1*2

• Microsoft Windows XP Professional (32 bit) Service Pack3*1*2

• Microsoft Windows XP Home Edition (32 bit) Service Pack3*1*2

CPU Intel Core 2 Duo Processor 2.0 GHz or more recommended.

Memory • For a 64-bit OS: 2 GB or more recommended
• For a 32-bit OS: 1 GB or more recommended

Display Resolution XGA (1024 × 768 dots) or higher.

Hard disk space
• For installation: 5 GB or more recommended
• For execution: 512 MB or more recommended

Display color High Color (16 bits) or higher.
1. What is the GOT?
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*1 For installation, the standard user or administrator account is required.
For installation on Windows XP, the administrator authority is required.
To interact GT Designer3 with other MELSOFT applications which are used under the administrator authority, use GT Designer3 
under the administrator authority.

*2 The following functions are not supported.
• Application start in Windows compatibility mode
• Fast user switching
• Change your desktop themes (fonts)
• Remote desktop
• DPI setting other than the normal size (For Windows XP and Windows Vista)
• Setting the size of text and illustrations on the screen to any size other than [Small-100%] (For Windows 10, Windows 8.1, 

Windows 8, and Windows 7)
*3 Windows XP Mode is not supported.
*4 The touch feature is not supported.
*5 Modern UI Style is not supported.
*6 Hyper-V is not supported.
*7 Versions 8.50, 8.71, and 9.15 of the software are validated by our company.
*8 The following shows the software versions that simulates the PLC CPU.

Other software

To use the simulation function on a personal computer, one of the following software applications must be 
installed.
• GX Simulator3 (included in GX Works3 Version1.007H or later)
• GX Simulator2 (included in GX Works2 Version1.12N or later)
• GX Simulator Version 5.00A or later
• MT Simulator2 Version1.70Y or later

The required software version depends on the controller to be simulated.*8

To use the document display function, the following software must be installed.
• Document Converter
• Ghostscript GPL8.50 to 9.15*7 (Free software)

To use the files of Microsoft Word, Microsoft Excel, or Microsoft PowerPoint, the following software also 
must be installed.
• PostScript printer driver supplied with Windows
• Microsoft Office 2003, Microsoft Office XP, Microsoft Office 2000 (Required only when the files of 

Microsoft Word, Microsoft Excel, or Microsoft PowerPoint are used)

To use the remote personal computer operation function (Ethernet), the following software must be 
installed.
• VNC server software (UltraVNC 1.0.5, 1.0.5.6, 1.1.9.6, or 1.2.1.1)
• Windows terminal server function (Windows Server 2003)
• Terminal service function software (RDPGateway(rdp2vnc))

To use the remote personal computer operation function (Serial), one of the following software must be 
installed.
• Remote Personal Computer Operation Driver (MES_2X)
• Remote Personal Computer Operation Driver (TSC-DD)

Use the software compatible with the personal computer OS used for the remote personal computer 
operation function (Serial).

To use the VNC server function, the following software must be installed.
• VNC client software (UltraVNC1.1.9.6, 1.0.9.6.2, or 1.0.8.2)

To use the multimedia function, the following software must be installed.
• Multimedia Interaction Tool
• Multimedia Interaction FTP Service
• Quick Time Player or QuickTime 7 Pro

To display Help, the following software must be installed.
• Internet Explorer7 or later recommended

To display PDF manuals, the following software must be installed.
• Adobe Reader7 or later recommended

Other hardware

Use the hardware compatible with the above OS.
• For installation: mouse, keyboard, DVD-ROM drive
• For execution: mouse, keyboard
• For printing: printer

Use the following hardware when required.
• For simulation (Only when outputting the buzzer sound): Sound card, speaker

Item Description
1 - 14 1. What is the GOT?
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• Software version of GX Simulator

• Software version of GX Simulator2

PLC CPU compatible with simulation
Software version of 

GX Simulator

QCPU (A mode), ACPU, motion controller CPU (A series) Version5.00A or later

QnACPU Version5.40E or later

FX0 series, FX0N series, FX0S series, FX1 series, FX1N series, FX1NC 
series, FX1S series, FX2 series, FX2C series, FX2N series, FX2NC series

Version5.40E or later

QCPU (Q mode) (except for Q00J, Q00, and Q01CPU) Version5.40E or later

Q00JCPU, Q00CPU, Q01CPU Version6.00A or later

Q02PHCPU, Q06PHCPU Version7.20W or later

Q12PHCPU, Q25PHCPU Version6.10L or later

Q12PRHCPU, Q25PRHCPU Version6.20W or later

FX3U series, FX3UC series Version7.08J or later

FX3G series Version7.22Y or later

Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, Q04UDHCPU, 
Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, Q26UDHCPU, 
Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, 
Q13UDEHCPU, Q20UDEHCPU, Q26UDEHCPU

Version7.23Z or later

PLC CPU compatible with simulation
Software version of 

GX Simulator

FX0 series, FX0N series, FX0S series, FX1 series, FX1N series, FX1NC 
series, FX1S series, FX2 series, FX2C series, FX2N series, FX2NC series

Version1.24A or later

QCPU (Q mode) (except for Q00J, Q00, and Q01CPU) Version1.12N or later

Q00JCPU, Q00CPU, Q01CPU Version1.12N or later

QnPHCPU Version1.87R or later

FX3U, FX3UC, FX3G series Version1.24A or later

FX3GC series Version1.77F or later

FX3S series Version1.492N or later

Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, Q04UDHCPU, 
Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, Q26UDHCPU, 
Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, 
Q13UDEHCPU, Q20UDEHCPU, Q26UDEHCPU

Version1.12N or later

Q03UDVCPU, Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU Version1.492N or later

L02CPU, L26CPU-BT Version1.24A or later

L02CPU-P, L26CPU-PBT Version1.62Q or later

L06CPU Version1.98C or later

L02SCPU, L26CPU Version1.98C or later

L02SCPU-P, L06CPU-P, L26CPU-P Version1.492N or later

Q50UDEHCPU, Q100UDEHCPU Version1.31H or later
1. What is the GOT?
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• Software version of GX Simulator3

• Software version of MT Simulator2

PLC CPU compatible with simulation
Software version of 

GX Simulator3

R04CPU, R08CPU, R16CPU, R32CPU, R120CPU Version1.007H or later

R08PCPU, R16PCPU, R32PCPU, R120PCPU Version1.010L or later

R08SFCPU, R16SFCPU, R32SFCPU, R120SFCPU, R04ENCPU, 
R08ENCPU, R16ENCPU, R32ENCPU, R120ENCPU

Version1.020W or later

FX5U series, FX5UC series Version1.025B or later

PLC CPU compatible with simulation
Software version of 

MT Simulator2

Q172DSCPU, Q173DSCPU Version1.70Y or later
1 - 16 1. What is the GOT?
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 List of software applications included in GT Works3
(a) GT Designer3 (GOT2000) Version1

This software is used to create screens for GOT2000 series.
(b) GT Designer3 (GOT1000) Version1

This software is used to create screens for GOT1000 series.
(c) GT Designer2 Classic

This software is used to create screens for GOT900 series.
(d) GT Simulator3 Version1

This software is used to simulate the operation of a GOT2000/GOT1000/GOT900 series GOT on a 
personal computer by connecting with GX Simulator or a PLC CPU.

(e) GT SoftGOT2000 Version1
This software has the functions equivalent to the functions of the GOT2000 series and is used to display 
lamps, data, and messages on a personal computer and panel controllers.

(f) GT SoftGOT1000 Version3
This software has the functions equivalent to the functions of the GOT1000 series and is used to display 
lamps, data, and messages on a personal computer or the like.

(g) GT Converter2 Version3
This software is used to convert the project data created by existing screen editor software into those 
available for use on GT Designer3 or GT Designer2 Classic.

(h) Document Converter
This software is used to convert documents created on a personal computer (such as Microsoft Word and 
Microsoft Excel) to GOT-compatible formats.

(i) Data Transfer Tool, Multimedia Interaction Tool, and other tools
(j) Help and manual list

This list displays the PDF versions of the relevant manuals.
1. What is the GOT?
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1.6 Applicable connection type between the GOT 
and the PLC CPU

The GOT can perform monitoring by connecting it to the PLC using the following connection types.
Therefore, the connection type suitable for the system configuration or usage can be selected.

(1) Ethernet connection
GOT can be connected to the Ethernet connection.
The networks can be configured with commercially available products such as hubs and cables.

(2) Direct CPU connection
Direct CPU connection is a method using a RS-232/RS-422 to connect a GOT.
Because no other equipment is required to connect the GOT to the PLC, this is the most economical connection 
type.

(3) Computer link connection
Computer link connection is a method using a computer link module or a serial communication module mounted 
together with a PLC CPU.
Connection of multiple GOTs is available depending on the model type of the computer link module or the serial 
communication module mounted with the PLC CPU.

Hub

GOT QCPU QCPU QCPU

PLC
GOT

Maximum distance when a RS-232 cable is used: 3 m
Maximum distance when a RS-422 cable is used: 30.5 m*

* Total length of a RS-422 connector conversion cable and a RS-422 cable.

Serial communication unit

GOTGOT GOT

PLC

Maximum distance when a RS-232 cable is used: 15 m
Maximum distance when a RS-422 cable is used: 1200 m
1 - 18 1. What is the GOT?
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(4) Bus connection
Bus connection is a method using an extension connector of a base unit to connect a GOT (connection by I/O 
bus).
This connection type enables the fastest response to a PLC CPU among all GOT connection types.
By occupying one stage of the extension base unit, up to maximum five GOTs can be connected.*1

*1  QCPU (High Performance model or models in higher class)

(5) CC-Link IE Controller Network, MELSECNET/H, or MELSECNET/10 connection
The GOT is connected to a CC-Link IE Controller Network system, MELSECNET/H network system , or 
MELSECNET/10 (PLC to PLC) network system as a normal station.
The cyclic data of the CC-Link IE Controller Network, MELSECNET/H, or MELSECNET/10 (PLC to PLC 
network) and the devices of PLC CPUs in the same network can be monitored.

(6) CC-Link connection
GOT can be connected to the network as an intelligent device station of the CC-Link System.
The cyclic data of the CC-Link System and devices of the PLC CPU on the master or local station can be 
monitored.

Connection to multiple GOTs is possible.

QCPU
GOT GOTGOT

Maximum distance: 37 m

GOT

GOT GOT

QCPU

Optical loop system

QCPU
GOT GOT

QCPU

Coaxial bus system

QCPU

QCPU GOT
Local station

Partner manufacturer
CC-Link module

Remote I/O station
1. What is the GOT?
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(7) CC-Link IE Field Network connection
CC-Link IE Field Network is a high-speed and large-capacity Field Network that handles a mix of control data 
and management data of devices. Additionally, distribution of controllers, I/O control, motion control, and safety 
functions can be seamlessly set.

(8) Applicable connections with third party PLCs
GOT can monitor third party PLCs.
The system construction without regarding to PLC manufacture is available.
Refer to the product catalogue or manual about PLC models that can be connected.

Partner manufacturer

PLC

Hub

GOT QCPU

PLC
1 - 20 1. What is the GOT?
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1.7 Connection to equipment other than the PLC
(1) Microcomputer

Data can be read and written from a personal computer, microcomputer board, PLC to GOT virtual devices.

(2) Bar-code reader
The data read with the bar-code reader can be written to PLC CPU.

(3) Temperature controller, Inverter, Servo amplifier, CNC
The controllers can be monitored and modification in parameters is also possible.
1. What is the GOT?
1.7 Connection to equipment other than the PLC
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1.8 Multi-channel function
The GOT which installs multiple communication drivers can monitor up to maximum four (four channels) controllers (PLC 
CPU, temperature controller, inverter, etc.).

To use the multi-channel function, read the GOT2000 Series Connection Manual (Mitsubishi Electric Products) and 
select systems and the communication units to be mounted on a GOT.

Install multiple 

communication drivers.

Monitor devices 

for controllers

Channel No. 1

Channel No. 2

Channel No. 3

Channel No. 4

Bus connection

OMRON PLC 

connection

Temperature controller 

connection

Servo amplifier 

connection
1 - 22 1. What is the GOT?
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2. GOT operation

GOT enables reading and writing to PLC CPU devices (bit, word) with the switches, lamp, numerical display/input, 
message display, etc. on the GOT screen.

2.1 Summary of operation
With GT Designer3, display pane figures called objects, such as the touch switch, lamp, and numerical display, etc., are 
pasted on the GOT screen.
GOT functions can be executed by setting operation functions of the PLC CPU device memory (bit, word) to each pasted 
object.
This chapter explains the GOT operation in connection with the PLC CPU when the touch switch or numerical display 
are set as shown below.

<System example>

M0

Y10

Y10

M1 Y10

K123MOV D10

Run Run lampStop

123

GOT

Sequence program

<Settings of GOT for figures>

Touch switch setting

Bit momentary
Write device : M0

Touch switch setting
Bit momentary

Write device : M1

Lamp display setting
Bit
Read device 

Numerical input setting

Write device 
Display : Unsigned decimal number

PLC CPU

Data

Ethernet connection cable

: D10, unsigned BIN

: Y10
2. GOT operation
2.1 Summary of operation
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<Action description>

1. While the touch switch "Run" on the GOT is 
being touched, the bit device "M0" has been ON.

2. When the bit device "M0" turns ON, the bit 
device "Y10" turns ON.

Also, the ON figure is displayed on Run Lamp in 
which the monitor device has been set to the bit 
device "Y10".

3. As the bit device "Y10" has been ON, "123" is 
stored into the word device "D10".

"123" is also displayed in the numerical display 
on the GOT in which the monitor device has 
been set to the word device "D10".

4. While the touch switch "Stop" on the GOT is 
been touched, the PLC CPU bit device "M1" has 
been ON.

The PLC CPU bit device "Y10" turns OFF, and 
Run Lamp turns OFF.

(GOT) (PLC CPU)

M0

Y10

Y10

M1 Y10

K123MOV D10

Turns ON.

Run
Run lamp

Stop

Data 0

Touch.

(GOT) (PLC CPU)

M0

Y10

Y10

M1 Y10

K123MOV D10

Turns ON.

Run
Run lamp

Stop

Data 0

Turns ON.

(GOT) (PLC CPU)

M0

Y10

Y10

M1 Y10

K123MOV D10

"123" is stored into D10.

Run Run lampStop

Data 123

"123" is displayed.

(GOT) (PLC CPU)

M0

Y10

Y10

M1 Y10

K123MOV D10

M1 turns ON. Y10 turns OFF.

Run
Run lamp

Stop

Data 123

Touch.

Display turns OFF.
2 - 2 2. GOT operation
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POINTPOINTPOINT

The display and operation of the cursor and key window for numerical input can be changed through settings.
(1) Display or non-display of the cursor, and key window

• When establishing conditions or switching screens, the cursor and key window are displayed, and when 
establishing the operating conditions, the cursor and window key are not displayed.

• The key window is displayed on touch input and not displayed at pressing the [Enter] button.
(2) Cursor key operations

The input order can be set to the multiple numerical input.

For the operation setting methods of cursor and key window for numerical input, refer to the GT Designer3 
(GOT2000) Screen Design Manual.

5. To change the value of the word device "D10", 
touch the numerical input on the GOT.

6. Input the numerical value on the key window to 
be displayed.
To store the value, touch the [Enter] button.

7. The input numerical value is reflected
(D10: 123 → 200), and the key window is 
closed.

(GOT)

Run
Run lamp

Stop

Data 123

Touch.

(GOT)

Run Run lampStop

Data

(GOT)

Run Run lampStop

Data 200

100

Input fixation

1000
00

0 0

Move cursor to the
next input field.
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3. About GT Designer3

3.1 About GT Designer3
GT Designer3 (GOT2000) is the software to create screens for GOT2000 series.

Write the created project into a GOT or open it using GT SoftGOT2000.

HINTHINTHINT

(1) Creating or editing a GOT1000 project
To create or edit a GOT1000 project, use GT Designer3 (GOT1000).
GT Designer3 (GOT1000) can be installed from the DVD-ROM or CD-ROM of GT Works3.

(2) Creating or editing a GOT900 project
To create or edit a GOT900 project, use GT Designer2 Classic.
GT Designer2 Classic can be downloaded from the MITSUBISHI ELECTRIC FA Global Website.

GOT

· GT Designer3 (GOT2000)
· GT SoftGOT2000

Write the project 
to the GOT.

Open the project with GT SoftGOT2000 
to perform monitoring on a personal computer. Display the project on the GOT.
3. About GT Designer3
3.1 About GT Designer3
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3.2 GT Designer3 screen configuration and features

3.2.1 Screen layout of GT Designer3

The following shows the screen layout, toolbars, and windows of GT Designer3.

Item Description

1) Title bar
Displays the software name.
The title bar displays a project name (workspace format) and a file name with a full path (single file format) 
according to the format in which the project is being edited.

2) Menu bar GT Designer3 can be operated from pull-down menus.

3) Toolbar GT Designer3 can be operated by buttons.

1)
2)

3)

3)

3)

8)

4)

4)

5)

6)

7)

4)
3 - 2 3. About GT Designer3
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4) Docking window

A window that can be docked with the screen of GT Designer3.
The docking location can be customized.
The following shows the types of windows that can be docked.

[Utilize (Screen)] window Searches a screen of another project which can be utilized.

[Project] window Displays the list of the settings of the whole project.

[System] window Displays the list of settings such as the GOT type settings, environmental 
settings, and controller settings.

[Screen] window
Displays the list of created base screens and window screens.
You can create a new base screen or window screen and edit existing 
screens.

[Property] window
Displays the list of settings of a selected screen, figure, or object.
You can edit the settings without opening the setting dialog of a figure, object 
and others.

[Library] window
Displays the list of figures and objects registered in the library.
You can utilize or edit the figures and objects and create a new figure or 
object in the library.

[Data Browser] window
Displays the list of the settings in the project.
You can search or edit the settings of a figure, object and others.

[Data Check List] window Displays the list of data check results.

[Output] window
Displays the list of the change history when the project is converted because 
of change of the GOT type or other reasons.

[Controller Type List] 
window

Displays the connection status of each channel.

[Data View] window
Displays the list of the figures and objects on the screen editor.
You can select a figure or object on the [Data View] window.

[Screen Image List] window
Displays the list of the images of base screens and window screens.
You can create a new base screen or window screen and edit existing 
screens.

[Category List] window

Displays the list of categories and figures and objects classified in each 
category.
You can edit a category and execute batch change to the settings of devices 
by the category.

[Parts Image List] window
Displays the list of the images of registered parts.
You can create a new part or edit the existing parts.

5) Editor tab Displays the tabs of the windows and screen editors which are displayed on the work window.

6) Temporary area By arranging unnecessary objects on this area temporarily, you can create and edit screens easily.

7) Screen editor Creates a screen to be displayed on the GOT by arranging figures and objects on the screen editor.

8) Status bar

Displays the following contents according to the position of the mouse cursor, a selected figure, or object.
• Description of the item over which the mouse cursor is moved.
• The GOT type, color settings, and controller settings of the project being edited.
• Coordinates of a selected figure or object

Item Description
3. About GT Designer3
3.2 GT Designer3 screen configuration and features
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3.2.2 Features of GT Designer3

The following shows the features of GT Designer3.

(1) Categorized setting items enable users to select an item easily. (Work tree)
Setting items in a project are categorized into "Project", "System", and "Screen" so that users can find an 
appropriate item easily. 
Since all setting items are displayed, users can quickly find the one.
New screens or comments can be created just by double-clicking [New].

(2) User-friendly icons and learning function improve efficiency. (Toolbar)
Simply designed colorful icons and easy explanations enable first-time users to design screens easily. 
Since previous selections are stored, drawings can be efficiently executed.
For example, when creating a switch, select the bit switch from the menu or toolbar to switch the button at the 
top to the bit switch button. 
From the next time, users do not need to select the bit switch from the sub menu. A bit switch can be created 
with just one click on the button.

<Project>

<System>

<Screen>

Double-click this item 
to create a new screen

Move the mouse cursor over 
the button to display the explanation of 
functions and operations.

Bit SwitchBit Switch Bit lampBit lamp Numerical Numerical 
DisplayDisplay

Numerical Numerical 
inputinput

Text DisplayText Display Word CommentWord Comment

Alarm DisplayAlarm Display Bit PartsBit Parts Trend GraphTrend Graph TextText Text Color Text Color 
SettingSetting

Import Import 
DXF DataDXF Data

AlignAlign RotateRotate Time DisplayTime Display Write to GOTWrite to GOT Start SimulatorStart Simulator Controller Controller 
settingsetting
3 - 4 3. About GT Designer3
3.2 GT Designer3 screen configuration and features
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(3) Parts to be used frequently can be registered. (Library)
The tree view enables users to easily search for an item in the library.
Objects can be selected not only from [Appearance], but also from [Function] or [Recently Used Library].
Just by selecting parts from the library and placing them on the editor, a beautiful screen can be created easily. 

(4) Users can intuitively configure settings or perform operations. (Dialog)
User-friendly terms and display items enable users to intuitively configure settings and perform operations.
An asterisk "*" displayed on a tab enables users to identify which setting has been modified.
Users can configure the settings by checking the ON/OFF states of a lamp, touch switch, or other objects by 
displaying the display image from different range. 

(5) Input assist 
It search device comments and device definitions with keywords, and narrow down utilizable devices.
Every click on the header switches the display order of the items, in order of the ascending order, descending 
order, and no sort.

Just click and 
place a part.

Click 
[Device Comment].

The sorting order 
can be changed.
3. About GT Designer3
3.2 GT Designer3 screen configuration and features
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(6) Easy alignment (Editor)
When a figure or object is dragged to move, the line display target exists in the horizontal or vertical direction for 
easy alignment of objects.
You can place figures and objects with the help of guidelines (auxiliary lines). 

(7) Easy placement using the consecutive copy (Editor)
Figures or objects can be copied for a specified number all at once. 
When copying an object containing devices, set the increment to assign device numbers.  

(8) Easy correction with [Batch Edit] (Editor)
The settings of devices, colors, figures, channel numbers, and networks can be configured all at once using 
[Batch Edit].
In [Width/height/coordinate input], change the size of selected objects and rearrange them all at once by 
inputting width, height, and coordinates. 

<Batch correction -- changing color> <Width/height/coordinate input>
3 - 6 3. About GT Designer3
3.2 GT Designer3 screen configuration and features
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(9) Data browser 
The common setting, figures, and objects set in the project are displayed in a list.
The targets to be displayed in the data browser can be changed and the displayed settings can be changed 
collectively.

(10) Simulation with just one click (Simulator)
Use a personal computer to check the screen data operation. (Check alarms, monitor screen transition and 
devices.) 
Data can be effectively debugged during the correction of a screen.

*: One of the following is required separately.
• CPU connection (RS232)
• CPU connection (USB)
• MT Simulator2
• GX Works2 and GX Simulator2

Even though a screen is being created (before the file is 
saved), the screen operation can be simulated with one 
click.

The following conventional operations are not required.
• Saving a file
• Starting the simulator
• Opening the file

Example) When the [Text Batch Edit] is selected from the menu

Click with mouse to 

simulate touch operation

Start Simulator

Just click "Update" 

after modifying the screen!
3. About GT Designer3
3.2 GT Designer3 screen configuration and features
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(11) The required data is selected automatically. (Communication with the GOT)
GT Designer3 (2000) selects the required system application, communication driver, and special data 
automatically from the project setting, adds them to the package data*1, and while transferring it to GOT.
The following shows the three methods for transferring data to the GOT.
(a) Transferring data using cables

• USB cable
• Ethernet cable

(b) Transferring data using a USB memory
(c) Transferring data using an SD card

*1 The package data consists of a project, basic system application, extended system application, and communication driver. 

(12) Effective use of screen assets (Data utilization (Project)) 
Use keywords to search for utilizable data from past projects or the provided sample projects. Even though 
users do not realize the setting content of the project, they can effectively create a new project by simply 
selecting utilizable data.

Package data

• USB cable
• Ethernet cable

SD card

USB memoryUSB

GOT2000

GOT2000

GOT2000

Specify search range

Select or input a keyword

Search results are displayed

Select "Sample Project" to reuse

Select a prepared keyword or input an arbitrary keyword

Choose the applicable 
project from the search result.

[New][Project] [Utilize Data]Procedure:
3 - 8 3. About GT Designer3
3.2 GT Designer3 screen configuration and features
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3.3 How to use Help

3.3.1 Displaying Help

(1) Displaying Help from the menu
To display Help, select [Help] → [GT Designer3 Help] from the menu.

(2) Displaying a page corresponding to the operation status of GT Designer3
To display a page corresponding to the operation status of GT Designer3, press [F1] key while operating GT 
Designer3.

(3) Precautions in displaying Help
(a) Relationship between Help and screen design software

The Help displayed in GT Designer3 (GOT2000) is for GT Designer3 (GOT2000).
To view Help of GT Designer3 (GOT1000), switch the screen design software mode from GT Designer3 
(GOT2000) to GT Designer3 (GOT1000).
To switch the screen design software mode, use one of the following methods.
• Create a new project.
• Open GOT1000 project data.
• Select [Project] → [Start GT Designer3 (GOT1000)] from the menu.

(b) Switching the screen design software mode while Help is displayed
While Help is displayed, switching the screen design software mode cannot switch Help.
To switch Help, switch the screen design software mode, and then display Help.

(c) Starting GT Designer3
GT Designer3 starts in the mode used last time.
(The first startup of GT Designer3 activates GT Designer3 (GOT2000).)
To switch the screen design software mode, use one of the following methods.
• Create a new project.
• Open GOT1000 project data.
• Select [Project] → [Start GT Designer3 (GOT1000)] from the menu.

3.3.2 Using Help

Help is viewable using e-Manual Viewer.
For information on how to use e-Manual Viewer, refer to the following.

e-Manual Viewer Help

Press [F1] key while displaying the [Style] tab in the [Switch] dialog. The page corresponding to the [Style] tab 
in the [Switch] dialog is shown.
3. About GT Designer3
3.3 How to use Help
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4. From GOT screen creation up to the 
test

4.1 Preparation before using the GOT
This section describes the procedure of creating screens up to monitoring of PLC by the GOT.

Create project data (GT Designer3 (GOT2000)).

Create a project (Refer to section 4.2.1). 
(Setting GOT/Controller (PLC) type to use)

Set controllers (Refer to section 4.2.2.)
(select connection method between GOT and PLC)

Screen switching device settings (Refer to section 4.2.3).

Connect the personal computer and GOT (Refer to section 4.3.1)

• USB cable
• Ethernet cable * USB cables are used during training.

Transfer data to GOT (Refer to section 4.3.4)

Connect GOT and PLC (Refer to section 4.4.1)

* Ethernet cables are used for this training.

• Ethernet cable (Ethernet and CC-Link IE Field Network)
• RS-232 cable
• RS-422 cable
• Bus connection cable
• Fiber-optic cable (MELSECNET/H, MELSECNET/10, and CC-Link IE Controller Network)
• Coaxial cable (MELSECNET/H and MELSECNET/10)
• CC-Link-dedicated cable

Monitor start

GOT2000

Install the software package (GT Designer3 (GOT2000) and Help) 
(Refer to the GT Works3 Installation Instructions).

Check that data has been properly transferred to the GOT. 
(Refer to section 4.5.)
4. From GOT screen creation up to the test
4.1 Preparation before using the GOT
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4.2 Screen creation

4.2.1 Project creation

Projects comprise all the data and settings displayed in one GOT.
The screens displayed in the GOT and connection method with the PLC are set in a project wizard.
In this section, the settings for the type of GOT used for training and the type of PLC connected to the GOT are 
described.

1. Click [Start] → [All Programs] → [MELSOFT 
Application] → [GT Works3] → [GT 
Designer3] menus to run GT Designer3 
(GOT2000).

2. The screen on the left is displayed when GT 
Designer3 (GOT2000) is started.

Click the  button.

3. The initial screen of [New Project Wizard] is 
displayed. (When no new wizard appears, go 
to section 4.2.2.)

Click the  button.

Various settings that can be made on the 
project wizard are described on the following 
pages.

2.

3.
4 - 2 4. From GOT screen creation up to the test
4.2 Screen creation
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(1) System settings for GOT
The GOT type to be used and the color are set.

1. When the left screen appears, set the GOT 
type and the color as follows.

GOT Type: GT27**-S (800x600)

2. After the selection is made, click the 
 button.

3. The left screen is displayed.
Confirm the settings.
Click the  button.

(2) Communication Settings
The connection method for the device to be connected to GOT is set.
(The settings made here can be changed later.)
For details on communication settings, refer to section 4.2.2.

1. When the left screen appears, set 
manufacturer and the device to be connected 
as follows.

Manufacturer: MITSUBISHI
Controller Type: MELSEC-Q/QS, Q17nD/

M/NC/DR, CRnD-700

2. Click the  button.

3. When the left screen appears, set the 
connection I/F as follows.

I/F: Standard I/F(Ethernet): Multi

4. Click the  button.

(Next page)

1.

2.

3.

2.

1.

4.

3.
4. From GOT screen creation up to the test
4.2 Screen creation
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(From previous page)

5. When the left screen appears, set the 
communication driver as follows.

Communication Driver: 
Ethernet(MELSEC), 
Q17nNC, CRnD-700, 
Gateway

6. Click the  button.

7. On the screen shown left, click the 
 button.

8. On the screen shown left, set the GOT IP 
address as follows.

GOT IP Address: 192.168.3.18

9. Click the  button to return to the 
[New Project Wizard] dialog.

(Next page)

5.

6.

7.

8.

9.
4 - 4 4. From GOT screen creation up to the test
4.2 Screen creation
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(From previous page)

10.Click the  button.

11.The left screen is displayed.
Confirm the settings.

Click the  button.

POINTPOINTPOINT

If GT Designer3 (GOT1000) starts while GT Designer3 is running, start GT Designer3 (GOT2000) by using 
one of the following methods.
(1) Click [Project] → [Start GT Designer3 (GOT2000)] from the menu of GT Designer3 (GOT1000).
(2) Select [GOT2000] and click the [Next] button in the [New Project Wizard] dialog of GT Designer3 

(GOT1000).

10.

11.
4. From GOT screen creation up to the test
4.2 Screen creation
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POINTPOINTPOINT

Up to 32 characters can be entered as a project name, regardless of whether they are one-byte or two-byte 
characters.

(3) Setting of Screen Switch Device
The device for switching the screens displayed on GOT is set.
(The settings made here can be changed later.)
Refer to section 4.2.3 for details on screen switching device settings.

1. When the left screen appears, the screen 
switching device is set as follows.

Base Screen : GD100
Overlap Window1 : GD101
Overlap Window2 : - (no setting)
Overlap Window3 : - (no setting)
Overlap Window4 : - (no setting)
Overlap Window5 : - (no setting)
Superimpose Window1 : - (no setting)
Superimpose Window2 : - (no setting)
Dialog Window : - (no setting)

Click the  button.

2. The left screen is displayed.
Confirm the settings.

Click the  button.

3. Base screen1 is created.
The screen is ready for drawing.

1.

2.
4 - 6 4. From GOT screen creation up to the test
4.2 Screen creation
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RemarkRemarkRemark

(1) Changing the GOT type or screen title
The GOT type and screen title settings can be changed in the docking window.

(2) For the details of the GOT type and screen title settings, refer to the GT Designer3 (GOT2000) Screen 
Design Manual.

• Changing the GOT type • Changing the screen title

Double-click 

this item.
1. Right-click this item.

2. Change the screen title.

• Change the screen 
title directly.

• Change the screen 
title in the [Screen 
Property] dialog.
4. From GOT screen creation up to the test
4.2 Screen creation
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4.2.2 Communication settings

POINTPOINTPOINT

Settings described in this section are not required when settings are made on the new project wizard (Section 
4.2.1).

The GOT and PLC CPU communication settings are performed.
When using the GOT for the first time, set the channel number and communication driver for the communication 
interface, and write the settings to the GOT.
This section explains how to connect the GOT to the Ethernet port built in a Q(nUDV)CPU via Ethernet.

1. Double-click [CH1] in the [Controller Setting] 
menu in the system tree.

2. The [Controller Setting] dialog appears.

(Next page)

1.
4 - 8 4. From GOT screen creation up to the test
4.2 Screen creation
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(From previous page)

3. Configure the controller setting.
Set the items as shown below.
(Settings for this item have already been 
performed in the new project wizard 
described in section 4.2.1.)

Manufacturer: MITSUBISHI
Controller Type: MELSEC-Q/QS, Q17nD/

M/NC/DR, CRnD-700
I/F: Standard I/F(Ethernet):Multi
Driver: Ethernet(MELSEC), Q17nNC, 

CRnD-700, Gateway

4. Configure the detail setting as follows.
GOT Net No.: 1
GOT Station: 1
GOT Communication Port No.: 5001

For the other items, use their default setting.

5. Click the  button.

6. On the screen shown left, set the GOT IP 
address as follows.
(Settings for this item have already been 
performed in the new project wizard 
described in section 4.2.1.)

GOT IP Address: 192.168.3.18
For the other items, use their default setting.

(Next page)

4.

5.

3.

6.
4. From GOT screen creation up to the test
4.2 Screen creation
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POINTPOINTPOINT

Ethernet setting
When the GOT is connected to the Ethernet port built in the QnUDVCPU or other PLC CPUs via the Ethernet 
connection, the setting items [Net No.] and [Station] do not exist on the PLC side. However, virtual values need to 
be set for the items when the device setting is configured on the GOT side as [Net No.] and [Station] are used to 
identify the CPU.
Setting virtual values is required only for the Ethernet connection with built-in Ethernet PLCs. For the QJ71E71 
connection, the Net No. and station number set to the module are required.

RemarkRemarkRemark
• For the details of [Controller Setting], refer to the GOT2000 Series Connection Manual (Mitsubishi Products).
• [Controller Setting] can also be performed with the GOT Utility.
• For the details of [Controller Setting] in the utility, refer to the GOT2000 Series User's Manual (Utility).

(From previous page)

7. Configure the Ethernet setting as follows.
Net No.: 1 (Virtual)
Station: 2 (Virtual)
Unit Type: QnUD(P)V/QnUDEH
IP Address: 192.168.3.39
Port No.: 5006
Communication: UDP

8. Click the  button.

7.

8.
4 - 10 4. From GOT screen creation up to the test
4.2 Screen creation
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4.2.3 Screen switching device settings

This section explains screen switching device settings.
Set the base screen switching device to "D0", and the Overlap window1 screen switching device to "D1".

1. Click on the [Common] – [GOT 
Environmental Setting] – [Screen Switching/
Windows] menu.

2. The [Environmental Setting] dialog box is 
displayed.

3. Click the  button and set a screen 
switching device for the current base screen.

(Next page)

1.

3.
4. From GOT screen creation up to the test
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(From previous page)

POINTPOINTPOINT

In the [Detail Setting] dialog box, the following contents can be set.

4. The device dialog box is displayed.

5. Click  and set to "D".

6. Click  and set to "0".

7. After settings are completed, click the 
 button.

8. Check that "D0" is set in the switching 
device.

9. Check "Overlap Window 1" and set the 
switching device to enable Overlap window.

10.Click the  button and set the "Screen 
Switching Device" to "D1".

11.Click the  button.

• [Display the title bar]
Displays a title bar on the overlap window.

• [Close the window when switching base screens]
Closes the overlap window automatically without [X] 
when the base screen is switched.

• [Specify the display order]
Select a stacking order number for the overlap window.

• [Disable the touch operation of a screen on the back]
Displays the overlap window in the front regardless of the 
setting of Specify the display order and disables the touch 
operation on the screens behind the overlap window.
Select this item, and then select a condition for disabling 
the touch operation.

7.

5.
6.

8.

10.

11.

9.
4 - 12 4. From GOT screen creation up to the test
4.2 Screen creation
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POINTPOINTPOINT

(1) Screen switching device settings
With the screen switching device, refer to the following to set the devices to be used.
(a) GOT internal device (GD)

It is recommended to use a GD device when screens are not switched by a PLC CPU.
Switch between screens with a specific touch switch ([Go To Screen Switch]).
With the screen switching device, the internal device (GD100) is set by default.

(b) PLC CPU device (D,W, etc.)
It is recommended to use this device to control screen switching from the PLC CPU.
Screen switching can also be performed by the touch switch (screen switching switch).

(2) GOT internal devices
They are devices kept in the internal of GOT.
The internal devices of GOT are classified into the following types.

• GOT bit register (GB) : Bit register located inside the GOT and used as bit devices.
• GOT data register (GD) : Data register located inside the GOT and used as word devices.
• GOT special register (GS) : Special register located inside the GOT, which stores internal information, 

communication status error information, etc.
By monitoring GS with the object function, various information of the GOT 
can be checked.
Writing values by a user, controls the GOT operations.

(3) Using an overlap window as the system window
System window includes test windows, remote screens of the remote personal computer operation (Ethernet), 
and window screens which are used for system applications.
Use the system window by assigning any overlap window.
You can also display the window screen with an overlap window for which the system window is assigned 
when the system window is not used.
If the system window is called while a window screen is displayed with the overlap window, the GOT closes 
that window screen and opens that system window.
After the system window is closed, the window screen whose screen No. is the same as the value of the 
screen switching device is displayed again.
Example) Switching between a system window and a window screen
(Overlap window 1 is used as the system window and D200 is set for the screen switching device.)

Window screen 10

D200: 10

VALUE16SET/RST

SET VAL

BM VAL16

BM VAL32

ChNo.[1]NetNo.[ 0]ST [FF]CPUNo.[0]

Test window

D200: 10 D200: 10

Window screen 10

(overlap window 1) (overlap window 1) (overlap window 1)

Touch the touch switch for 

starting the test window.

The GOT closes the displayed 

window screen and opens the 

system window.

After the system window is closed, the 

GOT opens the overlap window 1 of 

the screen switching device value.

VALUE32
4. From GOT screen creation up to the test
4.2 Screen creation
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4.2.4 Saving the project data

This section explains the operations to save the created project data.
This section explains to save a project to a desktop with an example.

1. Click on the [Project] – [Save As] menu.

2. The [Save As Project] dialog appears.

(Next page)

1.
4 - 14 4. From GOT screen creation up to the test
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(From previous page)

3. Select "Desktop" for [Save in].

4. Set the file name of the project to be saved as 
follows.

File name : "kiso"
Save as type : Project Data(*.GTX)

5. Click the  button to save the project.

3.

4.
5.
4. From GOT screen creation up to the test
4.2 Screen creation
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RemarkRemarkRemark
Select [Project] → [Save As] from the menu to display the [Save As Project] dialog.

• Single file format: Save the project in the [Save As Project] dialog.
• Workspace format: Save the project in the [Save As Project] dialog.

In this textbook, the project is saved in the single file format.
If the [Save As Project] with Workspace Format Project dialog appears, click the [Switch to single file format 
project] button to switch the dialog to [Save As Project] with Single File Format.

For information on how to save a project in the workspace format, refer to the GT Designer3 (GOT2000) Screen 
Design Manual.

Switching to the [Single File format Project..] dialog Switching to the [Workspace format Project..] dialog
4 - 16 4. From GOT screen creation up to the test
4.2 Screen creation
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HINTHINTHINT

The workspace format project is the file format to manage multiple projects in the workspace.
The workspace format project consists of multiple folders and files as the figure below.

Example of opening a workspace format project from MELSOFT Navigator

Folder and file operations of the workspace format project
If you manipulate (move, rename, copy, or delete) a folder or file in a workspace format project by using Windows 
Explorer or other tools on a personal computer, the project cannot be opened with GT Designer3.
Manipulate folders or files in a workspace format project by using the following procedure.
(1) Moving a project

1. Open a project to be moved.

2. Select [Project] → [Save As] from the menu and select the destination in [Save Folder Path] to save the 
project.

3. Delete the original project.

(2) Changing a project name

1. Open the project to change the name.

2. Select [Project] → [Save As] from the menu to save the project after changing the name.

3. Delete the original project.

(3) Copying a project

1. Open the project to be copied.

2. Select [Project] → [Save As] from the menu to save the project after changing the name.

(4) Deleting a project

1. Select [Project] → [Delete] from the menu to display the [Delete Project] dialog.

2. Select a project to be deleted from [Workspace/Project List] and click the [Delete] button. The selected 
project is deleted.

Workspace 

management file

workspacelist.xml

Project 

management file

Project 

management file

projectlist.xml

Storage folder

Workspace folder 1 Workspace folder 2

Project folder 

1-1

Project folder 

1-2

Project folder 

2-1

Project folder 

2-2

projectlist.xml
4. From GOT screen creation up to the test
4.2 Screen creation
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4.2.5 Reading screens

In this section, training is performed using screen prepared beforehand.
(Specific creation methods for screen are explained in chapter 5.)

RemarkRemarkRemark
Screen data is loaded from the project named "school" for which the settings described in sections 4.2.1 and 4.2.2 
are configured.

(1) Opening the project

1. Click on the [Project] – [Open] menu.

(Next page)

1.
4 - 18 4. From GOT screen creation up to the test
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(From previous page)

2. The [Open Project] dialog box appears and 
select "school.GTX".

3. Click the  button.

4. As the dialog box to confirm whether to save 
the project data created this time appears, 
click the  button.

(Next page)

2.

3.

4.
4. From GOT screen creation up to the test
4.2 Screen creation
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RemarkRemarkRemark
Select [Project] → [Open] from the menu to display the [Open Project] dialog.

• Workspace format: Open the project from the [Open Project] dialog (workspace format).
• Single file format: Open the project from the [Open Project] dialog (single file format).

In this textbook, a project in the single file format is opened.
If the [Open Project] dialog (workspace format) appears, switch the dialog to the [Open Project] dialog (single file 
format) using the [Open single file format project] button.

For information on how to save a project in the workspace format, refer to the GT Designer3 (GOT2000) Screen 
Design Manual.

(From previous page)

5. The screen is read.

Switching to the [Open Project] dialog 

(single file format)

Switching to the [Open Project] dialog 

(workspace format)
4 - 20 4. From GOT screen creation up to the test
4.2 Screen creation
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4.3 Data transfer (personal computer to GOT)
This section explains procedures for writing data created on GT Designer3 to the GOT.

4.3.1 Connection from a personal computer to GOT

Connect the personal computer and GOT.

RemarkRemarkRemark

To connect the personal computer and GOT, RS-232*1 or Ethernet can be used in addition to the USB cable.
Use of the USB cable enables the data to be transferred at higher speed and reduces the operation time as 
compared with RS-232 communication.

*1 When using an RS-232 cable, connect the personal computer and GOT via a PLC. For the details, refer to the GT Designer3 
(GOT2000) Screen Design Manual.

Notebook personal computer

USB cable
To USB 

connector
To USB 

connector

GOT

Personal computer 

(GT Designer3)

PLC

RS-232 cable

Ethernet

GOT

USB cable

Ethernet cable
4. From GOT screen creation up to the test
4.3 Data transfer (personal computer to GOT)
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4.3.2 About data types transferred to the GOT

To operate the GOT, it is necessary to transfer the following types of data to the GOT.

*1 For the extended system applications, refer to section 6.1.

POINTPOINTPOINT

With GOT, data exchange between the personal computer and GOT is expressed in the following terms.
• Write: Write package data or install the BootOS to the GOT from a personal computer.
• Read: Load project data, package data, resource data, or drive information to a personal computer from the 

GOT.

Data type Outline Data transfer timing

Boot OS

The program needed to control GOT hardware, and during communication 
between GOT and personal computers.
As the BootOS has been installed to the GOT at the factory, installing the 
BootOS is usually unnecessary.

• When restoring the factory 
default settings to the GOT 
(Installing the BootOS is 
usually unnecessary.)

Package data
Data consists of a project, standard system applications, extended system 
applications, communication drivers, and special data. • When using GOT for the first 

time
• When changing screens or 

settings
• When changing the functions 

to be used (extended system 
applications) or 
communication type

• When upgrading the 
versions of system 
applications

Project data
(Required)

Data for user-made monitor screens, such as screen data, comments, 
common settings, etc.

Standard system 
applications
(Required)

Applications to operate the GOT and display the utility.

Extended system 
applications

Applications to enable some functions of the GOT, such as the system 
monitor function and the logging function.

Communication 
driver
(Required)

Drivers required for the GOT to communicate with controllers.

Special data Special data is used for the intelligent module monitor, R motion monitor, Q 
motion monitor, or servo amplifier monitor.

• When changing the functions 
to be used

Resource data All types of data created in the GOT main unit, such as recipe file, alarm log 
file, etc.

• Varies depending on each 
GOT function
4 - 22 4. From GOT screen creation up to the test
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4.3.3 Communication settings

Settings for communication between the personal computer and the GOT are performed.

1. Click on the [Communication] – 
[Communication Configuration] menu.

2. In the [Communication Configuration] dialog, 
set the connection method and the 
connection interface as shown below.

Connection to GOT: Direct
PC side I/F: USB

(In training, to connect the personal computer 
and GOT with the USB cable)

3. Click the  button.
The message "Successfully connected" 
appears.

4. Click the  button.

2.

3.

4.
4. From GOT screen creation up to the test
4.3 Data transfer (personal computer to GOT)
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4.3.4 Writing the package data

This section describes how to write package data to the GOT.

1. Click [Communication] → [Write to GOT] from 
the menu.

2. When the [Communication Configuration] 
dialog appears, configure the settings as 
follows and click the  button.

Connection to GOT: Direct
PC side I/F: USB

(Next page)

1.

2.
4 - 24 4. From GOT screen creation up to the test
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3. The [Communicate with GOT] dialog appears.
Click the [Write Option] button to display the [Write Option] dialog.

1) Write Data:
Select the type of the data to be written to the GOT.

2) Data Size:
Displays the size of the data to be written to the GOT.

3) Destination Drive:
Select a GOT drive to which the project data or system applications are written.

4) GOT Type:
Select a GOT type. The GOT type set in [GOT Type Setting] of the project data is fixed.

5) Initialize SRAM user area at the time of writing project:
Initialize the SRAM user area when the package data is written to the GOT.

6) No automatic restart after writing (manual restart is required):
The GOT does not restart automatically after the package data is written to the GOT.
When this item is selected, the GOT is required to be restarted manually after writing.

7) Write Mode:
Select the write mode of the package data.
•[Synchronize]
Only the required data is written according to the difference with the package data which has already been written to the 
GOT.
The data which is not related to the package in the GOT is deleted.

•[Select]
Only the data selected in the package data tree is written.

8) Package data tree:
The data included in the package data is displayed in the tree.
When [Select] is selected for [Write Mode], the data can be added or deleted.

9)  button:
This button is displayed only when [Synchronize] is selected for [Write Mode].
Clicking this button displays the [Application Selection] dialog.

(Next page)

<[Communicate with GOT] dialog box>

1)
2)

3)

4)

5)
6)

7)

8)

9)
4. From GOT screen creation up to the test
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(From previous page)

4. Select [Package Data] in [Write Data].

5. Click the  button.

6. Select [Select] of [Write Mode].

7. Select the data to write.

8. Click the  button.

9. Click the  button.

(Next page)

4.

5.

8.

7.

6.

9.
4 - 26 4. From GOT screen creation up to the test
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POINTPOINTPOINT

Transferring data via a PLC
GOT screen data can be transferred from a personal computer to the GOT via a PLC. 
Editing GOT screen data during startup can be performed without changing cables.

For the details, refer to the GT Designer3 (GOT2000) Screen Design Manual.

(From previous page)

10.Click the  button to write the screen 
data.

11.When writing the data is completed, a 
completion message appears. Click the 

 button.
After writing the data has been completed, 
the GOT restarts automatically.

10.

11.

GOT screen data

Screen design software 

GT Works3

Mitsubishi PLC

WorksiteOffice

GOT2000

QCPU / LCPU

Ethernet

This feature does not apply to a GOT connected to a CPU's built-in Ethernet port. 

USB 

RS-232 

Ethernet

GOT2000
4. From GOT screen creation up to the test
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4.4 Connection to PLC CPU (Ethernet connection)

4.4.1 Connecting the cable

This section explains connection procedures for connecting the GOT and PLC CPU with the Ethernet connection cable.

1. Power OFF the PLC CPU and GOT.

2. Connect the Ethernet connection cable to the 
PLC module.

3. Connect the Ethernet connection cable to the 
GOT.
4 - 28 4. From GOT screen creation up to the test
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4.5 Checking whether data has been properly 
transferred to the GOT

4.5.1 System alarm

The system alarm is a function used to display error codes and error messages when error occurs in the PLC, GOT, 
servo amplifier, communication system, etc.
Error messages displayed in the system alarm do not need to be registered. (They are registered in GOT.)
If the system alarm is set in the screen beforehand, displaying system alarm allows a user to check how the error 
occurred and its cause.

• Under normal conditions

When nothing appears in the System Alarm, communication is normal.

• When an error occurs

When an error message appears in the System Alarm, check whether there is a cable disconnection and the condition 
of the PLC.

POINTPOINTPOINT

Error messages to be displayed in the system alarm can be checked by using the following methods besides 
setting the system alarm.

[Maintenance] tab of the utility menu of the GOT
• [System alarm]
• [Batch self check]

With [Batch self check], the error message history can also be checked.

System Alarm display area
4. From GOT screen creation up to the test
4.5 Checking whether data has been properly transferred to the GOT
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4.5.2 Executing the monitor

Operate the screen written to the GOT, and monitor the PLC.

GOT Operation Image

(1) Monitoring/changing the bit device (Y70, Y71) values

1. When the [Y71 ON] switch is touched, the 
Y71 becomes ON.

2. When the [Y71 OFF] switch is touched, the 
Y71 goes OFF.

3. Each time the [Y70 ON/OFF] switch is 
touched, the Y70 goes ON/OFF.

Displays the value of D100.

Lamp is lit when Y70 is 
turned ON.

Turn Y71 OFF.

Turn Y71 ON.

Switches Y70 ON 
or OFF each time 
Y70 is touched.

Lamp is lit when Y71 is 
turned ON.

Displays errors and error codes 
when a malfunction occurs in 
GOT or CPU.

Adds to the value of D100.

Sets the value of D100 to the 
number displayed on the switch.

1.

2.

3.
4 - 30 4. From GOT screen creation up to the test
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(2) Monitoring/changing the word device (D100) values

(3) Displaying the error message

1. To perform addition on the value of D100, 
touch a [Numeral Increase] switch.

2. When the [Set Numeral] switch is touched, 
the D100 value is set.

1. Power OFF the training machine and power 
OFF the PLC.

2. The error message appears in the system 
alarm.

1.

2.
4. From GOT screen creation up to the test
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POINTPOINTPOINT

Checking package data
Check whether the package data has been properly written to the GOT using GT Designer3.

1. Click [Communication] - [Read from GOT] from 
the menu.

2. The [Communicate with GOT] dialog appears. 
Select [Drive Information] in [Read Data].

3. Select [C:Built-in Flash Memory] in [Source 
Drive].

4. Click the  button.

5. The list of the items that have been written to 
the drive is displayed in the tree.

When the following items can be checked, the 
package data has been properly written to the 
GOT.

•Standard System Application
•Communication driver:

Ethernet(MELSEC),Q17n
NC,CRnD-700,Gateway

4.

3.

2.

5.
4 - 32 4. From GOT screen creation up to the test
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POINTPOINTPOINT

Checking that the GOT recognizes the connected equipment
Check that the GOT recognizes the connected equipment with the GOT utility.
To avoid problems, always perform checks.

1. Power ON the GOT.

2. The screen described in section 4.3.3 
appears. Hold down the upper left corner on 
the GOT monitor screen for two seconds.

3. The utility screen appears. Touch [Controller] 
in the [GOT basic set] tab.

4. In [Communication setting], touch [Assign 
Ethernet I/F].

(Next page)

Utility call key

Hold down the upper left corner 

for two seconds.

Touch 

[Controller].

4.
4. From GOT screen creation up to the test
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POINTPOINTPOINT

When the target communication driver is not set, perform one of the following operations.
(1) Change the communication driver settings

(a) Touch the [Channel - Driver assign] button in the "Communication setting" screen.
(b) In the "Channel - Driver assign" screen, touch the [Change assignment] button.
(c) The communication drivers installed on the GOT are displayed. Select the target communication driver 

and touch the [OK] button.

The GOT automatically restarts after this setting is executed.
If project data has been written to the GOT, the GOT starts monitoring a controller after the restart.
Execute this setting after carefully confirming the safety.

(2) Reinstalling the target communication driver using GT Designer3
If you do not find the target communication driver when performing the above operation, install it using GT 
Designer3.

(From previous page)

5. In [Ethernet I/F assignment], check that the 
Ethernet I/F setting of the channel No. 1 has 
been set to [Ethernet (standard I/F)].

5.
4 - 34 4. From GOT screen creation up to the test
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5. Drawing fundamentals

This chapter explains how to create screens on the GOT.
The screen data created in this chapter works with the sequence program described in section 5.12.

5.1 Switching the screen to be displayed

5.1.1 The screen type

The GOT2000 comprises the following screen types.

(1) Base screen
The basic screen display on the GOT.

(2) Window screen
A screen overlapped the base screen. The following screen types are available.
• Superimpose window : A window superimposed on a base screen and displayed as a part of the 

base screen.

• Overlap window : A pop-up window displayed over a base screen.
Displaying the title bar enables you to move and delete the window 
manually.

• Key window : A pop-up window displayed on a base screen for the input by the numerical 
input function.
Two types of key windows are provided: standard key window and user-
created key window.

• Dialog window : A window displaying error messages, warning messages, and the GOT 
system messages in the foreground.
While a dialog window is displayed, other screens cannot be operated.

Production 

status screen 1

A 1254 B 348

Production 

status screen 1

A 1254 B 348

Production 

status screen 1

A1254 B 348

Back

Front

Base screen

Superimpose window 1, 2

Overlap window 1, 2, 3, 4, 5

Key window

System message
Dialog window
5. Drawing fundamentals
5.1 Switching the screen to be displayed
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RemarkRemarkRemark
• Up to 4096 base screens and up to 1024 window screens can be created.
• For base screens and window screens, the range of registerable screen numbers is 0 to 32767.
• For the display position setting of window screens, refer to the GT Designer3 (GOT2000) Screen Design 

Manual.

5.1.2 Screen switching device

The screen switching device is set to switch the base screens or to display the window screen on the GOT.
Set a screen switching device for each of the following screens.
• Base screen
• Overlap window 1 to 5
• Superimpose window 1, 2
• Dialog window

RemarkRemarkRemark
• For information on how to set the screen switching devices, refer to 4.2.3.

(1) Screen switching of base screens
The GOT displays a base screen whose screen No. is the same as the value of the screen switching device.
Example) Storing 20 in the screen switching device (D100) while displaying the base screen whose screen No. 

is 10

If the value of the screen switching device is 0, the GOT displays a base screen whose screen No. is the 
minimum.
Example) Storing 0 in the screen switching device (D100) if the minimum screen No. is 1

If the screen number which does not exist is stored in the screen switching device, the system alarm is 
displayed.
In that case, the screen is not switched.
Example) Storing the screen No.50 of the base screen which does not exist in the screen switching device 

(D100)

D100: 10 D100: 20

The device value of 

D100 is changed. 

(10 to 20)

Base screen

(screen number: 10)

Base screen

(screen number: 20)

Line A status

The GOT displays a base 

screen whose screen No. is 

the same as the value of the 

screen switching device.

D100: 10 D100: 0

The device value of 

D100 is changed. 

(10 to 0)

Base screen

(screen number: 10)

Base screen

(screen number: 1)

Line A status

The GOT displays a base 

screen whose screen No. is 

the minimum.

Line A status

D100: 10 D100: 50

The device value of 

D100 is changed. 

(10 to 50)

Base screen

(screen number: 10)

Base screen

(screen number: 10)

Line A status

The GOT displays the system alarm.

The base screen is not switched.
5 - 2 5. Drawing fundamentals
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(2) Screen switching of overlap windows and superimpose windows
The GOT displays the window screen whose screen No. is the same as the value of the screen switching device 
as an overlap window or a superimpose window.
Example) Setting D100 for the screen switching device of an overlap window

When the screen switching device stores the value set to [Screen No. of the window screen to be hidden] in 
[Environment Setting] window, the GOT closes the target overlap window or superimpose window.
Example) Storing 0 in the screen switch device (D200) while displaying the overlap window 1

([Screen No. of the window screen to be hidden]: 0)

If the screen number which does not exist is stored in the screen switching device, the system alarm is 
displayed.
In that case, the screen is not switched and the window which has been displayed remains displayed.
Example) Storing the screen No.50 of the window screen which does not exist in the screen switching device 

(D200)

D200: 0 D200: 10

The value of D200 

is changed.

(0 to 10)

Window screen

(screen number: 10)

Window screen: 10 Window screen: 20

Window screen

(Not displayed)

D200: 20

The value of D200 

is changed.

(10 to 20)

Window screen

(screen number: 20)

The GOT displays a window 

screen whose screen No. is 

the same as the value of the

 screen switching device.

D200: 10 D200: 0

The device value of 

D200 is changed. 

(10 to 0)

Overlap window 1

(screen number: 10)

The GOT closes the 

overlap window 1.

Window screen 10D200: 10 D200: 50

The device value of 

D200 is changed. 

(10 to 50)

The GOT displays 

the system alarm.

Window screen 10

The window which has been 

displayed remains displayed.
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(3) Screen switching of dialog windows
The following two methods are available to display a created dialog window.
• Displaying a created dialog window as a new message

Storing the screen number of the created dialog window to the screen switching device enables the display of 
the dialog window.
Storing 0 to the screen switching device closes the displayed dialog window.
Example) Storing the screen number of the window screen 20 to the screen switching device (D300) for the 
dialog window

• Displaying a created dialog window instead of the system message of the GOT
A created dialog window can be displayed instead of the system message of the GOT.
This is called the system message replacement display.
Storing 0 to the screen switching device closes the displayed dialog window.
Example) Displaying the window screen with the screen number 20 instead of the system message at an 

error operation (Screen switching device (dialog window): D300)

Line A             258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 .

Enter

Line A             258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 .

Enter

D300: 0 D300: 20

The device value of 

D300 is changed. 

(0 to 20)

A dialog window

(window screen with the screen 

number 20) is displayed.

The input value is 

beyond the range.
Input a correct value.

OK

A dialog window

Line A              258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 .

Enter

Line A             258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 .

Enter

D300: 0 D300: 20

The data beyond the 

range is input by the 

numerical input. 

(Error operation)

A dialog window is displayed instead of the 

system message.

The input value is 

beyond the range.
Input a correct value.

OK

The data beyond the range is input.

-32767 <= input <= 32767

OK

System message A dialog window

The screen number of the displayed 

window screen is stored.
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5.1.3 Base screen switching with the sequence program

GOT display screen is switched when the screen switching device value is written with the sequence program.
Example: When the switching device for base screen is D0

The current value of D0 is stored six because the 
GOT displays screen No. 6.
Turn on X1 with the sequence program, and D0 
value is changed to two.

The GOT displays screen No. 2 because D0 value 
is changed to two.

MOV K2 D0

X2X1

MOV K3 D0

X1X2

Sequence program example

Screen No. 6

1234Data 2

Screen No. 6

1234Data 2

StopRUN

Screen No. 2
5. Drawing fundamentals
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5.1.4 Base screen switching with the touch switch

GOT display screen is switched when the screen switching device value is written with the touch switch.
Example: In the case of device for base screen switching: D0

The current value of D0 is stored five because the 
GOT displays screen No. 5.
Set both of X1 and X2 in OFF with sequence 
program, and touch No. 10 touch switch.

The GOT displays screen No. 10 because the 
current value of D0 is changed to 10 with the touch 
switch.

Touch switch setting

Operation setting: Base switching

Fixed to "10"

No. 10

RUN lamp

Screen No. 5

No. 10

RUN lamp

Screen No. 5

Stop

Screen No. 10
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5.1.5 Window screen display and switching

The window screen is displayed by writing the same No. as the window No. of the
screen to be displayed into the switching device used in overlap windows 1 to 5.
Two types of writing in the screen switching device are available: writing with the sequence program, and writing with the 
GOT touch switch.

POINTPOINTPOINT

When "zero" is written in the screen switching device, the window screen is not displayed.

Example: When the switching device for base screen is D0, and that for overlap window 1 is D1.

The current values of the switching device are the 
below because the GOT displays only base 
screen No. 15.
D0 = "15"
D1 = "0"
Turn ON X3 with the sequence program, and D1 
value is changed to three.

The GOT displays window screen No. 3 because 
D1 value is changed to three.

When closing the window screen, operate either of 
the following methods.

• Touch  in the upper right corner of the window 
screen.

• Write "zero" as the D1 value in the overlap 
window1 screen switching device.

MOV K3 D1

X4X3

MOV K0 D1

X3X4

Sequence program example

Screen No. 15

Data 4    999

Screen No. 15

Data 4 999

Screen No. 15

Data 4 999Window Screen 

No. 3

Window Screen 

No. 3
5. Drawing fundamentals
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[Screens to be created]
Screens to be created in this chapter and a summary of screen switching are as follows:
" " refers to the screen switching (page switching) operation.

Base Screen No. 1

(Sets objects such as switch, lamp, numerical display, etc.)

Window Screen No. 1

(Displays over the base screen. Shows current time.)

Base Screen No. 2

(Displays the error which occurred in GOT or PLC.)
5 - 8 5. Drawing fundamentals
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5.2 Before creating the screen

5.2.1 Operations before creating the screen

Set the project using [New Project Wizard] in the following manner:

(1) System Settings for GOT
GOT Type: GT27**-S (800x600)
Color Setting: 65536 Colors

(2) Confirmation
Controller Type: MELSEC-Q/QS, Q17nD/M/NC/

DR, CRnD-700
I/F: Standard I/F(Ethernet):Multi
Communication Driver: Ethernet(MELSEC), 

Q17nNC, CRnD-700, 
Gateway

(3) Screen Switching Device Setting
Base Screen: D0
5. Drawing fundamentals
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(4) Screen Property
Enter "Base screen".

(5) Saving project data
Save the project data.

Select [Project] - [Save As] from the menu and 
save the current project with the name "BASIC1".
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5.2.2 Figure drawing

This section describes how to draw figures and how to edit the figures arranged on the screen.

(1) Types of drawable figures
The following figures can be drawn on GT Designer3:

Shape Drawing example Reference

Text (5) Text settings

Logo text -

Line (2) Drawing line, rectangle, and circle

Line free form (3) Drawing polygon and line free form

Rectangle (2) Drawing line, rectangle, and circle

Polygon (3) Drawing polygon and line free form

Circle
(including ellipse) (2) Drawing line, rectangle, and circle

Arc
(including elliptic arc)

(4) Drawing arc and sector

Sector (4) Drawing arc and sector

Table -

Scale -

Piping -
5. Drawing fundamentals
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(2) Drawing line, rectangle, and circle
This section describes how to draw a line using an example.

1. Click  on the toolbar (Figure).

Drawing rectangle: Click .

Drawing circle: Click .

2. Click the left mouse button at the starting 
point for drawing a line.

3. Drag and move the cursor to the end point.

(Next page)

1.

Start point

Start point

End point
5 - 12 5. Drawing fundamentals
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(3) Drawing polygon and line free form
This section describes how to draw a polygon using an example.

(From previous page)

4. Release the left mouse button to draw a line.

1. Click  on the toolbar (Figure).

Drawing line free form: Click .

2. Click the left mouse button at the starting 
point for drawing a polygon.

(Next page)

Start point

End point

1.

Start point
5. Drawing fundamentals
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POINTPOINTPOINT

Editing a figure with the vertex edit handle
(1) Select [Edit] → [Edit Vertices] from the menu and select a figure.
(2) Drag the handle to change the vertex position and release the mouse button to determine the change of the 

vertex position of the figure.

(From previous page)

3. Drag and move the cursor to the second 
vertex.

4. Release the left mouse button to determine 
the second point.

5. Click the left mouse button at the third vertex.
Repeat this procedure to increase the 
number of vertexes.

6. Double-click at the last vertex to form a 
polygon.

Start point

Second point

Start point

Second point

Third point 

Start point

Second point

Third point

Last point

Drag a handle. Release the mouse button.
5 - 14 5. Drawing fundamentals
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(4) Drawing arc and sector
This section describes how to draw an arc using an example.

1. Click  on the toolbar (Figure).

Drawing sector: Click .

2. Click the left mouse button at the starting 
point for drawing an arc.

POINTPOINTPOINT

Set the starting point and the endpoint of a 
radius.

(Next page)

1.

Start point
5. Drawing fundamentals
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(From previous page)

3. Drag and move the cursor to the end point.

4. Release the left mouse button. A line from the 
center of the circle is drawn.

5. Drag and move the cursor to define the 
starting point of arc.

POINTPOINTPOINT

Set the starting point and the endpoint of an 
arc.

6. Click the mouse to determine the starting 
point of arc.

7. Drag and move the cursor to define the end 
point of arc.

(Next page)

Start point

End point

Start point of arc

Start point of arc

End point of arc
5 - 16 5. Drawing fundamentals
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RemarkRemarkRemark

Drawing sector
Double-click the drawn arc and check [Sector] in the Arc/Sector dialog box to draw a sector.

(From previous page)

8. Click to form an arc.
5. Drawing fundamentals
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(5) Text settings
This section describes how to set a text (input a text).

1. Click  on the toolbar (Figure).

2. Click the left mouse button at the starting 
point for placing a text.

3. The setting dialog appears.

(Next page)

1.
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(From previous page)

4. Enter a character string. Enter "GOT2000 
series" here.

5. After entering the character string, click the 
[OK] button.

6. The character string is displayed.

4.

5.
5. Drawing fundamentals
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(6) Selecting data for editing
This section describes how to select the desired figure/object for editing.

1. Click  on the toolbar (Main).

2. To select data, first click the left mouse button 
at the starting point to drag and move the 
cursor to the end point, and then release the 
left mouse button to include all the data 
necessary.

1.

Start point

End point
5 - 20 5. Drawing fundamentals
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(7) Changing attribute
Change the attribute of the created figure on the property sheet.
This section describes how to change the color for a circle using an example.

1. Select the figure.

2. Change the attribute on the property sheet.

3. Change the pattern color from [None] to [Fill 
Color (White)] for the circle.

(Next page)

3.
5. Drawing fundamentals
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(From previous page)

4. The changes made are reflected on the 
figure.
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To change attributes other than the pattern figure color, use the following items of the property sheet.

POINTPOINTPOINT

The attributes in the figure setting dialog box can also be changed by double-clicking the figure.

1) [Line Style]
Select a line style of the figure.

2) [Line Width]
Select a line width.

3) [Line Color]
Select a line color.

4) [Pattern]
Select a filling pattern for the figure.

5) [Shape Color]
Select a fill color of the figure.

6) [Background Color]
Select a background color for the figure.

7) [Text Color] (only when text is selected)
Select a text color.

8) [Text Style] (only when text is selected)
Select a text style.

9) [Solid Color] (only when text is selected)
Select a text solid color.

4)

2)

3)

5)

1)

6)

9)

8)

7)
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(8) Size change
This section describes how to expand/reduce the size of figure/object.

POINTPOINTPOINT

Size changes as follows are possible using  key or  key.
•  key : Proportional transformation
•  key : Concentric transformation

1. Select a figure/object of which the size needs 
to be changed.

2. Click the left mouse button on the handle (●) 
on the direction to which the figure is 
expanded/reduced, and then drag the cursor.

3. Release the left mouse button to complete 
the size change of figure.

This is 

the handle.

Drag

Shift Ctrl
Shift
Ctrl
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(9) Moving selected data
This section describes how to move the figure/object.

1. Select the figure/object to be moved.

2. Move the cursor to the figure/object to be 
moved to change the cursor shape into .

3. Click the left mouse button and drag the 
figure/object to the desired position.

4. Release the left mouse button to determine 
the position for displaying the figure/object.

Drag
5. Drawing fundamentals
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(10) Cutting, copying, pasting, or duplicating the selected data
The following shows how to cut, copy, paste, or duplicate a figure or object.

(a) Cut and paste

POINTPOINTPOINT

• Similar operations can also be performed by using the following keys cut/copy can also be performed by using 
the following keys.
For cutting:  key +  key
For copying:  key +  key

• Figure/object can be deleted by using  key.
The deleted figure/object cannot be "pasted", but can be "undone".

1. Select the desired figure/object.

2. For cutting, click  on the toolbar (Main).

(For copying, click )

2.

Ctrl X

Ctrl C

Delete
5 - 26 5. Drawing fundamentals
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(b) Pasting
This section describes how to paste the cut or copied figure/object using an example.

POINTPOINTPOINT

• Pasting can also be performed by using  +  keys.

1. Click  on the toolbar (Main).

2. A display range frame appears. Move it to the 
desired position.

3. Click the mouse button to paste the cut 
figure/object.

1.

Ctrl V
5. Drawing fundamentals
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(c) Duplicate
Copies and pastes a selected figure or object at a time.
Select a figure or an object placed on the screen editor and use [Duplicate].

1. Select a figure or an object.

2. Select [Edit] → [Duplicate] from the menu.

3. The selected figure or object is copied and 
pasted with a certain interval.

2.
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5.3 Text settings
This section describes how to create actual screens.

The following characters will be placed on Base Screen No.1.

(1) Click  on the toolbar (Figure), and then click any where on the drawing screen.

(2) The [Text] dialog box appears.
Enter "Planned operating time" on the [Text] dialog box.

POINTPOINTPOINT

• Up to 512 characters can be entered in [Text] dialog box.
• A text can be entered on multiple lines.

• To start a new line (line feed), press the  key at the end of the current line.

Screen

No. 2

Screen

No. 1

Window

No. 1

Set a title and a unit by using text figures. 
(Select a standard font or the outline gothic font 
in the text figure setting.)

Enter
5. Drawing fundamentals
5.3 Text settings

5 - 29



(3) Set the attributes for the entered characters.

(a) Style
The following text styles are available.

(b) Font

Standard Bold Solid Raised Reverse Rotate/Flip

Font
Image

Classification Type

Outline font
Outline Square style

Outline Gothic

Standard font

6 × 8 dots (Gothic)

12-dot Standard (Gothic)

16-dot Standard (Mincho)

16-dot Standard (Gothic)

HQ font

12-dot HQ Mincho

12-dot HQ Gothic

16-dot HQ Mincho

16-dot HQ Gothic

TrueType font

TrueType Mincho

TrueType Gothic

TrueType Numerical (Gothic)

TrueType Numerical (7-Segment)

Windows font
The TrueType font and OpenType font that 
can be displayed on a personal computer 
(other than vertical fonts)
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(4)  Click the  button.
"Planned operating time" is displayed on the screen.
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5.4 Numerical input/numerical display settings
This function is used to write or display the data stored in the devices of the controller.
In this section, create a numerical display showing the operating time, and a numerical input for 
entering the planned operating time.

5.4.1 Numerical input settings

Making the settings of numerical input (D10)

(1) Click of  on the tool bar (Object) and select , and then click any where on the drawing screen.

1. Move the cursor on to the screen, 
determine the position for display, and then 
click the mouse button.

2. The numerical input is placed.

POINTPOINTPOINT

An object can be placed with changing its 
size by clicking and dragging the cursor.

3. Double-click the placed numerical input.

Screen

No. 2

Screen

No. 1

Window

No. 1

Numerical input:
Four digits for decimal number
Write device: D10

Numerical display:
Four digits for decimal number
Read device: D20
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(1) Changing the size of an object after being placed
This section describes how to change the size of arranged object.
(a) Select the object to be changed in size.
(b) Position the cursor on the sizing handle, click and drag it to change the object size.
5. Drawing fundamentals
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(2) Making basic settings

(3) Setting the display format (to handle decimal number in a range of 0 - 9999)

1. Set [Type] to [Numerical Input].

2. Click the  button.

3. Set "D10" for [Device].

4. After setting is completed, click the 
 button.

1. Set [Format] to "Signed Decimal".

2. Set [Digits (Integral)] to "4".

3. Set [Font] to "Outline Gothic".
(For GT27, the default setting of Font is 
Outline Gothic. )

4. Set [Number Size] to "32".

5. Click the  button.

1.

2.

3.

4.

1.

3.

4.

2.

5.
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(4) Making settings on the screen

1. Use text figure to assign unit to numerical 
input.

This completes the settings of the numerical 
input.

1.
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5.4.2 Numerical display settings

Making the settings of numerical display (D20)

(1) Click  on the toolbar (Object), and then click any where on the drawing screen.

(2) Double-click the numerical display, and make the settings as follows:
(the same procedures as those described in section 5.4.1)

(3) Making settings on the screens
(the same procedures as those described in section 5.4.1)

1. Set "D20" for [Device].

2. Select "4" for [Digits (Integral)].

3. Select "Outline Gothic" for [Font].

4. Set [Number Size] to "32".

5. Click the  button.

1. Set a title and a unit by using text figures.

This completes the settings of the numerical 
display.

1.

3.
4.

2.

5.

1.
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5.4.3 Key window

The key window has two types: GOT default key window (standard key window) and key window created by the user 
(user-created key window).

(1) Standard key window
The standard key window is a GOT default window for inputting numerical values and characters.
The type of the standard key window to be displayed changes automatically according to the data type of the 
input area (hexadecimal number, decimal number, octal number, binary number, or character string).
(a) Key window for numeric values

When the data type of the input area is hexadecimal number, octal number, or binary number, the key 
window for hexadecimal numbers is displayed.
When the data type of the input area is decimal number, the key window for decimal numbers is displayed.

(b) Key window for character strings (key window for alphabets and key window for kana)
When the data type of the input area is character string, the key window for character strings is displayed.
Use the keys for switching character types sequentially and the keys for switching character types directly 
to switch the character type used in the key window.

Example) Key window for decimal numbers Example) Key window for hexadecimal numbers

Example) Key window for kanaExample) Key window for alphabets
5. Drawing fundamentals
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(2) User-created key window
By displaying a user-created window screen as a key window, it can be used as the user's original key window.

POINTPOINTPOINT

By registering a user-created window screen as a key window, the key window for numerical input can be used as 
the user's original key window.
The registered key window is displayed instead of the standard key window.
For information on how to create a user's original key window, refer to the GT Designer3 (GOT2000) Screen 
Design Manual.

Example) User-created key window (for text input) Example) User-created key window (for numerical input (decimal))
5 - 38 5. Drawing fundamentals
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5.5 Settings of lamps
This function is used to turn on/off the lamp depending on the bit device condition (on/off) or the value 
of word device.
In this section, create a lamp that turns on when Y7A is on.

(1) Using a lamp that is registered in the library
Use a lamp that is registered in the library of GT Designer3.

1. Touch the docked [Library] tab.

(Next page)

Screen

No. 2

Screen

No. 1

Window

No. 1

Lamp

This lamp turns on when Y7A is turned on.

1.
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(From previous page)

2. Select [FA Metal_N Lamp 1] in the [Library] 
folder.

3. Click the toolbar option and set the lamp color 
to "Green".

4. Click "68 L_05_G".

(Next page)

2.

3.

4.
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(2) Settings of lamps

(3) Making settings on the screen

(From previous page)

5. On the screen, click the mouse button to 
place the lamp.

6. Double-click the placed lamp to display the 
setting dialog.

1. Set [Device] to "Y7A".

2. When setting is done, click the  
button.

1. Use text figure to create title for Lamp.

This completes the settings of the lamp 
display.

1.

2.
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5.6 Touch switch settings
Make the settings for the switches which behave as follows when touched.
• Bit Switch   : Turns bit device ON/OFF when touched.
• Go To Screen Switch : Switches base screen/window screen when touched.

5.6.1 Bit switch settings

Creating a touch switch which turns the bit device (M10) ON when touched.

(1) Place a touch switch.

1. Click on the [Object] - [Switch] - [Bit Switch] 
menu.

2. Move the cursor to the position where the 
touch switch is placed, and click the mouse 
button.

3. The touch switch is placed.

4. Double-click the placed touch switch to 
display the setting dialog.

Screen

No. 2

Screen

No. 1

Window

No. 1

Bit switch
Turns M10 ON.

Bit switch
Turns M10 OFF.

Bit switch
Turns M30 ON.

Screen switching switch
Switches to Base Screen No. 2.

Screen switching switch
Displays Window Screen No. 1.
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5.6 Touch switch settings



1

W
H

AT
 IS

 T
H

E 
G

O
T?

2

G
O

T 
O

PE
R

AT
IO

N

3

AB
O

U
T

G
T 

D
es

ig
ne

r3

4

FR
O

M
 G

O
T 

SC
R

EE
N

 
C

R
EA

TI
O

N
 U

P 
TO

 
TH

E 
TE

ST

5

D
R

AW
IN

G
 

FU
N

D
A

M
EN

TA
LS

6

AB
O

U
T 

D
EB

U
G

AP
PE

N
D

IC
ES
(2) Bit switch settings

1. Click the  button in [Switch Action].

2. As the  device setting dialog box appears, 
set the device to "M10".

3. After setting is completed, click the 
 button.

4. Set [Action].
[Action] determines how the bit device will 
behave when touched.

•Momentary : turns on while 
being touched
(turns OFF when 
released)

•Alternate : toggles ON/OFF 
when touched

•Set : turns ON when 
touched

•Reset : turns OFF when 
touched

Select "Set" here.

1.

2.

3.

4.
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(3) Setting a display style

1. Click the [Style] tab.

2. Click the  button.

(Next page)

1.

2.
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(From previous page)

3. As the [Image List] dialog box appears, 
select the figure "33 SW_02_0_B".

4. After setting is completed, click the 
 button.

5. Set the shape attribute for the OFF state as 
follows.

Shape Color: Blue

6. Click the shape of the ON state to set the 
shape attribute for the ON state.

7. Set the shape attribute for the ON state as 
follows.

Shape Color: Blue
Blink: None

8. Click the  button.

3.

4.

5.

6.

8.
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(4) Creating other bit switches
Copy the touch switch created in (2) and paste the copy to create a new touch switch.
The following shows how to copy and paste a touch switch.

1. Click the copy target touch switch to select it.

2. Click  on the toolbar. (Or Ctrl + C)

3. Click  on the toolbar. (Or Ctrl + V)

4. A display range frame appears. Move it to the 
desired position.

5. Click the frame to paste the copy of the touch 
switch.

2.

3.
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To adjust the touch area of a touch switch according to the switch size, perform the following operations.

(a) Right-click the mouse and select [Edit Touch Area] → [Manual Edit] from the menu.
(b) Change the size of the touch switch effective area so that it overlaps the touch switch figure size.

The touch switch effective area can be changed in one dot unit.

(5) Naming the switches

6. Create two switches as described in  
above.

7. Change the settings of switch created by 
copying/pasting as follows:

Touch switch 
name

Setting item Setting

Line stop switch

Switch action

Device M10

Operation 
setting Bit reset

Key touch 
OFF

Shape 
color Yellow

Key touch ON
Shape 
color Yellow

Blink Disabled

Reset switch

Switch action

Device M30

Operation 
setting

Bit set

Key touch 
OFF

Shape 
color

Red

Key touch ON

Shape 
color

Red

Blink Disabled

1. Set the names of the three switches by 
placing text figures on the screen.

This completes the settings of the bit 
switch.

Effective area for touch switch

Touch switch size

6.

5.

1.
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5.6.2 Bit switch actions

A bit switch turns on and off the bit device specified by the switch.
The following shows the actions that can be set with bit switches.

(1) Bit momentary
Keeps a specified bit device on only while you touch the switch.

(2) Bit alternate
Alternates the status of a specified bit device (ON←→OFF) when you touch the switch.

(3) Bit set
Turns on a specified bit device when you touch the switch.

(4) Bit reset
Turns off a specified bit device when you touch the switch.

X0001: OFF

STOP

X0001: OFF

STOP

X0001: ON

RUN

X0001: OFF

STOP

X0001: ON

RUN

X0001: OFF

STOP

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: OFF

STOP

X0001: OFF

STOP

X0001: OFF

STOP

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: OFF

STOP

X0001: ON

RUN

X0001: OFF

STOP

X0001: OFF

STOP

X0001: OFF

STOP

X0001: OFF

STOP
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5.7 Operation check 1
Select [Communication] → [Write to GOT] from the menu to display the screen for writing project data.
Select data and a write mode, and then click the [GOT Write] button to write all data to the GOT.

Reset the PLC CPU using the RESET key switch, and then switch to RUN.

Check if each switch of the initial screen (No.1) functions properly here.

(1) Test 1
Perform the following tests in screen No. 1.

(2) Test 2
Perform the following tests in screen No. 1.

*1  The line will not start when the operating time exceeds the planned operating time.

(3) Test 3
Perform the following tests in screen No. 1.

Test object

Item
Planned operating time (numerical input)

Touch operation Touch the numerical input area.

R
es

ul
t o

f o
pe

ra
tio

n

Screen status When a key window screen appears, enter the numeric value (15), and then press 
[Enter] of the key window.

Write device D10

Test object

Item
Line start switch RUN lamp

Operating time
(numerical display)

Touch operation*1 Touch ──── ────

R
es

ul
t o

f o
pe

ra
tio

n

Screen status The switch is pressed.
The lamp is on till the 
planned operating time.

Count up till the planned 
operating time.

Write device M10: ON ──── D20

Read device ──── Y7A: ON ────

Test object

Item
Line stop switch RUN lamp

Operating time
(numerical display)

Touch operation It is touched while the 
operation lamp is on.

──── ────

R
es

ul
t o

f o
pe

ra
tio

n Screen status The switch is pressed. The lamp is off. Count stops.

Write device M10: OFF ──── ────

Read device ──── Y7A: OFF D20
5. Drawing fundamentals
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(4) Test 4
Perform the following tests in screen No. 1.

Test object

Item
Reset switch RUN lamp

Operating time
(numerical display)

Touch operation Touch ──── ────

R
es

ul
t o

f o
pe

ra
tio

n

Screen status The switch is pressed. The lamp is off.
The operating time 
becomes "0".

Write device M30: ON ──── ────

Read device ──── Y7A: OFF D20
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5.8 Comment display settings
Two types of messages (comments) are displayed depending on the condition of devices.

Screen

No. 2

Screen

No. 1

Window

No. 1

Describes the line operation

(Y7B: ON/OFF) of comment display in the form of comment.

With Y7B ON, "line in operation" is displayed.

With Y7B OFF, "line stopped" is displayed.
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5.8.1 About the comment display

There are the following three types of comment display.

(1) Comment display (bit)
It is the function to display the comment corresponding to the ON/OFF status of bit device.
The following two comments are switched back and forth for displaying.

(2) Comment display (word)
This function displays the comment corresponding to the value of a word device.

(3) Comment display (simple)
This function displays comments without setting a device.

RemarkRemarkRemark
The comment to be displayed by comment display needs to be registered in advance.

X10 = OFF

Comment when 

bit device is OFF

Pro. line con.

X10 = ON

Comment when 

bit device is ON

Pro. line con.

Conv. st. During oper.

D10

Display comment of 

comment No.1

Pro. line con.

D10

Display comment of 

comment No.10

D10

Display comment of 

comment No. 100

Conv. st. CompletedDuring oper.

1 10 100

Pro. line con. Pro. line con.

Comment No. 1

The comment No. 1 is 

always displayed.

Pro. line con.

During oper.
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5.8.2 Comment display settings by bit device

(1) Registering comments

1. Double-click [New] of the [Comment] menu 
in the project tree.

2. When [Comment Group Property] appears, 
configure the setting as follows.
Group No.: 1, Line operating status

3. Click the  button.

4. When the [Comment List] dialog appears, 
configure the settings as follows.

Comment No. 1
Comment: "Lines stopped"
Text: Yellow

Comment No. 2
Comment: "Line operating"
Text: Green

1.

2.

3.

4.
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Displaying multi-language comments (Language switching device)
If you set multiple comment columns in a comment group, the comments can be registered in multiple languages 
for one comment No.
The comments registered in multiple languages can be switched by switching the comment column to be displayed 
with the language switching devices.
Example) Switching comments with the language switching device

Column No.1Comment No.

1

3

2

Comment group No. 1

• D500 = 1 • D500 = 2

Start

Column No.2

Start

Running

Done

Language switching device: D500

Comment No. to be displayed: 1

Comment of the column 

No.1 is displayed.
Comment of the column 

No.2 is displayed.
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(2) Click  on the toolbar (Object) to place a comment on the object screen.

(3) Comment display setting

1. Double-click the comment display.
The comment display (Bit) dialog box is 
displayed.

2. Click the  button to set the device to 
"Y007B".

3. Click the [Comment] tab.

4. Set [Font] to "Outline Gothic" and [Text Size] 
to "32".

5. Set "Alignment" to "Center".

6. Deselect [OFF=ON].

7. Click the [ON] button.

(Next page)

3.

2.

4.

6.

5.

7.
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(1) A comment can be created with 1 to 1024 characters.
(2) Comments can be created on multiple lines.

Comments are displayed in the GOT as follows:

(From previous page)

8. Set comments to be displayed when the 
device is ON.

9. Set [Comment No.] to 2.

10. Click the  button.

10.

9.

In operation now

Y70 is ON.

In operation now

Y70 is ON.

Display range
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(4) Settings on object screen
Adjust the size of object frame so that all the comments are displayed.
Create a frame for the comments.

1. As the cursor changes to a re-sizing cursor 
when it is moved over to the handle, click the 
left mouse button and drag it to the desired 
size for displaying.

2. When the display area is determined, release 
the left mouse button.

3. Create a frame showing the comment display 
area by using a figure such as a rectangle.
This completes the settings of the comment 
display by a bit device.

To create a frame showing the comment 
display area, set [Shape] on the [Device/
Style] tab in the [Bit Comment Display] dialog.
5. Drawing fundamentals
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• The display condition for set comments can be displayed switching between ON and OFF by pressing the "ON/OFF 
of object function" button on the toolbar (Display setting).

• Adjust the size of display area when the comments vary in length depending on its ON/OFF condition as 
follows:

(Example) In case of ON, [Alarm: The water level is at upper limit.].
In case of OFF, [lower limit].
Adjust the size of display area to be able to display a longer comment by switching comment 
displays with the "ON/OFF of object function" button of toolbar (Display setting).
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5.9 Window screen creation
Create a screen displayed over the base screen.
Window screen No. 1 is displayed in Overlap window 1 here.

(1) Making the settings of screen switch device

1. Click the docked [System] tab.

2. The system tree is opened. Double-click 
[GOT Setting] → [Environmental Setting].

3. Double-click [Screen Switching/Window].

(Next page)

Screen

No. 2

Screen

No. 1

Window

No. 1

Displays the clock.

1.

2.

3.
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(2) Creating window screen

(From previous page)

4. Check [Overlap Window1].

5. Click the  button to set the device to 
"D1".

6. Click the  button.
This completes the settings of the screen 
switching device.

1. Select the [Screen] - [New] - [Window 
Screen] menu.

2. As a dialog box appears, check that the 
"Window Screen" is selected on [Screen 
Type].

3. Enter "Sub screen" for [Screen Name].

4. Click the  button.

Window screen No. 1 is displayed on the screen.

4.

5.

6.

3.

2.

4.
5 - 60 5. Drawing fundamentals
5.9 Window screen creation



1

W
H

AT
 IS

 T
H

E 
G

O
T?

2

G
O

T 
O

PE
R

AT
IO

N

3

AB
O

U
T

G
T 

D
es

ig
ne

r3

4

FR
O

M
 G

O
T 

SC
R

EE
N

 
C

R
EA

TI
O

N
 U

P 
TO

 
TH

E 
TE

ST

5

D
R

AW
IN

G
 

FU
N

D
A

M
EN

TA
LS

6

AB
O

U
T 

D
EB

U
G

AP
PE

N
D

IC
ES
(3) Setting the time displayed on the window screen
The current time is displayed on the GOT.

1. Click  on the toolbar (Object).

2. Click on the upper left portion of the screen to 
place a time display.

3. Double-click the placed time display.

4. The [Time Display] dialog appears.

5. Select "Time" for [Type].
Hour:Minute:Second   09:13:12

6. Set [Time Type] to "Hour:Minute:Second".
The current time is displayed in the "Hour: 
Minute: Second" format.

7. Select [Fill with 0].

8. Set [Font] to "Outline Gothic" and set 
[Number Size] to "32".

9. Click the  button. 

10.Enter "Current time" above the time display.

1.

8.

7.

5.

6.

9.

10.
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(1) Date and time displayed by time display function
The time display function represents the date and time of the GOT maintained by the internal clock function.
The clock function sets the clock to be used as standard for adjusting the time between the GOT and PLC 
CPU.
The way of adjusting the time between the GOT and PLC CPU differs as follows depending on the clock to be 
used as standard:

(a) Using the time of clock data in PLC CPU as standard (time adjustment)
Set the clock data of GOT to the time of clock data in PLC CPU.

(b) Using the time of clock data in GOT as standard (broadcast)
Set the clock data of PLC CPU to the time of clock data in GOT.
A battery is required for the clock data to be maintained while the power to GOT is off.

(2) Change in settings of clock function
The settings of clock function can be changed using the clock setting function provided in GT Designer3 or 
Utility function.

For the details of the time display function, refer to the GT Designer3 (GOT2000) Screen Design Manual.

(a) Adjust

(b) Broadcast
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5.10 System alarm settings
Create Base Screen No. 2 and set the system alarm.
Refer to section 4.5.1 for details for system alarms.
The following screen will be created in Base Screen No.2.

5.10.1 System alarm settings

(1) Creating Base Screen No.2

1. Select the [Screen] - [New] - [Base Screen] 
menu.

2. As a dialog box appears, check that the 
"Base Screen" is selected on [Screen Type].

3. Enter "Alarm screen" for [Screen Name].

4. Click the  button.

(Next page)

Screen

No. 2

Screen

No. 1

Window

No. 1

Creates a Screen switching switch 

of Return to Base Screen No. 1.

Creates a title with text.

Creates a system alarm.

4.

3.

2.
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(2) Creating a title text for the system alarm
Enter "System alarm" in Text.

(3) Setting a system alarm.

(From previous page)

Window screen No. 2 is displayed on the screen.

1. Select Object- Alarm Display- System Alarm 
Display.
Click on the screen to place a system alarm 
display.

2. Double-click the system alarm which has 
been placed.
The [System Alarm Display] dialog appears.

3. Configure the system alarm display settings.
Shape: @Frame(1): Frame_5
Display detailed information on the target 
alarm: Deselected

4. Click the  button.

5. Adjust the size of system alarm so that all the 
system alarms are displayed.
Position the cursor over the handle, click and 
drag it to the desired size for displaying the 
system alarm.

6. When the object and shape are adjusted, 
adjustment is completed.

4.

3.
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POINTPOINTPOINT

An adjustment of display area is required as illustrated below to keep part of alarm message from dropping out of 
the frame.

• When "Display detailed information on the target alarm" is selected, the alarm messages containing the 
information to identify devices, objects, or functions that caused alarms are displayed.

• If alarm messages are not displayed entirely even though the display range has been adjusted, set [Display 
Alarm] to [System Alarm] and set [Display Type] to [Flow] in the [Alarm Popup Display] dialog. (As the error 
codes used for the GOT2000 series have been increased, system alarm messages are not displayed entirely in 
VGA resolution.)

RemarkRemarkRemark

Size change of object with shape

(1) Method of changing size
(a) Select the object to be changed in size.
(b) Position the cursor over the sizing handle, click and drag it to change the desired size.

Set in three lines.

Enlarge the size until the time of the alarms occurred is displayed on the right edge.

Error message (Max. 64 digits) The time of the alarms occurred (Fixed eight digits)

400 Unable to communicate with CPU
3       AC down error
803 Transient error
5. Drawing fundamentals
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Misalignment of object and figure
(1) Centering the object in the figure

Right click on the object to be realigned.

(2) Moving the object to any position within the figure
The position of object and shape can be changed separately as instructed below.

(3) Moving the object to any position within the figure
The position of object and shape can be changed separately as instructed below.

Right-click the mouse and select [Centering] in menu.

Right-click the mouse and select [Edit 
Touch Area] → [Manual Edit] from the 
menu.

Move the object to change the 
position.

Right-click the mouse and select [Edit 
Touch Area] → [Manual Edit] from the 
menu.

Drag the object to change its size.
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5.10.2 Go To Screen Switch setting

Create a switch which can switch a base screen to another or display a window screen by touch operation.

(1) Placing a Go To Screen Switch.

(2) Setting operation of Go To Screen Switch.

1. Display Base Screen No. 1.

2. Select the [Object] - [Switch] - [Go To Screen 
Switch] menu.

3. Move the cursor to the position where the Go 
To Screen Switch is placed, and click the 
mouse button.

4. Double-click the placed Go To Screen switch.

1. Check that "Base" is selected in [Screen 
Type].

2. Set [Next Screen]. The specified screen is 
displayed when the Go To Screen switch is 
touched.

"Fixed": 
switch to the Base Screen whose 
screen No. is specified.

"Back (Previous/History)": 
switch to previously displayed Base 
screen.
Up to 10 screens can be switched 
according to the history.

"Device": 
switch to the Base Screen whose 
screen No. is specified depending on 
the ON/OFF condition of the specified 
bit device.
(this is useful for returning to the 
previously displayed screen)

Here select "Fixed", and set "2" to switch to 
Base Screen No. 2.

1.

2.
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(3) Setting the display (figure, color) of Go To Screen Switch.

1. Click the [Style] tab.

2. Set the Display Style of Go To Screen Switch 
as follows:

"Shape": FA Control Switch Figure 
A1:SW_02_0_W (specified in 
Shape...)

<Shape attribute for [Key Touch OFF]>
[Shape Color]: White

<Shape attribute for [Key Touch ON]>
[Shape Color]: White
[Blink] : None

3. Click the [Text] tab.

(Next page)

1.

2.

3.
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(4) Create Go To Screen Switch which displays Window Screen No. 1.
Copy and paste the Go To Screen Switch to Base Screen No. 2 created above.
Make the settings of display and operation for the copied Go To Screen Switch as follows:

When setting is done, click the [OK] button.

(5) Create Go To Screen Switch for Window Screen No. 2.
Copy and paste the Go To Screen Switch created for Base Screen No. 1 on to Base Screen No. 2.
Make the settings of display and operation for the pasted Go To Screen Switch as follows:

When setting is done, click the [OK] button. The Go To Screen Switch setting has been configured.

(From previous page)

4. Set the text to be displayed in the switch as 
follows:

[Font] : Outline Gothic
[Text Size] : 12
[Text Color] : Black

5. Set the display position of text as follows:
[Display Position]: Center
[Alignment]: X: 

Y: 

The position of the texts used for switches 
and lamps can be selected among the 
following display positions:

6. Enter the following to [Text].
"Alarm screen"

7. Check that [OFF=ON] is selected.

8. Click the  button to complete the 
settings.

Setting item Setting

Next Screen tab

Screen Type Overlap window 1

Next Screen Fixed

Screen No. 1

Text tab Text Sub screen

Setting item Setting

Next Screen tab
Next Screen Fixed

Screen No. 1

Text tab Text Base screen

4.

7.

5.

8.

6.

Left

Up

Switch figure Right

Center

Down
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5.11 Operation check 2
Display the screen for writing a project, and then write data to the GOT.
Reset the PLC CPU using the RESET key switch, and then switch to RUN.
Check if the comment display in screen No. 1 is properly displayed, and that the overlap window (Window Screen No. 1) 
appears correctly here.

(1) Test 1
Perform the following tests in screen No. 1.

(2) Test 2
Perform the following tests in screen No. 1.

(3) Test 3
Perform the following tests in screen No. 1.

Test object

Item
Planned operating time (numerical input)

Touch operation Touch the numerical input area.

R
es

ul
t o

f o
pe

ra
tio

n

Screen status When a key window screen appears, enter the numeric value (15), and then press 
Enter of the key window.

Write device D10

Test object

Item
Line start switch Comment display

Touch operation Touch ────

R
es

ul
t o

f o
pe

ra
tio

n Screen status The switch is pressed. Comment "Line operating" appears.

Write device M10: ON ────

Read device ──── Y7B: ON

Test object

Item
Line stop switch Comment display

Touch operation It is touched while the operation lamp is 
on.

-

R
es

ul
t o

f o
pe

ra
tio

n Screen status The switch is pressed. Comment "Line stopped" appears.

Write device M10: OFF ────

Read device ──── Y7B: OFF
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(4) Test 4
Perform the following tests in screen No. 1.

(5) Test 5
Perform the following tests in screen No. 2.

(6) Test 6
Perform the following tests in screen No. 2.

(7) Test 7
Perform the following tests in screen No. 1.

Test object

Item
Alarm screen switch

1) Touch operation Touch

R
es

ul
t o

f o
pe

ra
tio

n Screen status Switch to Base Screen No. 2.

Write device 2→D0

Read device ────

Test object

Item
System alarm

1) Operations in the training machine
Power off the Q series training machine
(After confirming Test 5, power back ON the Q series training machine.)

R
es

ul
t o

f o
pe

ra
tio

n

Screen status
The following alarm message appears:
"402 Communication timeout. Confirm communication pathway or modules."

Write device ────

Read device ────

Test object

Item
Base screen switch

1) Touch operation Touch

R
es

ul
t o

f o
pe

ra
tio

n Screen status Switch to Base Screen No. 1.

Write device 1→D0

Read device ────

Test object

Item
Sub screen switch

1) Touch operation Touch

R
es

ul
t o

f o
pe

ra
tio

n Screen status Window screen No. 1 displayed.

Write device 1→D1

Read device ────
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(8) Test 8
Perform the following tests in screen No. 1.

Test object

Item
Window screen

1) Touch operation Touch x in the upper right corner.

R
es

ul
t o

f o
pe

ra
tio

n Screen status Window screen No. 1 closes.

Write device 0→D1

Read device ────
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5.12 Training device list and sequence program
(1) Training device list

R: Reading W: Writing

POINTPOINTPOINT

To identify the device used for the project data being edited, the Device List function of GT Designer3 will be useful.
Refer to section section 5.13 of this text for details.

(2) Training sequence program

* SM412 is a special relay that makes turn ON/OFF the CPU module OS at the interval of one second.

Device Signal name
GOT 

operation Device Signal name
GOT 

operation

M10 Line start/stop W D10 Numerical input W

M30 Reset W D20 Numerical display R

Y7A RUN lamp R D0 Base screen switching W

Y7B Comment display R D1 Window screen switching W

0

M10

< D20 D10

18

M30

RST M10

RST D20

Line start/stop

+P K1 D20
Operating 

time

Planned 

operating time

Operating 

time

Operating 

time

Reset

SM412

Y7A

Y7B

RUN lamp

Comment 

display

= D20 D10
Planned 

operating time

Operating 

time

RST M10

RST M30
Reset

Line 

start/stop

Line 

start/stop
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5.13 How to check the devices used in the created 
project

To check the devices used in the created project, use the device list on GT Designer3.
Display the list of the devices used in the project which has been created in this training.

POINTPOINTPOINT

When the desired device is not shown in the list, click the Search button to specify the appropriate device.
For the details of the setting in this section, refer to the GT Designer3 (GOT2000) Screen Design Manual.

Click the [Search/Replace] - [Device List] - 
[Project] menu.

The Device List dialog box is displayed.
As a list of bit devices is shown right after the 
Device List dialog box appears, check which bit 
devices are included in the list.

Click the tab to see a list of word devices or labels.

A list of word devices or labels is displayed.
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6. About debug

This chapter describes the debug function used for troubleshooting and maintenance of the PLC system.

6.1 Extended function
To use extended functions, install the extended system applications on the GOT.

(1) List of extended functions

Function name Reference
Graphic acceleration driver

GT Designer3 (GOT2000) Screen Design Manual
Standard font
Outline font
KANA-KANJI conversion
Wireless LAN
SoftGOT-GOT link function GT SoftGOT2000 Version1 Operating Manual
System launcher

GOT2000 Series User's Manual (Utility)
iQSS utility
Sequence program monitor

GOT2000 Series User's Manual (Monitor)FX ladder monitor
Backup/Restore
Gateway

GT Designer3 (GOT2000) Screen Design Manual

Barcode
RFID
Remote personal computer operation (Serial)
Remote personal computer operation (Ethernet)
VNC server
Video/Multimedia
External I/O / Operation panel
Report
Printer
Sound output
GOT network interaction
GOT Mobile function
Device data transfer
MES interface GOT2000 Series MES Interface Function Manual for GT Works3 Version1
Device monitor

GOT2000 Series User's Manual (Monitor)

Network monitor
Log viewer
Intelligent module monitor
Servo amplifier monitor
Drive recorder
R motion monitor
Q motion monitor
CNC monitor
CNC data I/O
CNC machining program edit
CNC monitor 2
Motion program editor
Motion program I/O
Motion SFC monitor
FX list editor
CC-Link IE Field Network diagnostics
6. About debug
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Recipe operation

GT Designer3 (GOT2000) Screen Design Manual
Recipe display (record list)
Operation log screen image
Operator authentication
File manager GOT2000 Series User's Manual (Utility)
Document display GT Designer3 (GOT2000) Screen Design Manual
MELSEC-L troubleshooting function GOT2000 Series User's Manual (Monitor)
GOT platform library

GT Designer3 (GOT2000) Screen Design ManualGOT function expansion library 
(additional/MELSEC iQ-R)

Function name Reference
6 - 2 6. About debug
6.1 Extended function
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(2) Writing the extended functions
The following explains the procedure for writing the extended functions.
In this section, the sequence program monitor (ladder) and device monitor for training in section 6.3 and section 
6.4 are written.

1. Click [Communication] - [Write to GOT] from the 
menu.

2. When the Communication Configuration dialog 
appears, select the settings as follows and click 
the  button.

Connection to GOT: Direct
PC side I/F: USB

3. When the Communicate with GOT dialog 
appears, click the  button.

4. When the [Write Option] dialog appears, click 
the  button.

(Next page)

1.

2.

3.

4.
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(From previous page)

5. Select [Extended Function] - [Sequence 
Program Monitor(Ladder)] and [Device monitor] 
from the tree view, and click the  
button.

6.  Click the  button.

5.

6.
6 - 4 6. About debug
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6.2 Training screen creation
Add the following Base Screen No. 3 to the screen created in chapter 5.

Base Screen No. 3

[Operation of Base Screen No. 3]

1. When the [Run/Stop] switch turns ON, the operation will start, and the lamp will be lit.

2. As the operation gets started, the operating time starts counting. When the operation time is over eight hours, the 
lamp turns ON.

6.2.1 Screen creation training

(1) Creating and setting Base Screen No. 3
1. Create a base screen as follows:

Screen No. : 3
Screen Name: Operating time display

(Next page)

Bit lamp

Screen switching switch
Return to Base screen No. 1

Numerical display

Touch switch
Run/Stop switch (M31) 
to activate the line

Bit lamp
Lit if the operating display 
exceeds eight hours (M35).

Turns on during 
line operation (M34).

Bit lamp
Lit while the run 
command is ON (M31).

Displays the operating time 
of the line. (D32: hours, 
D31: minutes, D30: seconds)

1.
6. About debug
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(From previous page)

2. Place the numerical display, and make the 
settings as follows:

[Device] tab
Device: D30
Font: Outline Gothic
Number Size: 32
Digits (Integral): 2
Select [Fill with 0].

3. Copy and paste the numerical display created in 
, and make the settings as follows:

1) Device "D31"
2) Device "D32"

4. Create characters with text.

5. Select [Object] - [Lamp] - [Bit Lamp] from the 
menu, and then click on the screen to place a 
bit lamp.
Configure the following settings for the placed 
bit lamp.

[Device/Style] tab
Device: M34
Shape : FA Control Lamp Figure

A1:L_01_0_G
Lamp color (when it is ON): Green

[Text] tab
Font: Outline Gothic
Text Size: 16
Display Position: Down
Text: Operating
Select OFF=ON.

6. Copy and paste the lamp created in , and 
make the settings as follows:

[Device/Style] tab
Device: M35
Lamp color (when it is ON): Red

[Text] tab
Text: 8 hours have elapsed
Select OFF=ON.

(Next page)

2) 1)

2.3.

2.

4.

5.
6.

5.
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(2) Setting Base Screen No.1

(From previous page)

7. Select [Object] - [Switch] - [Bit Switch] and click 
a desired position on which a bit switch is to be 
placed.
Change the width of the switch and configure 
the settings as follows.

[Device] tab
Device: M31
Action: Alternate

[Style] tab
Shape: FA Control Switch Figure A1
Shape Color (ON): Red (100 SW_04_1_R)

(OFF): Blue (97 SW_04_0_B)
[Text] tab

Font: Outline Gothic
Text Size: 16
Text: Run/Stop
Select OFF=ON.

8. Copy the lamp created in , paste the copy 
on the screen, and configure the settings as 
follows.

[Device/Style] tab
Device: M31
Shape Color (ON): Cyan

[Text] tab
Text: Run command
Select OFF=ON.

9. Copy the Go To Screen switch (control screen) 
of Base Screen No. 2, paste the switch on the 
screen, and configure the settings as follows.

[Text] tab
Text: Base screen
Select OFF=ON.

1. Copy the Go To Screen Switch (alarm) of Base 
Screen No. 1, and change the settings as 
follows:

[Next Station] tab
Screen Type: Base
Screen No.: 3, Operating time display

[Text] tab
Text: Operating time display
Select OFF=ON.

7.

8.

9.

5.

1.
6. About debug
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6.2.2 Writing a project

Display the screen for writing the project and write all data to the GOT.
Reset the PLC CPU using the RESET key switch, and then switch to RUN.

6.2.3 Training sequence program

POINTPOINTPOINT

To identify the device used for the project data being edited, the Device list function of GT Designer3 will be useful.
Refer to section 5.13 of this textbook for details.

 21 
M31

Run/Stop

X2

Malfunction 1
M32

Dummy for 
ladder 
monitor

 34 
M32

Dummy for 
ladder 
monitor

M33

 36 
M33

M34
Operating

 38 
M34

Operating

SM412

1-sec clock
INCP D30

1-sec unit

 42 >= D30
1-sec unit

K60 INCP D31
1-min unit

RST D30
1-sec unit

 49 >= D31
1-min unit

K60 INCP D32
1-hour unit

RST D31
1-min unit

 56 >= D32
1-hour unit

K24 RST D32
1-hour unit

 61 >= D32
1-hour unit

K8 M35
8 hour 
operation

 65 END

Dummy for 
ladder 
monitor

Dummy for 
ladder 
monitor
6 - 8 6. About debug
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6.3 Sequence program monitor (Ladder)
6.3.1 Sequence program monitor (Ladder)

(1) Features
With the sequence program monitor (ladder) function, you can use the GOT to monitor or edit the sequence 
program of a controller in the ladder diagram format and change the current device values.
This function supports the display switching (decimal or hexadecimal format), the display of the device 
comments written to a PLC CPU, and the display language switching.
It is also possible to search for a contact causing a malfunction, which may lead to a reduction of factor analysis 
time.

Screen of the sequence program monitor (ladder)

(2) Functions available on the ladder monitor screen

Function Description

Edit Edit a ladder program, such as adding or deleting a ladder block.

Search 
operation

Device search Displays a ladder block containing the specified device.

Contact point search Displays a ladder block containing the specified contact.

Coil search Displays a ladder block containing the specified coil.

Step search Displays a ladder block with the specified step number.

Ladder end search Displays the last ladder block of sequence program.

Defect search
Searches the ladder for conductive/non-conductive status of the contact point that 
turned on or off the coil on the ladder.

Touch search
Searches for coils of the same device when the contact shown on the screen of 
ladder monitor function is touched, and for contacts of the same device when the coil 
is touched.

Display switching
Changes displays of decimal number, and hexadecimal number for word device, and 
displays of device comment.

Test operation Changes device values, etc.

Hard copy Saves screens of ladders in the BMP or JPEG format.
6. About debug
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(3) Required extended system application
The following extended system applications are required.
• Sequence program monitor
• GOT platform library
• GOT function expansion library

(4) Required hardware
The following hardware is required.

Hardware

Data storage (SD card, USB memory, and etc)
6 - 10 6. About debug
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6.3.2 Operation check (1)

Perform the following operation checks for screen No.3 created in section 6.2.

(1) Test
Perform the following tests in screen No. 3.

Screen No. 3 is not working properly.
Use the sequence program monitor (ladder) to diagnose the cause of the error.

Test object

Item
Operation

1) Touch operation Touch Run/Stop.

R
es

ul
t o

f o
pe

ra
tio

n

Screen state

(Under normal conditions)
The Operating lamp turns ON, and the operating time starts 
counting.

↓
(Current operations)
The Operating lamp does not turn ON, and the operating time does 
not start counting.
6. About debug
6.3 Sequence program monitor (Ladder)

6 - 11



6.3.3 Startup procedure of sequence program monitor (Ladder)

1. Hold down the upper left corner of the GOT 
monitor screen for two seconds.

2. Touch [Monitor] tab.

3. Touch [Seq. program monitor (Ladder)].

(Next page)

Utility call key

Hold down the upper left corner 

for two seconds.

Touch 

[Monitor].

Touch 

[Seq. program monitor (Ladder)].
6 - 12 6. About debug
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(From previous page)

4. The communication setting window appears.
1) The names of the communication drivers 

installed on the GOT are displayed.
2) The channel No. is fixed to "1".

5. Touch  to move the cursor to network No. [ ].

6. Set the network No. to [0].

7. Set the station No. to [FF], and touch the [Enter] 
key.

8. Set the CPU No. to [0], and touch the [Enter] 
key.

[DEL] key: Used to delete a character of 
the entered information.

[AC] key: Used to delete all characters 
indicated by the cursor.

(Next page)

5.

2)

1)

8.

6.

7.
6. About debug
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(From previous page)

9. On the [PLC Read] screen, select [Program 
Memory] from the target drive list of [PLC Drive] 
to list the files stored in the drive.

10. Touch the  key to select the 
sequence program displayed in the file list.

11.Touch the  key to write the 
sequence program to the data storage device 
selected in the target drive list of [GOT].

12.The reading of the sequence program is 
completed.
The [Program list] window appears.

13.Touch the  key.

(Next page)

9.

10. 11.

Touch 

[Display].
6 - 14 6. About debug
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(From previous page)

14.The sequence program file selected in the list of 
files (connection destination) is displayed in the 
ladder monitor screen, and functions including 
the device search can be used.
6. About debug
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6.3.4 Method for factor search operation

The factor search function searches the ladder blocks for the conductive/non-conductive status of the contact that turns 
on or off a specific coil when the sequence program monitor (ladder) is performed.
This section explains the operation procedures.

1. Touch [Find].

2. Touch [Factor search] to display the factor 
search window.

(Next page)

Touch 

[Find].

Touch 

[Factor search].
6 - 16 6. About debug
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(From previous page)

3. Touch the [M] key to enter "M" into [Factor], and 
touch [0-9] to display the number keys.

4. Set the device number to "34".

5. Touch the [Enter] key.

6. The block containing the specified device is 
displayed, and the device is enclosed in a green 
frame.

To cancel a factor search, touch the [Esc] key.
(During a factor search, all key operations 
except [Esc] and [Exit] keys are invalid.)

<Factor search Result>
The reason why M34 does not turn on is 
because X2 is not turned on.

3.

3.

4.

5.
6. About debug
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6.3.5 Operation check (2)

Display the screen for writing a project, and then write data to the GOT.
Reset the PLC CPU using the RESET key switch, and then switch to RUN.

(1) Test
Perform the following tests in screen No. 3.

Check the Operating lamp turns ON, and that the operating time counts up.

Test object

Item
Operation

1)  Touch operation Turn on X2, and touch Run/Stop.

R
es

ul
t o

f o
pe

ra
tio

n

Screen state The Operating lamp turns ON, and the operating time starts counting.

2)  Touch operation Touch Running/Stop.

R
es

ul
t o

f o
pe

ra
tio

n

Screen state The Operating lamp turns OFF, and the operating time stops.
6 - 18 6. About debug
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6.4 Device monitor function

6.4.1 About the device monitor function

(1) Features
The device monitor function monitors and changes the devices of a PLC CPU or an intelligent module.
With this function, you can troubleshoot the system and streamline maintenance.

(2) Monitoring method available with system monitor function

(3) Test operations
With the device monitor function, the following data changes are possible by performing test operations.
• Testing a bit device

A device specified by the user is turned ON and OFF.
• Testing a word device

A specified value is written to a device specified by the user. (Real number data is not allowed.)
• Testing a timer/counter

Specified values are written as the present and set values of a device specified by the user.
• Testing buffer memory

A specified value is written to buffer memory specified by the user.

Test menu screen

Monitoring method Description

Entry monitor Registers devices to be monitored in advance and monitors only the registered devices.

Batch monitor Collectively monitors the devices starting from the user-specified one.

TC monitor
Monitors timers (T) and counters (C) only.
Monitors the current values, set values, contacts, and coils of timers, counters, and retentive 
timers of a PLC CPU in a batch.

BM (buffer memory) 
monitor

Monitors the buffer memories of a special function module.
Monitors the buffer memories of an intelligent module in a batch.
6. About debug
6.4 Device monitor function
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(4) Required extended system application
The following extended system application is required.

6.4.2 Method for starting the system monitor

System application

Device monitor
GOT platform library

1. Hold down the upper left corner of the GOT 
monitor screen for two seconds.

2. Touch [Monitor] tab.

3. Touch [Device monitor].

(Next page)

Utility call key

Hold down the upper left corner 

for two seconds.

Touch 

[Monitor].

Touch 

[Device monitor].
6 - 20 6. About debug
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(From previous page)

4. The Device monitor screen appears. Touch 
the [Connect] key.

5. The communication setting window appears. 
Configure the settings as follows.

<CH No. input status window>
Ch No : 1 (Set a number using 

the channel No. 
selection keys.)

<Network No./station No./CPU No. input 
status window>

NETWK No : 0
STATION : FF
CPU No : 0

Touch 

[Connect].

5.
6. About debug
6.4 Device monitor function
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6.4.3 Operation check (device monitor operation)

In this section, the following operation checks are performed regarding the training screen created in section 6.2 using 
the device monitor of the system monitor function.

(1) Device registration procedure for device monitor

1. Display the device monitor screen by using 
the procedure described in section 6.4.2.

2. Touch the monitor category change key to 
select to [Selected] when other than 
[Selected] is selected.

(Next page)

Numerical display
Displays the operating time of the line. 
(D32: hours, D31: minutes, D30: seconds)

Bit lamp
Lit if the operating display exceeds eight hours 
(M35).

2.
6 - 22 6. About debug
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(From previous page)

3. The entry monitor screen appears. Touch the 
[Register] key.

4. The device registration window appears. 
Touch the device display area.

5. Set the device number to "D30".

6. Touch the [Enter] key.

(Next page)

Touch 

[Register].

4.

5. 6.
6. About debug
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(From previous page)

7. Register the device.

8. When registration is complete, return to the 
device registration screen.

9. Touch the [AC] key to clear the device value.

10.Set the device number to "D31" and touch the 
[Enter] key to register the device.

11.Repeat the procedures for device "D32".

12.When registration is complete, touch [x] to 
exit the device registration screen.

13.Go back to the device monitor screen, and 
the monitor just registered is being 
monitored.

Registering the device now.

Please Wait.

10.9.

12.

Operating time in units of seconds

Operating time in units of minutes

Operating time in units of hours

Word device value
Device number

Device name
6 - 24 6. About debug
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(2) Operation procedure for test operation

1. Touch the [Test] key on the device monitor 
screen.

2. The confirmation dialog is displayed.
Touch the [OK] key to switch to the test mode.

3. Touch a device targeted for the test 
operation.

(Next page)

Touch 

[Test].

2.

3.
6. About debug
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(From previous page)

4. The device value setting window appears. 
Set the device value as follows and touch the 
[Enter] key.

D30: Device value = 50

5. After the setting has been completed, touch 
[×] to exit the device value setting window.
Set the following devices in the same 
manner.

D31: Device value = 59
D32: Device value = 7

6. Check that the above set values have been 
reflected to the devices on the entry monitor 
screen.

(Next page)

4.

5.
6 - 26 6. About debug
6.4 Device monitor function
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(From previous page)

7. Touch the [Test] key again to end the test 
mode.
Touch the [Quit] key on the Device monitor 
screen.

8. When the Main menu screen appears, touch 
[x].

Touch 

[Test].

7.

8.
6. About debug
6.4 Device monitor function
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(3) Operation check

1. Display Base screen No. 3.

2. Check that the operating time indicates 
7:59:50.

3. Turn on X2, and touch the [Run/Stop] switch 
to start counting the operating time. 

4. When the operating time exceeds eight 
hours, check if the lamp turns ON.

2.

3.

4.
6 - 28 6. About debug
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Appendices

Appendix.1 Alarm

Appendix.1.1 About the alarm

The alarm display function displays the user-created comments as alarm messages, or displays the error codes and 
messages of the GOT, controllers, or networks.
This function monitors the devices, GOT, controllers, and networks, and collects alarm data from them.
This chapter explains the functions that display following alarms.

(1) Alarm types
The following types of alarms are collected.

(a) User alarm
The function that displays the user-created comments as alarm messages when an alarm occurs.
Suitable for the case in which the alarm, which is created by the user, needs to be displayed.

(b) System alarm
An error code and message are displayed when an error occurs in the GOT, controller, or network.
To display the error information of the GOT, controller, or network, use system alarms.

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Touch

Error date and time Comment

May 1, 2004 Fuse error

May 1, 2004 Oil error

May 1, 2004 Temperature anomaly

Detail

Replace the fuse of 

the power supply unit.

M100: OFF → ON
M101: OFF → ON

Error 

occurrence

400 Unable to communicate with CPU 16:40:30

9      AC down error

803 Transient error
 
 

App - 1



(2) Available functions in the alarm
The GOT collects and displays alarms as follows.

RemarkRemarkRemark
For the details of each function, refer to the GT Designer3 (GOT2000) Screen Design Manual.

Available functions in the alarm Description Remarks

Displaying the comment set previously at the 
alarm occurrence

You can register any comment for the 
user alarm.

The following display methods are available:
• Displaying comments by level in the 

hierarchy
• Displaying the comment by switching the 

language

Checking the working status of the equipment 
by displaying the alarm information

View the displayed alarm information to 
check on the operating status of the 
equipment and diagnose the cause of a 
productivity slowdown.

The alarm function displays the following 
items:
• Occurred time
• Comment
• Restored time
• Checked time
• Cum.Time
• Frequency
• Alarm status
• Down Time
• Level
• Group

Operating 
the 
display 
contents

Changing the display order by the 
setting

Set the display order for the displayed 
alarms.

You can sort the displayed alarms in ascending 
order or descending order of each condition.

Operating the alarm display by 
device

• Displaying or hiding the alarm
You can display or hide the alarm by 
the device.

• Narrowing the display contents
You can narrow the display contents 
by the device.

To narrow down the display contents, classify 
alarms into different levels and groups. Thus, 
the display contents can be narrowed by level 
or group.
Two or more items can be set as narrowing 
criteria.

Setting a display color for the 
alarm contents

By displaying different character colors 
for each alarm, you can distinguish the 
alarm type visually.

The character color can be set only for the 
alarm popup display.

Displaying the alarm only at the 
alarm occurrence

By using the alarm popup display, you 
can display the alarm only at the alarm 
occurrence without arranging the alarm 
display object.

When an object is placed on the alarm display 
position, the alarm is displayed.
Touching the alarm popup display on the 
screen switches a screen or level in the 
hierarchy, or displays the detail display.

Scrolling comment display
The comments at the alarm occurrence 
are displayed by scrolling across the 
screen from right to left.

This function displays whole comments even 
when the display area is narrow.

Writing the alarm information to 
devices

You can write the touched alarm 
information to a device.

The detail message of the selected alarm can 
be displayed in the comment display.
In addition, the contents that cannot be 
displayed due to a narrow screen can be 
written to the device.

Setting any alarm monitor device
The alarm monitor device can be set by 
the user.

Set the monitor device (alarm monitor) and the 
alarm display in different screens.

Storing the alarm data (power 
failure backup)

By storing the alarm data as alarm log 
files, the alarm histories can be stored 
even when the GOT is powered off.

The following storage methods are available:
• Storing the alarm data in data storage
• Storing the alarm data in SRAM user area

Utilizing the stored data

The stored alarm log files can be 
displayed and edited in a personal 
computer, and displayed in a graph in 
the GOT.

The following shows the utilization examples.
• Outputting the alarm log files to a Unicode 

text file or a CSV file
• Converting the alarm log file stored in the 

data storage
App - 2  
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Appendix.1.2 Collecting alarms by monitoring devices

In a user alarm monitor, the time when set conditions of devices set as the alarm detection are satisfied or comments as 
the user alarm data history to a built-in memory of the GOT.

For the screen setting, refer to the advanced course manual.

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Line No.1
A 1254

B 348

A 1254

B 348

Buffering area

Stores the alarm data 
in the buffering area.

An alarm 
occurred!

M100: OFF → ON
M101: OFF → ON

The alarm detection condition 
set by the user is satisfied.
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 Specifications of the user alarm observation
(1) Alarm detection condition and range

(a) Detection condition
• Rising (OFF to ON) or falling (ON to OFF) of the bit device
• Word device value

(b) Collection cycle (monitoring cycle)
The user alarms can be collected and updated to a buffering area of the GOT in a cycle set by the user 
regardless of a displayed screen.
The setting range of the cycle is 100 ms to 3600 seconds.

(c) Setting range
• Alarm points

The alarm points are the monitorable device points.
Up to 32767 points of devices can be monitored.

• Alarm ID
Each user alarm observation setting has an alarm ID number.
The alarm ID numbers range from 1 to 32767.
However, up to 255 user alarm observation settings can be set.

(2) Setting example

Alarm ID: 10 (An alarm for the maintenance)

D10 > 40   [Supply oil]
D20 > 500 [Supply fuel]

Alarm ID: 50 (An alarm for an emergency)

M10: OFF → ON [LineA abnormal stop]
M20: OFF → ON [LineB abnormal stop]
M30: OFF → ON [LineC abnormal stop]
M40: OFF → ON [LineD abnormal stop]

Alarm ID: 900
M80: OFF → ON [Check a battery]
M81: OFF → ON [Check the 
                              hydraulic pressure]
M82: OFF → ON [Check the 
                              internal pressure]
M83: OFF → ON [Check a fuse]

Setting

Setting

Setting

Alarm detection condition

Watch cycle 
Alarm points 

Alarm detection condition
Watch cycle 
Alarm points 

Alarm detection condition
Watch cycle 
Alarm points 

Alarm detection conditions, collection cycles (observation cycle), 
and number of alarms for each alarm ID
 Alarm ID: Up to 255 (The number for the alarm ID is 1 to 32767.)
 Number of alarms: Up to 32767 (Total number of alarms set for each alarm ID)

: 3600 seconds
: 50

: Values of 
word devices

: Bit devices
: 2 seconds
: 4

: Bit devices
: 60 seconds
: 4
App - 4  
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 How to use the user alarm observation
(1) Alarm collecting procedure and alarm history collecting method

(a) Alarm collecting procedure
The user alarms are collected to a buffering area of the user area in a cycle (1 to 3600 seconds) set by the 
user regardless of a displayed screen.
The buffering area stores the collected user alarms as histories temporarily, and displays them on the GOT 
as alarms.

• For how to delete the data in the buffering area, refer to the following.

(2) Deleting the collected user alarm data
• The data to be stored in the buffering area of the user area differ depending on the history collecting 

method.

Error date and time Comment

Jun. 1, 2013 14:46:49 Temperature anomaly

Jun. 1, 2013 13:30:14 Fuse error

Buffering area

User area

Displays the user alarm data collected 

in the buffer area as alarms.

Regardless of the displayed screen, 

errors are collected in the cycle set 

by the user (1 to 3600 seconds) 

in the buffering area.
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(b) Alarm history collecting method
The following shows the alarm history collecting method.
• History mode

Adds the alarm contents to the user area of the GOT for each alarm occurrence.
• Cumulative mode

Collects the latest alarm status and the alarm counts or time together for each alarm.
• Only the current alarm

Displays only the alarm in occurrence, and deletes the display after the alarm restoration.
Depending on the collecting method, the types of information collected differs.
Example) Alarm Display (User)

Displayed
information

Description

History mode Cumulative mode
Alarms in the 

"Occurred" status 
only

(1) Date of 
occurrence

Displays the date and time when an alarm occurs.

(2) Comment Displays the comment assigned to the alarm at the alarm occurrence.

(3) Alarm status

Displays the alarm status that is currently displayed.
• Occurred: The alarm has occurred. (The occurrence of the alarm has not been checked.)
• Checked: The occurrence of the alarm has been checked.
• Restored: The monitor target already recovered from the alarm.

(4) Restored Displays the date and time when the monitor target recovered from the alarm.

(5) Checked

Displays the date and time when an alarm occurrence has been checked.
Check the occurrence of the alarm with a touch switch for the alarm check.

(6) Frequency -
Displayed only for the cumulative mode.
Displays the number of error occurrence.

-

(7) Cum.time -

Displayed only for the cumulative mode.
Displays the total time of alarm occurrence including the past 
alarm occurrence time.

-

(8) Down time -
Displayed only for the cumulative mode.
Displays the time from the alarm occurrence to the alarm 
restoration.

-

(1) (2) (3) (4) (5) (6) (8)(7) (9) (10)

Group

Jun. 1, 2013 Checked - 2 -- 1

Jun. 1, 2013 2 00:2000:40 2 1

Jun. 1, 2013 - - - 1 -- 1

1

2

Error date and time Alarm status Restored Checked Frequency Down TimeCum. Time Level

16:10

18:30

20:00 Power supply unit error

Comment

Hydraulic pressure failure

Drive module error Checked 16:30 16:20

18:50

- -

Restored Checked

Power supply unit error

Comment

- 19:00

Restored Checked

Power supply unit error

Comment
Checked

Key code: FFB4h or FFB5h

Time

ON ON ON

OFF OFF OFF

Cum. Time

An alarm occurs. An alarm occurs. An alarm occurs.

(Third time)(Second time)(First time)

Alarm 

occurrence 

status

(M10)

Down 

time A

Down 

time B

Down 

time C
App - 6  
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(9) Level

Displays the levels set for alarms.
The alarms can be classified into the level according to the alarm importance.
You can display the alarm with higher level preferentially or display the alarms with specific level 
only.

(10) Group
Displays the groups set for alarms.
The alarms can be classified into groups according to the alarm contents.
You can display the alarms in order of the group or display the alarms with specific group only.

Displayed
information

Description

History mode Cumulative mode
Alarms in the 

"Occurred" status 
only
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(c) Alarm display example
The following shows the examples for displaying alarms with the alarm display (user) for each alarm 
collecting method.

• History mode
Collects the alarm occurrence status as histories.
The history is added every time an alarm occurs.

Temperature anomaly
(M10: OFF → ON)

Fuse error
(M20: OFF → ON)

OFF OFF

Alarm check 
by a user

ON ON

ON

11:30
(1)

12:00
(2)

15:30
(3)

18:25
(4)

19:00
(5)

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

18:25 Temperature anomaly

Comment

Temperature anomaly

Fuse error

15:30 12:00

(5) A temperature anomaly has restored.

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

18:25 Temperature anomaly

Comment

Temperature anomaly

Fuse error

15:30 12:00

(4) The restored temperature anomaly 

occurs again.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

12:00

(3) A temperature anomaly has restored.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

(2) A temperature anomaly has checked.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

12:00

(1) A temperature anomaly occurs.

A temperature 

anomaly occurs.

Displays the alarm 

adding a row newly.

A temperature anomaly 

has checked.

12:00

Displays the restored time.15:30

Displays the restored time.19:00

These items are not collected in the history mode.

Checked

Key code: FFB4h
App - 8  
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• Cumulative mode
Collects the latest alarm status, the alarm counts, and the time together for each alarm.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

18:25 Temperature anomaly

Comment

Fuse error

19:00

12:00

(5) A temperature anomaly has restored.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

18:25 Temperature anomaly

Comment

Fuse error 12:00

(4) The restored temperature anomaly 

occurs again.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

15:30 12:00 04:00

12:00

12:00

(3) A temperature anomaly has restored.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

12:00

(2) A temperature anomaly has checked.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

00:001

1

1

1

1

1

2

1

2

1

00:00

04:00

00:00

04:00

00:00

00:00

00:00

04:00

00:00

(1) A temperature anomaly occurs.

A temperature 

anomaly occurs.

Displays the alarm occurred time 

of the alarm that occurred again 

in the same line, and frequency 

is added by one.

A temperature anomaly 

has checked.

Displays the restored time, 

the down time, 

and the cumulative time.

The restored time and the down 

time are displayed.

The time while the alarm was 

occurring is displayed in Cum. Time.

Checked

Key code: FFB4h
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• Alarms in the "Occurred" status only
Collects the alarms that are currently occurring only.
The histories of the alarms that have been recovered are not stored.

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

Comment

Fuse error

(5) A temperature anomaly has restored.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

18:25 Temperature anomaly

Comment

Fuse error

(4) The restored temperature anomaly 

occurs again.

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. TimeComment

10:25 Fuse error

(3) A temperature anomaly has restored.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

12:00

(2) A temperature anomaly has checked.

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCum. Time

10:25

11:30

Comment

Temperature anomaly

Fuse error

12:00

(1) A temperature anomaly occurs.

A temperature 

anomaly occurs.

Displays alarms that 

has occurred again

A temperature anomaly 

has checked.

Deletes the restored alarms.

Deletes the restored alarms.

Not collected if only the alarms in the "Occurred" status are displayed.

Checked

Key code: FFB4h
App - 10  
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(2) Deleting the collected user alarm data
The user alarm data are stored in the buffering area in the user area of the GOT.
The stored user alarms are deleted at the following timing.
(a) Powering off or resetting the GOT
(b) Configuring the controller setting of the GOT basic setting with the utility.
(c) Writing a system application or the project data, deleting the user alarm data by the drive information of 

formatting a drive
(d) By user setting or operation

The history of alarms that have been restored can be deleted by the user.
• Deleting with a device

Turn on [Buffering Data Clear Trigger Device] set in the [Basic] tab of the [User Alarm Observation] 
dialog to delete all alarms that have been restored.

• Deleting with a touch switch
The touch switch deletes one or all restored alarms.

RemarkRemarkRemark
For the details of the user alarm observation, refer to the Chapter 9 in the GT Designer3 (GOT2000) Screen 
Design Manual.

(3) Holding the collected user alarm data
(a) Overview of the power failure backup

Once the user alarm data are stored in the data storage or the SRAM user area as the alarm log file, the 
user alarm data are held even when the GOT is powered off.
When the alarm log file is stored in the data storage or the SRAM user area when the GOT is powered on, 
the alarm log file is read automatically and the user alarm history before the power-off is restored.

Jun. 1, 2013 10:25 Drive module error

Jun. 1, 2013 09:10 Control unit error

Error date and time Comment Restored

Key code: Delete one with FFB6h.

                 Delete all with FFB7h.

Deleting a project

Jun. 1, 2013 10:25 Drive module error

Jun. 1, 2013 09:10 Control unit error

Error date and time Comment Restored

Jun. 1, 2013 11:30 15:30Hydraulic pressure failure

AAABBBCCC
AAABBBCCC

AAABBBCCC
AAABBBCCC

DDDEEEFFF

DDDEEEFFF

Data storage
The timing with which alarms are saved in the data storage can be set.
(Rise, Fall, Sampling, ON Sampling, or OFF Sampling)

Data can be saved with touch switch inputs.

Power OFF Power ON

Displays the status that 

was saved before power-off 

and the current status.

AAABBBCCC
AAABBBCCC

AAABBBCCC
AAABBBCCC

DDDEEEFFF

DDDEEEFFF

SRAM user area

Power OFF Power ON

Displays the status that 

was saved before power-off 

and the current status.

Stores the alarm data stored 

in the buffering area into the SRAM user area.

Status that was saved before power-off

Current status

Status that was saved before power-off

Current status
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• Precautions for starting the GOT
When reading and restoring the user alarm from the data storage, install the data storage on the GOT 
before powering-on the GOT.
After powering-on the GOT, the data in the data storage cannot be restored.
In addition, when the data storage is installed after the power-on, the user alarm data in the data storage 
are overwritten when other user alarm data are stored in the data storage.

(b) Performing the power-failure backup
To hold the data in the data storage, configure the setting in the [File Save] tab of the [User Alarm 
Observation] dialog, and use either of the following methods.
• Storage by the store trigger device
• Storage by the touch switch
• Storage by the Buffer Flash Forced Saving signal (GS520.b0)
To hold the data in the SRAM user area, configure the setting in the [Basic] tab of the [User Alarm Observation] 
dialog.
• Saving data to the SRAM user area

(c) Information to be stored
The information in the alarm log file to be stored in the data storage and the SRAM user area differ 
depending on the alarm collecting method.

(d) File name and storage timing
You can set any file name for each alarm ID.
You can set triggers (rise or fall) to perform the file save.

(e) Available memory capacity
The memory capacity used to retain the user alarms at power failure can be checked in the [Basic] tab of 
the [User Alarm Observation] dialog.

(f) Backing up the alarm log file stored in the data storage
Select [Automatically backup at the time of saving] in the [File Save] tab of the [User Alarm Observation] 
dialog to store the alarm log file as a backup file when the alarm log file is saved.

(g) Backing up/restoring the data stored in the SRAM user area
Backup or restore the data stored in the SRAM user area by using the [SRAM control] of the utility.

(h) Monitoring the writing status
You can monitor the status during the user alarm data writing and a writing error by using a 
device.

RemarkRemarkRemark
For the details of the user alarm holding, refer to the GT Designer3 (GOT2000) Screen Design Manual. 

Error date and time Comment

Jun. 1, 2013

Jun. 1, 2013

Write operation 
in progress

Write operation error:
Save

The status of write operations can be monitored.

Write

Temperature anomaly

Fuse error

:
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Appendix.1.3 Collecting alarms by monitoring the GOT, controllers, and 
networks

With system alarm monitors, system alarm data is stored as histories in the built-in memory of the GOT when errors of 
the GOT, a controller, or network occurs.

 Specifications of the system alarm observation
(1) Types of the alarms which can be monitored and necessary settings

(a) Alarm type
As system alarms, the following alarms can be monitored.
• CPU error

Displays an error of a controller as an alarm.
• GOT error

Displays a GOT error as an alarm.
• Network error

Displays a network error as an alarm.
The type of the alarm to be monitored is selected by setting.
Because only a specified alarm type can be displayed, alarm information can be quickly checked.

(b) Required settings for using the system alarm
To use the system alarm, select [Use System Alarm] in the [Basic] tab of the [System Alarm Observation] 
dialog and set a monitor target.
For system alarm monitors, set the type of the alarms to be collected and the collecting method of the 
alarms.

Error date 
and time Comment

Jun. 1, 2013
70   The battery voltage 
became lower than the spec.

Jun. 1, 2013
803 The transient 
error has occurred.

Jun. 1, 2013
402 A communication 
timeout has occurred.

Checked

Line No.1
A 1254

B 348

A 1254

B 348

Buffering area

Stores the alarm data 

in the buffering area.

An alarm 

occurred!

An error occurred 
in the system.
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 How to use the system alarm observation
(1) Alarm collecting procedure and alarm history collecting method

(a) Alarm collecting procedure
• CPU errors, network errors

CPU errors and network errors are collected in the cycle of three seconds in the buffering area in the 
user area of the GOT, regardless of the screen being displayed.
The buffering area stores the collected system alarms as histories temporarily, and displays them on the 
GOT as alarms.

• GOT error
GOT errors are collected in the buffering area in the user area when alarms occur.

• For how to delete the data in the buffering area, refer to the following.

(2) Recovery from alarms
• The data to be stored in the buffering area of the user area differ depending on the history collecting 

method.

Error date and time Comment

Jun. 1, 2013 14:46:49

Jun. 1, 2013 13:30:14

Buffering area

User area

Displays the system alarm data collected 
in the buffering area as alarms.

Whether the screen is displayed or not, errors are 
collected in the cycle of three seconds in the buffering area.

A communication 
timeout has occurred.
Battery voltage low or 
equipment fault
App - 14  
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(b) Alarm history collecting method
The following shows the alarm history collecting method.
• History mode

Adds the alarm contents to the user area of the GOT for each alarm occurrence.
• Only the current alarm

Displays only the alarm in occurrence, and deletes the display after the alarm restoration.
Depending on the collecting method, the types of information collected differs.
Example) Alarm Display (system)

Displayed
information

Description

History mode Alarms in the "Occurred" status only

(1) Date of
occurrence

Displays the date and time when an alarm occurs.

(2) Message
Displays an error code and massage when an alarm occurs.
For error codes and the corrective actions, refer to the following.
Massages registered in the GOT beforehand are displayed as alarm massages.

(3) Alarm status

Displays the alarm status that is currently displayed.
• Occurred: The alarm has occurred. (The occurrence of the alarm has not been checked.)
• Checked: The occurrence of the alarm has been checked.
• Restored: The monitor target already recovered from the alarm.

(4) Restored
Displays the date and time when the monitor target 
recovered from the alarm.

-

(5) Checked

Displays the date and time when an alarm occurrence has been checked.
Check the occurrence of the alarm with a touch switch for the alarm check.

(1) (2) (3) (4) (5)

Jun. 1, 2013 Checked -

Jun. 1, 2013

Jun. 1, 2013 - - -

Error date and time Alarm status Restored Checked

16:10

18:30

20:00 402 Communication timeout.

Comment

70   Battery voltage low or equipment fault

803 Transient error Checked 16:30 16:20

18:50

- -

Restored Checked
402 A communication 
timeout has occurred.

Comment

- 19:00

Restored Checked
402 A communication 
timeout has occurred.

Comment
Checked

Key code: FFB4h or FFB5h
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(c) Alarm display example
The following shows the examples for displaying alarms with the alarm display (system) for each alarm 
collecting method.

• History mode
Collects the alarm occurrence status as histories.
The history is added every time an alarm occurs.

402 A communication 

timeout has occurred.

500 The GOT built-in 

battery voltage has dropped.

Recovery 

from the 

alarm

Alarm check 

by a user
Alarm reset 

by a user

An alarm 

occurs.

An alarm 

occurs.

An alarm 

occurs.

11:30
(1)

12:00
(2)

15:30
(3)

18:25
(5)

16:00
(4)

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Error date and time

10:25

11:30

18:25 402 A communication timeout has occurred.

Comment

402 A communication timeout has occurred.

500 The GOT built-in battery voltage has dropped.

16:00 12:00

16:00 12:00

(5) The reset communication 

timeout occurs again

Jun. 1, 2013

Jun. 1, 2013

Error date and time

10:25

11:30 402 A communication timeout has occurred.

Comment

500 The GOT built-in battery voltage has dropped.

(4) Alarm reset

Jun. 1, 2013

Jun. 1, 2013

Error date and time

10:25

11:30

Comment

402 A communication timeout has occurred.

500 The GOT built-in battery voltage has dropped.

12:00

(3) Communication timeout restoration

Jun. 1, 2013

Jun. 1, 2013

Error date and time

10:25

11:30

Comment

402 A communication timeout has occurred.

500 The GOT built-in battery voltage has dropped.

12:00

(2) Communication timeout check

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

10:25

11:30

Comment

402 A communication timeout has occurred.

500 The GOT built-in battery voltage has dropped.

Occurred

Occurred

Checked

Occurred

Checked

Occurred

Checked

Occurred

Occurred

Occurred

Checked

(1) Occurrence of a communication timeout

A communication 

timeout has occurred.

The communication timeout error 

has already been checked.

The alarm status of the GOT 

does not turn "Restored".

The alarm status of the GOT 

turns "Restored" and the 

recovery time is displayed.

Displays the alarm 

adding a row newly.

Checked

Key code: FFB4h

The alarm was reset.

Reset

Key code: FFB4h
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• Alarms in the "Occurred" status only
Only the latest GOT error, CPU error, and network error are collected.
The histories of the alarms that have been recovered are not stored.

(2) Recovery from alarms
The following shows the procedure for turning the alarm status of each error to "Restored".
(a) CPU errors

Eliminate all the alarm causes of the CPU error.
The alarm status of the system error caused by the CPU error turns "Restored" by eliminating all the alarm 
causes.
When the multi-channel function is used, the alarm status of all the channels turns "Restored" by 
eliminating the alarm causes of all the channels.

(b) Network errors
Eliminate all the alarm causes of the network error.
The alarm status of the system error caused by the network error turns "Restored" by eliminating all the 
alarm causes.

(c) GOT errors
Eliminate all the alarm causes of the GOT error.
Otherwise the same alarm occurs again after the alarm status is turned from "Occurred" to "Restored".

Jun. 1, 2013

Jun. 1, 2013

Error date and time

10:25

18:25 402 A communication timeout has occurred.

Comment

500 The GOT built-in battery voltage has dropped.

(5) The reset communication 

timeout occurs again

Jun. 1, 2013

Error date and time

10:25 500 The GOT built-in battery voltage has dropped.

Comment

(4) Alarm reset

Jun. 1, 2013

Jun. 1, 2013

Error date and time

10:25

11:30

Comment

402 A communication timeout has occurred.

500 The GOT built-in battery voltage has dropped.

12:00

(3) Communication timeout restoration

Jun. 1, 2013

Jun. 1, 2013

Error date and time

10:25

11:30

Comment

402 A communication timeout has occurred.

500 The GOT built-in battery voltage has dropped.

12:00

(2) Communication timeout check

Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

10:25

11:30

Comment

402 A communication timeout has occurred.

500 The GOT built-in battery voltage has dropped.

Occurred

Occurred

Checked

Occurred

Checked

Occurred

Occurred

Occurred

Occurred

(1) Occurrence of a communication timeout

A communication 

timeout has occurred.

The communication timeout 

error has already been checked.

The alarm status of the GOT 

does not turn "Restored".

After the alarm status turns 

"Restored", the alarm is deleted.

Displays the alarm 

that has occurred.

Checked

Key code: FFB4h

Not collected if only the alarms in 

the "Occurred" status are displayed.
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Example) When the alarm of error code 460 occurs and the alarm is reset before the cause is eliminated

The alarm status of GOT errors does not turn "Restored" even after the alarm causes are eliminated. To 
turn the status to "Restored", execute any one of the following operations.

• Turning the alarm status of a selected error to "Restored"
Using a touch switch, turn the alarm status of an selected error to "Restored".

• Using the system information, turning the alarm status of all the GOT errors to "Restored"
By turning on the GOT Error Reset signal (System signal 1-1.b13), turn the alarm status of all the GOT 
errors to "Restored".

• Using a utility, turning the alarm status of all the GOT errors to "Restored"
Using the alarm display (system) utility, turn the alarm status of all the GOT errors from "Occurred" to 
"Restored".

GOT2000 Series User's Manual (Utility)

Alarm status

10:25

11:30

Comment

803 Transient error

460 Communication unit error

Occurred

Occurred

Error date and time

The status of the GOT

error turns "Restored".

After the reset, the same

alarm occurred again.

The date and time of occurrence

displayed show the date and time

when the alarm was detected again

after the reset.

Error date and time

10:25

11:30

Comment

803 Transient error

460 Communication unit error

Alarm status

Occurred

Restored

Error date and time

11:30

12:00

Comment

460 Communication unit error

803 Transient error

10:25 460 Communication unit error

Alarm status

Occurred

Occurred

Restored

Reset Reset the alarm.

(Turn on the System signal 1-1.b13.)

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Error
occurrence

Cause 

elimination

Eliminate the cause of the alarm of 

the GOT, a controller, or a network.

Error date 
and time Comment

Alarm
status

70 Battery voltage low or 
equipment fault

803 Transient error

402 A communication timeout 
has occurred.

Restored

Restored

Occurred

The alarm status of the GOT error remains "Occurred" 

even if the cause of the alarm is eliminated.

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Key code: FFB9h

Reset

Jun. 1, 2013 10:25 70 Battery voltage low or equipment fault

Jun. 1, 2013 09:10 803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Occurred402 A communication timeout has occurred.

70 Battery voltage low or equipment fault

803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Restored402 A communication timeout has occurred.Jun. 1, 2013 11:30

Jun. 1, 2013 10:25

Jun. 1, 2013 09:10

Jun. 1, 2013 11:30

Turn on the System 

signal 1-1.b13.

Reset

70 Battery voltage low or equipment fault

803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Occurred402 A communication timeout has occurred.

70 Battery voltage low or equipment fault

803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Restored402 A communication timeout has occurred.

Jun. 1, 2013 10:25

Jun. 1, 2013 09:10

Jun. 1, 2013 11:30

Jun. 1, 2013 10:25

Jun. 1, 2013 09:10

Jun. 1, 2013 11:30
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(3) Deleting alarm
Alarms in the "Restored" status can be deleted from the history.
To delete alarms, turn the alarm status from "Occurred" to "Restored".

(2) Recovery from alarms
To delete alarm data, execute any one of the following operations.
(a) Powering off or resetting the GOT

Delete alarm displays by powering off or resetting the GOT.
However, when the system alarm data is stored in the SRAM user area or a data storage device, the 
system alarm data is retained even after the GOT is powered off.

(b) Configuring the controller setting of the GOT basic setting with the utility.
(c) Writing a system application or the project data, deleting the user alarm data by the drive information of 

formatting a drive
(d) By user setting or operation

The history of alarms that have been restored can be deleted by the user.
• Deleting with a device

Turn on [Buffering Data Clear Trigger Device] set in the [Basic] tab of the System Alarm Observation 
dialog to delete all the alarm data in the "Restored" status.

• Deleting with a touch switch
The touch switch deletes one or all restored alarms.

RemarkRemarkRemark
For the details of the system alarm observation, refer to the Chapter 9 in the GT Designer3 (GOT2000) Screen 
Design Manual.

Turn on the buffering 

data clear trigger device.

Delete

70 Battery voltage low or equipment fault

803 Transient error

Restored

Occurred

Error date and time Comment Alarm status

Restored402 A communication timeout has occurred.

Error date and time Comment Alarm status

Occurred803 Transient error

Jun. 1, 2013 10:25

Jun. 1, 2013 09:10

Jun. 1, 2013 11:30 Jun. 1, 2013 09:10

Key code: Delete one with FFB6h.

                 Delete all with FFB7h.

Delete

70 Battery voltage low or equipment fault

803 Transient error

Restored

Occurred

Error date and time Comment Alarm status

Restored402 A communication timeout has occurred.

803 Transient error Occurred

Error date and time Comment Alarm status

Restored70 Battery voltage low or equipment fault

Jun. 1, 2013 10:25

Jun. 1, 2013 09:10

Jun. 1, 2013 11:30 Jun. 1, 2013 10:25

Jun. 1, 2013 09:10
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Appendix.1.4 Enabling the popup display for when an alarm occurs

In the alarm popup display, the GOT displays alarms whether or not the target object for the alarm popup display is 
placed.
Even a long comment can be displayed in the alarm popup display by scrolling across the screen from right to left.

 Specifications of the alarm popup display
(1) Types of alarms which can be displayed and necessary settings

(a) Alarm type
User alarms and system alarms can be displayed in the alarm popup display.
• Setting the alarm popup display

Set the alarms to be displayed in the alarm popup display.
• Auxiliary settings for each screen

For each base screen, set the position of the alarm popup display and whether to display or not.
Set the alarm popup display in the [Screen Property] dialog.

• When the display position overlaps with other objects
Place the alarm popup display where it does not overlap with objects. Objects hidden under the display 
cannot be operated.

• Switching the display position with touch operations
Touch the far left of the alarm popup display area to switch the display position.

Detail

Line No.1
A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

Temperature 
anomaly

Displays the alarm 

with a popup display.

Detail

A 1254

B 348

A 1254

B 348

10:30 70 The battery voltage be

Detail

A 1254

B 348

A 1254

B 348

70 The battery

Displays the alarm 

with a popup display.
Scrolls a long comment.

An alarm 

occurred! Jun. 1, 2013 10:30

Jun. 1, 2013 10:30
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(b) Float
Comments displayed when alarms occur are displayed by scrolling from right to left.
When multiple alarms occur, the alarms are displayed in order.

• When multiple alarms occur
• When setting a comment using multiple rows

After the part of the comment in the first row is displayed, the parts in the second and the following 
successive rows are displayed by scrolling.

A 1254

B 348

A 1254

B 348

Temperature 
anomaly

A 1254

B 348

A 1254

B 348

When a temperature anomaly and the fuse error occur

Fuse error

Displays alarms that have occurred 

by scrolling from right to left.

A 1254

B 348

A 1254

B 348

09:45 Fuse errorJun. 1, 2013 10:30 Jun. 1, 2013 09:45
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Appendix.1.5 Viewing the collected alarms

In the alarm display, either of user alarms or system alarms can be displayed in a list.

For the screen setting, refer to the advanced course manual.

 Specifications of the alarm display
(1) Maximum number of objects arrangeable on one screen

Up to 33 alarm displays (user) and 9 alarm displays (system) can be placed on each base/window screen.

(2) Alarm type to be displayed
Select alarms to be displayed from the following two types.
• All Alarm

When this item is set, the history of alarms including past alarms is displayed.
• Generating Alarm

When this item is set, only the existing alarms are displayed.

Display example) Alarm display (user)

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Line No.1
A 1254

B 348

A 1254

B 348

The information on alarms 

is displayed in a list.

An alarm 

occurred!

(Occurred) (Comment) (Restored) (Checked)

12:10 Temperature anomaly - -

11:45 Fuse error 12:25-

-

11:30 Oil error 12:05 11:50

10:47 Fuel error 10:55

09:30 Internal pressure error 10:14

09:45

09:48

08:58 Light error 09:15

Alarm status

Error date and time Comment Restored Checked

12:10 Temperature anomaly

11:45 Fuse error 12:25

11:30 Oil error 12:05 11:50

10:47 Fuel error 10:55

09:30 Internal pressure error 10:14

09:45

09:48

08:58 Light error 09:15

[All Alarm]

Error date and time Comment Restored Checked

12:10 Temperature anomaly

11:45 Fuse error 12:25

10:47 Fuel error 10:55

[Generating Alarm]

Because the oil error, internal pressure error, and light error 

have been eliminated, the alarms of the errors are deleted.

The history of alarms including past alarms is displayed.

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013
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 How to use the alarm display
(1) Display method of comments

• Fixed
The comments to be displayed at the occurrence of an alarm are not scrolled in the display.

• Float
The comments to be displayed at the occurrence of an alarm are displayed by scrolling from right to left.
In the scrolling display, the part of a comment that extends off the display area, and the second and the 
following successive rows of a comment that involves multiple rows are not displayed.

Display example) Alarm display (user)

Error date and time Comment Restored Checked
Jun. 1, 2013
Jun. 1, 2013
Jun. 1, 2013

Jun. 1, 2013
Jun. 1, 2013
Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013
Jun. 1, 2013

12:10 A temperature
11:45 Check the hyd 12:25
11:30 Motor error 12:05 11:50

Error date and time Comment Restored Checked
12:10 power supply unit.
11:45 raulic pressure. 12:25
11:30 Motor error 12:05 11:50

Error date and time Comment Restored Checked
12:10 unit. Check the
11:45 Check the 12:25
11:30 Motor error 12:05 11:50

Comments are displayed by scrolling from right to left.

For a comment with multiple lines, 
the subsequent lines are also displayed.

Displayed commentsWhen display type is [Flow]

Comment No. 1 (comment group)

A temperature anomaly has occurred in the 
power supply unit. Check the fuse.

Comment No. 2 (comment group)

Check the hydraulic pressure.

Comment No. 3 (comment group)

Motor error

Comment with
multiple rows
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(2) Display order of alarms
Set the display order of alarms as follows.

1. Specify an item for sorting the display of alarms.
The display of alarms is sorted according to the specified item.

Display example) Displaying user alarms in the chronological order

Setting example) Configure the setting in the [Style] tab of the [Alarm Display (User)] dialog as follows.

2. You can change the item for sorting the display of alarms.

Display example) Sorting user alarms in the descending order of frequency of occurrences

Group

Checked - 2 - 1

5 00:2004:10 2 1

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Occurred - - 1 -- 1

1

2

Error date and time Restored Checked Frequency Down TimeCum. Time Level

16:10

18:30

20:00

Comment

Hydraulic pressure failure

Checked 16:30 16:20

18:50 00:20

Checked 4 2

1 01:0001:00 2 1

1

13:30

14:00 Motor error

Checked 14:30 13:50

14:10 02:30 01:0015:00

Alarm status

Power supply unit error

Drive module error

Light error

Sorting user alarms in the chronological order

Set [Occurred] as an item 

for sorting alarms.
Set [Reverse chronological] 

as the display direction.

Group

Checked - 2 - 1

5 00:2004:10 2 1

Occurred - - 1 -- 1

1

2

Error date and time Restored Checked Frequency Down TimeCum. Time Level

16:10

18:30

20:00

Comment

Hydraulic pressure failure

Checked 16:30 16:20

18:50 00:20

Checked 4 2

1 01:0001:00 2 1

1

13:30

14:00 Motor error

Checked 14:30 13:50

14:10 02:30 01:0015:00

Alarm status

Power supply unit error

Drive module error

Light error

Sorting user alarms according to the frequency of occurrences (in the descending order)

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013
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Setting example) Configure the setting in the [Extended] tab of the [Alarm Display (User)] dialog as follows.

• When both [Display Order] in the [Display] tab and [Priority Display Attribute] in [Switching Device] in the 
[Extended] tab are set, the display order set in [Priority Display Attribute] has priority.

Switching device D100 9

The sort criteria can be changed according to the value 
in the switching device (priority display attribute).

0: Without specification
    (sorting by the occurrence date and time)
1: Occurred
2: Restored
3: Checked
4: Comment (comment No.)
5: Level
6: Group
7: Status
    (Ascending: Checked → Restored → Occurred)
    (Descending: Occurred → Restored → Checked)
9: Frequency
10: Cum. Time
11: Down Time
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Appendix.2 Data transfer to the GOT with the data 
storage

Screen data, BootOS, or CoreOS can be written to the GOT from a data storage where the CoreOS, BootOS, or package 
data has been written.
When the package data is written to multiple GOTs, using the data storage eliminates the need to carry a personal 
computer or cables, enhancing your convenience.
In addition, the GOT can be started using the package data stored in the data storage.

Personal computer (GT Designer3)

Data storage

GOT

• Installing the CoreOS

• Installing the BootOS

• Writing package data
App - 26  
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Appendix.2.1 Overall procedure

This section describes the overall procedures for data transfer to the GOT using a data storage.

*1 BootOS and package data cannot be transferred to the same memory card.
*2 Check the available space of the data storage.

The available space of BootOS and system applications can be checked in [Write to Memory Card] or [Write Option] of GT 
Designer3.

1. Personal computer → Data storage
Write each type of data (CoreOS, BootOS, or package data) installed in a personal computer to a data storage with 
GT Designer3.
For how to write each type of data to the data storage, refer to the GT Designer3 (GOT2000) Screen Design 
Manual.

POINTPOINTPOINT

To directly open the package data from the data storage, select [Directly from the memory card] for [GOT Startup 
Method] tab on the [Memory Card Write] of the Communicate with Memory Card dialog.
For how to directly open the package data from the data storage, refer to the GT Designer3 (GOT2000) Screen 
Design Manual.

2. Data storage → GOT
The following two methods are available for installing or writing each data (CoreOS, BootOS, or package data) to 
the GOT.

•How to install while the GOT is powered ON
For the installation method, refer to the GT Designer3 (GOT2000) Screen Design Manual.

•How to install package data using the utility (data control function) of the GOT
For the installation method, refer to the GOT2000 Series User's Manual (Utility).

1) CoreOS

2) BootOS

3) Package data

Drive C

• CoreOS

• BootOS

• Package data

Drive A

• Package data

Drive B

Drive E

Drive F

Drive G

• Package data

Data to be transferred

Package data
(SD card)

*1 *2

Data storage

Package data
(SD card)

SD card

USB memory( (
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POINTPOINTPOINT

Precautions for data transfer
(1) Memory card

Do not store any other data in a data storage where each type of data (CoreOS, BootOS, or package data) is 
to be written.
When the data is written, the other data is deleted.
CoreOS, BootOS, and package data cannot be stored in the same memory card.

(2) Data stored in GOT
When CoreOS, BootOS, or package data is written, all the data in the GOT are deleted.
When the data in the GOT is required, read the data in advance.

(3) Precautions for operations while CoreOS, BootOS, or package data is being written
Writing CoreOS, BootOS, or package data cannot be interrupted.
Note that the GOT may become non-functional if one of the following is performed during writing:
• Power off the GOT.
• Press the reset button of the GOT.
• Open the SD card interface cover.
• Remove the data storage.
App - 28  
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Appendix.3 About the FA transparent function
The FA transparent function allows the sequence programs of the Mitsubishi PLC to be read, written and monitored via 
GOT when the GOT is connected both to Mitsubishi GOT and to a personal computer.
Debugging, starting up, and adjustment of the sequence program can be carried out through the USB port equipped in 
front of GOT, which requires no cumbersome steps like panel opening or reconnection of cables.

RemarkRemarkRemark
For the details, refer to the GT Designer3 (GOT2000) Screen Design Manual.

Appendix.3.1 System configuration

System configuration for the FA transparent function is shown below.

Sequence program can be read, written, monitored, etc.

Bus connection cable
RS-232/RS-422 cable
Ethernet connection cable

Ethernet cable

USB cable

A 1254

348B

A 1254

348B
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Appendix.3.2 Procedures up to accessing

This section describes the system configurations using the following connection examples:
• Connection between the personal computer and GOT: USB connection
• Connection between GOT and PLC: Ethernet connection

The following shows the procedure before accessing.

(1) Setting communication interface (Communication settings)
Set the communication interface of the GOT at [I/F Communication Setting] in GT Designer3.

(2) Cable connection
(a) Connection method for USB cable

Connect the GOT to a Mitsubishi PLC.

Set the communication interface (Communication 
settings) Refer to (1) of this section

Connect the cable. Refer to (2) of this section

Access the PLC by GX Works2. Refer to (3) of this section

1. Set [CH No.] of [Standard I/F-3] to "9".

2. Set [Driver] of [Standard I/F-3] to "Host (PC)".

Connect the USB cable to the USB interface on the GOT.

1.

2.
App - 30  
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(b) Connection method for the Ethernet connection cable

(3) Access the PLC by GX Works2.
The following describes the procedures for monitoring the PLC by GX Works2 using the FA transparent function.
Refer to the GX Works2 Operating Manual for details on operation procedures for GX Works2.

(a) Connecting to PLC

Connect the Ethernet connection cable to the GOT.

1. In the [Navigation] window of GX Works2, select 
[Connection Destination] - [Current Connection] 
and double-click [Connection1].

(Next page)

1.
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(From previous page)

2. Set [Transfer Setup].
PC side I/F: Serial USB
PLC side I/F: GOT
Other Station Setting: No specification

3. Go back to [Transfer Setup], double-click [Serial 
USB] of [PC side I/F] to display [PC side I/F 
Serial Setting].

4. Check [USB] in [PC side I/F Serial Setting] and 
click the  button.

5. Double-click [GOT] of [PLC side I/F] to display 
[PLC side I/F Detailed Setting of GOT].

6. Check [via GOT(Ethernet) transparent mode] in 
[PLC side I/F Detailed Setting of GOT] and click 

.

(Next page)

2.

4.

6.
App - 32  
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(From previous page)

7. Configure the setting in [GOT (Ethernet) 
Transparent Setting].

PLC Type: Ethernet Built-in CPU
IP Address: IP Address set for Built-in 

Ethernet port QCPU

8. Go back to [Transfer Setup], click the 
Connection Test button, and check that the 
connection to QCPU is established.

7.
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(b) Monitoring PLC by GX Works2

1. In GX Works2, select the [Online] → [Monitor] 
→ [Monitor Mode] menu.

2. Monitoring of PLC starts.

1.
App - 34  
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Appendix.3.3 About the restrictions

This section describes the restrictions of the FA transparent function.
Refer to the GOT2000 Series Connection Manual (Mitsubishi Products) for details on the specifications and cautions in 
using the FA transparent function.

(1) GOT interface required to use the FA transparent function
Connect the personal computer, to which GX Works2 or any other relevant software has been installed, to the 
USB interface or Ethernet interface of the GOT.
When performing the FA transparent function, use either USB interface or Ethernet interface of the GOT.
Using both of them to perform the FA transparent function concurrently is not allowed.

(2) When the FA transparent function is used in Ethernet connection
(a) Functions of GX Developer and GX Works2

When the FA transparent function is used in Ethernet connection, the following GX Developer or GX 
Works2 functions cannot be executed.
The message [The executed function is not supported. Please check the manual and other 
documentation.] appears on GX Developer or GX Works2.

(b) GOT station monitoring function
When the FA transparent function is used in Ethernet connection, GOT station monitoring function does not 
work.
Therefore, in the cases of [no connection target], [PLC power OFF], etc., the monitoring of the GOT delays 
for the timeout time.

Unsupported functions Remarks

• Remote reset
• Remote system reset

―

• Remote RUN
• Remote STOP
• Remote PAUSE
• Remote STEP-RUN
• Remote latch clear
• Write clock data
• Clear malfunction log

Inexecutable only when all stations/groups has 
been specified.

• Remote password function
• MELSECNET diagnostics
• CC IE Control diagnostics
• CC IE Field diagnostics
• Ethernet diagnostics

(PING test/loopback test with the Ethernet module (Q series))

-

Ethernet

USB
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(3) Software available on one personal computer
When multiple kinds of software are activated on one personal computer, only one
of them is available for communications using the FA transparent function.
Do not concurrently perform any communications using the FA transparent
function. (Offline operation with each software is available.) Do not communicate with the GOT from GT 
Designer3 (including writing package data) while another MELSOFT application is using the FA transparent 
function.

GT Designer3

GX Works2 etc.

Online operation

Communication with GOT
App - 36  
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Appendix.4 Installing the BootOS
This section explains how to install the BootOS to the GOT.

POINTPOINTPOINT

(1)  Since the BootOS has been installed to the GOT at factory shipment, installing BootOS is not usually 
necessary.
However, the BootOS needs to be upgraded (newly installed) to use a function which the BootOS of the GOT 
does not support, such as an upgraded function of GT Designer3.
To initialize the GOT to the factory shipment condition, install the BootOS.

(2) When the BootOS is installed, the existing package data is automatically deleted.
If backing up the project data is required, read the project data to a personal computer or a data storage 
before installing the BootOS.

1. Click [Communication] - [Write to GOT] from the 
menu.

2. The Communicate with GOT dialog appears. 
Select [BootOS] in [Write Data].

3.  Click the  button.

4.  Click the  button to install the 
BootOS.

5. After the BootOS has been installed, click 
[Close] to close the dialog.

2.

3.

4.
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POINTPOINTPOINT

How to check the version of BootOS and package data
To check if the BootOS or package data needs to be upgraded, the current version of the BootOS or package 
data can be displayed.

(1) BootOS installed on the GOT
For the version of the standard system application, check [OS information] of the utility.

(2) For the factory default version of the BootOS installed on the GOT, check the rating plate on the GOT 
rear face.

BootOS version

(When the BootOS version is two digits, 

only the first digit is described.)

A A A A

MODEL

DATE

MADE IN JAPAN

SERIAL

MAC ADD. 123456789012
POWER

GRAPHIC OPERATION TERMINAL

PASSED

IN

GT2708-VTBA

2013-09
00013910AA00000-A

MAX 100VA
100-240VAC 50/60Hz
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Appendix.5 Installing the CoreOS
This section explains how to install the CoreOS to the GOT.
Use the data storage to install the CoreOS to the GOT.

POINTPOINTPOINT

(1) Canceling writing the package data
When writing the package data is canceled during the process, the data in the GOT may be corrupt.
When writing the package data has been canceled during the process, write the package data again.

(2) Data in the GOT before the CoreOS is installed
When the CoreOS is installed, all the data in the GOT are deleted.
When the data in the GOT is required, read the data in advance.

(3) Precautions for installing the CoreOS
The data storage of when the CoreOS is installed supports only the drive A (standard SD card).
When the CoreOS is installed, all the data in the memory card are deleted.

(4) Precautions for the utilize data and the input assist information
When [Utilize data/Input assist information] is excluded from the package data at writing, the project read from 
the GOT operates as follows.
• The accumulated input assist information return to the initial status.
• The project data is not searched for when a new project is to be created using another project.

(1) Writing the CoreOS to the data storage

1. Click [Communication] - [Write to Memory Card] 
from the menu.

2. The Communicate with Memory Card dialog 
appears. Click the [BootOS/CoreOS Write] tab.

3. Configure the following setting in [PC].
Write Data: CoreOS
GOT Type: GT27**-S(800×600)

Check the CoreOS version to be installed in 
[Version].

4. Set the drive name of the data storage for 
[Destination Memory Card].

5.  Click the  button.

(Next page)

2.

3.

4.

5.
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(2) Installing the CoreOS to the GOT from the data storage

1. Install the data storage that has been removed from the personal computer to the GOT.

2. Power on the GOT.

3. The confirmation message for installing the CoreOS appears.
To install the CoreOS, touch the screen for two seconds or longer.
To abort the installation of the CoreOS, power off the GOT.

4. When the installation of the CoreOS is completed, the completion message appears.
Touch the screen to restart the GOT.

5. Write the required package data to the restarted GOT.

POINTPOINTPOINT

• When installing the CoreOS from the SD card, close the SD card cover properly after inserting the card to start 
the installation.

• When using the SD card as a drive A, in which the CoreOS has been installed, delete the CoreOS in the SD 
card or format the SD card before use.

(From previous page)

6.  Click  button to install the CoreOS.

7. After writing to the data storage is completed, 
remove the data storage from the personal 
computer.
Refer to the following to install the CoreOS to 
the GOT.

6.
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(3) Checking the CoreOS version

1. Hold down the upper left corner on the GOT 
monitor screen for two seconds.

2. Touch the [Maintenance] tab.

3. Touch [GOT Information].

(Next page)

Utility call key

Hold down the upper left corner 

for two seconds.

Touch 
[Maintenance].

Touch [GOT 
information].
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(From previous page)

4. The [GOT information] window appears. Check 
the CoreOS version.
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Appendix.6 Reading the project data
This section explains how to save the project data as a file for GT Designer3 from built-in memory of the GOT. 

1. Click [Communication] - [Read from GOT] from 
the menu.

2. The Communicate with GOT dialog appears. 
Select Project Data in [Read Data].

3. Set the storage destination of the project data to 
be read.

Click the  button.

4. The [Save As Project] dialog appears. Select 
[My Documents].

5. Set the file name of the project to be saved as 
follows.

File name : "GT Designer3"
Save as type : Project Data(*.GTX)

6.  Click the  button.

(Next page)

2.

3.

4.

5.

6.
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(From previous page)

7.  Click the  button.

8. The confirmation message that the drive 
information was acquired appears. Click 

.

9.  Click the  button.

10. Click the  button to read the project 
data.

When the read is completed, confirm the data 
in "My Document".

7.

9.
App - 44  
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Appendix.7 Checking operations (simulator)

RemarkRemarkRemark
This section explains the simulations connected to a sequence program (GX Simulator2).
(For the details of simulations connected to the PLC CPU and description not indicated in this section, refer to the 
GT Designer3 (GOT2000) Screen Design Manual.)

(1) Preparing a sequence program
Open a sequence program to be monitored using simulators from GX Works2.

(2) Starting the simulator for the PLC
Start GX Simulator2 from GX Works2.

1. Select [Debug] → [Start/Stop Simulation] from 
the menu bar of GX Works2.

2. GX Simulator2 starts.

1.
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(3) Starting the simulator for the GOT to check the created screen
Start GT Simulator3 from GT Designer3 (GOT2000) to check the created screen.

1. Select [Tools] → [Simulator] → [Set] from the 
menu bar of GT Designer3 (GOT2000).

2. When the dialog shown left appears, select GX 
Simulator2 for Connection.

3. Click the [OK] button to complete the settings.

4. Select [Tools] → [Simulator] → [Activate] from 
the menu bar of GT Designer3 (GOT2000).
Debug the program after starting the GT 
Simulator3.

1.

2.

3.

4.
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POINTPOINTPOINT

(1) Functions not available in GT Simulator3
Some functions are not available in GT Simulator3.
Check the GOT for the functions that cannot be simulated and actual GOT display.

(2) How to reflect an editing project to GT Simulator3
Select [Tools] → [Simulator] → [Update] from the menu bar of GT Designer3 (GOT2000).
When reflecting the editing project to the GOT, perform "GOT Write" separately after connecting the GOT.

(3) Precautions when exiting the simulator
GX Simulator2 cannot be exited while GT Simulator3 is running.
After exiting GT Simulator3 by selecting [Tools] → [Simulator] → [Exit] from the menu bar of GT Designer3 
(GOT2000), select [Debug] → [Start/Stop Simulation] from the menu bar of GX Works2 to exit GX Simulator2.
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Appendix.8 GOT function
The GOT has various functions useful on sites.
This section introduces some of the functions.

Touch the switch to change the value of a 
word device.

Touch the switch to switch the screen to the 
utility screen or other screens.

Word switch Special function switch

Touch the switch to switch the base and 
window screens.

Go to screen switch

Key window display switch
Displays a specified key window at a specified 
position, or displays a cursor on a specified 
object.

Touch the switch to turn on or off a bit device.

Bit switch

Touch the switch to switch the station number 
of the controller to be monitored.

Change station No. switch

Change the
monitoring
target.

Changes the color of a lamp.

Lamp display

Key code switch

Base screen 1 Base screen 2

150 150

M0: ON→OFF

This switch can be used as a key for entering 
numerical values or text.

D100:
200→350

Lamp, switch
App - 48  
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Values are written into devices.

Numerical input
A device value is displayed with a numerical 
value.

Numerical display

D100: 334 STOPD100: 45

334D100
45D100

Character codes are entered to a device.

Text input

D10: 4241H (BA)
D11: 4443H (DC)

A device value is displayed with a character.

MITSUBISHI

Text display

STOP

Comment display
A comment is displayed.

RUN STOP

The date and time are displayed.

Clock display

15:27

Numerical and text display

004D: M
0049: I
0054: T
0053: S
0055: U

0042: B
0049: I
0053: S
0048: H
0049: I

07/08/24

A B C D
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Alarm

Simple alarm display System alarm display

Alarm popup displayAlarm display

Parts
Parts movementParts display

Displays GOT errors, communication errors, 
the message created by users as history when 
an alarm occurs. 
Alarms are displayed hierarchically.

Displays GOT errors, communication errors, 
messages created by users with pop-up 
windows when an alarm occurs.

Displays registered parts. Displays movements of parts.

Displays a message created by users when 
an alarm occurs.

Displays GOT errors and communication errors 
when an alarm occurs.

13:25 Line A stop

13:25 Line A stop
13:05 Upper limit over
13:03 Motor trip

Time Message

02/04/18  13:25:40
Line stop

307 No monitor device 
is set.

Part 1 Part 2
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Graph, meter * These are just some examples. 
  Other functions are also provided.

Statistics graph display Historical trend graph display

Level displayPanel meter display

Condition → Operation
Time action functionLogging function

A device value is displayed with a meter.

Multiple device values are displayed in a graph 
with the percentages of total.

A device value is displayed with the percentage 
of total.

Pie graph Bar graph

Data including past and present data collected 
using the logging function is displayed with a 
trend graph.

Device values are collected and stored. Devices can be written on a specified date and 
time.

→  

* These are just some examples. 
  Other functions are also provided.

RecipeSlider
Recipe functionSlider

The status of devices is monitored, and the device 
values are read or written when conditions are satisfied. 
Multiple values can be set for one device. 
Device values can be read and written using the utility.

Use the slider to set continuous values to the 
device within any setting range. 
The value of the destination where you stop the 
knob is input to the device.

Read/
Write

D100:
D101:
D102:

150 250
500300
235208

Changing the set output 
with the slider

Production line
Current output
Set output

Production line
Current output
Set output
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External I/O * These are just some examples. 
  Other functions are also provided.

Others

Device monitor Backup/Restore

Language switchingDocument display

Monitors the status of the PLC devices. The settings of the controller can be backed 
up or restored from the GOT.

Multiple languages can be switched to display 
an appropriate one.

Document data can be displayed on the GOT.

Barcode Operation panel

Video displayReport

Data read with the barcode reader is written 
to devices.

Devices are written by operating the operation 
panel.

Collects data such as production 
management and production status and prints 
the collected data.

Displays video images.s.

M10   ON
M20  OFF
D100 255

Backup

Restore

* These are just some examples. 
  Other functions are also provided.

150

English

Hello

M10      ●
M20      ○
D100  255
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Appendix.9 Screen gesture function
This function enables zooming and scrolling the monitor screen of the GOT.
The displayed contents of the objects can be scrolled or zoomed in and out touching directly the GOT screen by gestures 
such as pinching out and in.

POINTPOINTPOINT

The screen gesture function is enabled by default.
If the screen gesture function is disabled, configure the setting according to the following procedure.
Select [Common] → [GOT Type Setting] from the menu bar to display the [Type Setting] dialog.
Select [Use the gesture function] and click the [OK] button.
The screen gesture function is enabled.

(Example) Pinching out the screen to zoom in the displayed contents

(Example) Pinching in the screen to zoom out the displayed contents
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(1) Creating an object for the screen gesture
Place the switch for switching to the screen gesture mode.

1. Select [View] → [Docking Window] → [Library 
List] from the menu bar.

2. Click the  icon on the [Library List] window.

3. Select [System Library] → [Search By Function] 
→ [Gesture] from the displayed pull-down 
menu.

(Next page)

1.

2.

3.
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(From previous page)

4. Double-click [Gesture_Title(VGA)].

5. The registered styles are displayed in a list.
Click [1 Gesture01_B].

6. Move the cursor to the screen editor, and click 
the top left of the screen.
(The broken line that indicates the size of the 
object appears.)

The object for the screen gesture is placed.

4.

5.

6.
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POINTPOINTPOINT

Functions of the object for the screen gesture
• Switching to the screen gesture mode

Touching the following icon switches to the screen gesture mode.

• Canceling the screen gesture mode
Touching the following icon during the screen gesture mode cancels the screen gesture mode.

• Full scale display (100%)
Touching the following icon resizes the screen enlarged using the gesture function to the actual size (100%).
App - 56  
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(2) Displaying the screen gesture inactive area
The screen gesture inactive area, the area for 32 dots from the top of the screen, is not the target to be zoomed 
in and out and scrolled during the use of the gesture function.

1. Select [Screen] → [Screen Property] from the 
menu bar.

2. Select [Display the screen gesture inactive 
area].

3. Click the [OK] button.

4. Setting the screen gesture function is 
completed.

1.

3.

2.
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(3) Using the screen gesture function
The monitor screen can be zoomed in and out by using the screen gesture function.

1. Touch the switch for switching the screen 
gesture mode.

2. A red line indicating the area that can be 
zoomed in and out appears.

3. The screen can be zoomed in and out by 
pinching out and in this area.

(Next page)

1.

3.
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(From previous page)

4. To cancel the screen gesture mode, touch the 
switch for switching the screen gesture mode.
The screen gesture mode is canceled and the 
screen display remains enlarged.

5. To change the display to the full scale, touch the 
full scale display (100%) switch.
When the screen display is changed to the full 
scale during the screen gesture mode, the 
screen gesture mode is canceled and the 
screen is displayed in the full scale.

4. 5.
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Appendix.10 Glossary
This glossary explains the terms used in this document.

Access key
A key used instead of selecting menu items for GT Designer3 or other applications.
The underlined letter in a menu item shows its access key.

Address
A position in memory.
The PLC has various devices, including data registers (D) and internal memory (M). The
positions in these memories are called addresses.
Addresses are expressed in decimal or hexadecimal format.
Hexadecimal format: X, Y, B, W
Decimal format: All addresses other than the above

Alignment
The figures and objects in the selected area are aligned with the specified method.
Besides up/down/left/right and center, there is also top-justified or left-justified alignment.
With top-justified alignment, all the figures including the most upper left and the most right bottom figures in the 
alignment area are justified. This is useful for uniform-interval layout of numbers in tables and other objects.

Attribute (change)
The polyline/fill pattern/text status are called attributes. Changing the status of an attribute is called attribute 
change.
· Polyline: Line style/line width/color
· Pattern: Line style/color
· Text: Font, vertical magnification ratio/horizontal magnification ratio/direction/style/background color/color

Backlight
This is a fluorescent lamp that shines light from the rear of an LCD in order to display with the LCD.

Base screen
The screen displayed over the entire GOT display area.

Bit device
Located in the PLC device, and transmits information with one bit.
In a GOT, each bit of a word device can be used as a bit device.

Bit map (BMP)
This is a file format for storing pixel images and is indicated with the extension (.BMP).
In a GOT, bit maps can be used as figure or part data.
BMP files can be output with image scanners or commercially available graphics software.

Blink
Makes the display go on and off repeatedly and cyclically.

BootOS
The BootOS is used to activate the GOT.
It is installed on the GOT by factory default.

Buffer memory (G)
Memory unique to PLC special function module it can be read and written directly from a GOT.

A

B
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Cascade (menu)
When a GT Designer3 menu is selected, the menu is selected is displayed lined up from top to bottom.
When an item in this vertical menu is selected, a horizontal menu is displayed on the left. This state is called 
cascade display.

Click
Moving the cursor to the desired position on the screen, then pressing the mouse button once is called clicking. 
Pressing the mouse button twice in a row quickly is called double clicking.
Moving the mouse cursor to the desired position holding down the mouse button, then releasing the mouse button 
is called dragging.

Communication driver
This is one of system applications for communicating with a PLC.
A dedicated communication driver is provided for each communication format such as the bus connection and 
direct CPU connection.

CoreOS
The CoreOS is used to activate the GOT.
It is installed on the GOT by factory default.

Counter (C)
This is a device that counts how many times the input came ON and switches the contact ON when the set value 
is reached.
To clear a counter value, it is necessary to reset the counter with a reset command.

Cyclic communication
This is a function for data communication between stations on the same network with MELSEC.
This function uses the link relay (B), link register (W), link input (X), and link output (Y) devices.
A GOT directly connected to MELSECNET/H, CC-Link IE Controller Network can use B and W as its own station 
devices.

Data register (D)
This is a PLC register for storing numbers. It is also called a D register.
A data register can handle 16-bit or 32-bit data.
With some PLC types, the data registers can handle not only integers, but real numbers as well.
The GOT has dedicated GD registers.

Data storage (SD card and USB memory)
Storing screen data in a data storage enables a high-speed copy when the screen data is copied to another GOT.
If alarms have been stored under the alarm observation, the previous data can be displayed even when the GOT 
is turned off.

Default value
This is the initial value.

Device
This is the general name for memory in the PLC CPU.
There are various devices, such as input (X), output (Y), and data register (D), for various applications.

Display conditions
Only when the specified condition is satisfied, an object is displayed.
The condition type can be set to "Ordinary", "ON", "OFF", "Rise", "Fall", "Rise/Fall", "Sampling", "Range", "Bit 
Trigger", "ON Sampling", and "OFF Sampling".

Display Method
The display color, operations, etc. can be changed for each specified range.
The display area corresponding to monitor device value is specified by a comparison expression.

C

D
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Edge trigger
A trigger that updates the data display when the rising or falling edge of the specified bit is detected. Even if the 
trigger is not generated, the data can be forcibly displayed ON at the first time after the screen is switched.

Edit Vertex
This is an editing function for changing the position of vertices of polygons or consecutive straight lines after 
drawing.

EN Standard
Indicates a product that conforms with EC directives.
The EN Standard is one standard in EC directives (laws).
There are three main relevant EC directives: EMC directives, low-voltage directives, and mechanical directives. 
The EN Standard is the standard used for products meeting these directives. (example safety)

Ethernet connection
This is a connection method using typical network standards for personal computers.
A PLC and a GOT are connected using the Ethernet cable.

Extended system application
Application that is required for using some functions, such as the system monitor function and the logging 
function.

Extension cable
This cable connects the PLC extension base (basic base) and the GOT when the PLC and GOT are connected 
with a bus connection.

Extension file register (R)
These are file register extension registers in the PLC memory cassette.
The extension file register capacity is set with parameters.
The capacity that can be set depends on the CPU used and the memory cassette capacity.
Indicated with R with MELSEC-A.
Indicated with R and ZR with MELSEC-QnA.
Indicated with R and ZR with MELSEC-QnU.

Falling (trigger)
This is the status when the devices goes from ON to OFF.
With a GOT, the condition established just once at the fall is called a falling trigger.
Be aware that after the device falls, if the time until it comes ON is short, sometimes the fall cannot be detected 
and display is not possible.
When [Display objects immediately after the screen is switched regardless of display conditions] is selected, data 
can be displayed even if the trigger condition is not satisfied when the screen is switched.

File register (R)
These are extension registers for when data registers (D) are insufficient.
The file register capacity is set with parameters.
The capacity that can be set depends on the CPU used and the memory cassette capacity.

Free location touch switch
Free location touch switches are so called because they are touch switches with a minimum of 2-by-2 dots, and 
they can be located freely per dot.
The enabled/disabled area can be specified and the switch can also be protected conditionally.

Graphic operation terminal
The name of the Mitsubishi Electric display unit.
The name GOT is an acronym for Graphic Operation Terminal.

E

F

G
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Handle
This is the small filled square displayed on the rectangle surrounding a figure when a figure is selected. Moving 
the mouse cursor here changes the shape of the cursor.
If the mouse is moved with the left mouse button held down, the figure size can be changed.
By holding down  key while the above operation, the figure size can be changed while maintaining the 
aspect ratio.

Icon
In Windows, a picture selected (by double-clicking it with the mouse) in order to execute an application such as 
GT Designer3.

Install
To register application software on a personal computer.

Instantaneous power failure
A power failure of extremely short duration.
The PLC/GOT do not treat a power failure lasting less than 20 ms as a power failure.
A power failure lasting longer than this results in initial processing the same as when the power is first switched 
ON.

Interlock
This is a block that prevents the system from shifting to the next operation until the operation being executed is 
completed. Interlocks are used to prevent devices from going out of control or being destroyed.
Normally, interlocks are put in place using bit devices.
Such signals are called interlock conditions.

IP67F
IP is the abbreviation for International Protection; this indicates a product that conforms with
IEC standard 529.
IP 6 7 F

Option code (Class, A-Z, for protection against oil penetration)
No. 2 code (Class, 0-8, for protection against water penetration)
No. 1 code (Class, 0-6, for protection against human body and solid foreign matter)
Protection characteristic function

The degree of IP67 protection
No. 1 code = 6: No dust penetrates.
No. 2 code = 5: Is not harmed by direct spraying of water, for example at locations cleaned periodically.
Option code = F: Is not harmed by oil drops or application of oil, for example at locations cleaned periodically.

ISO9001
ISO9000 covers a series of standards from the International Standard Organization. These are international 
standards prescribing quality system requirements with the objective of assuring quality to customers.
ISO9000 covers four standards: ISO9001, ISO9002, ISO9003, and ISO9004.

JPG
This is a file format for storing pixel images and is indicated with the extension (.JPG). In a GOT, JPG format files 
can be used as figures or part data.
JPG format files can be output with image scanners or commercially-available graphics software.

H

I

J

Shift
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Key window
This is a window for inputting numerical values and characters which are used for objects including numerical 
input and text input.
The type of the standard key window to be displayed changes automatically according to the data type of the 
input area (hexadecimal number, decimal number, octal number, binary number, or character string).

Layer
This is a function that divides a single screen into two structures, the front screen and the back screen, making it 
possible to set objects for each layer separately.
Objects set for the front screen layer and back screen layer respectively can also be displayed overlaid.

Layer processing
Name of operation processing for screen switching.
Since the screen switching is layered, it can be executed automatically without setting the layer structure.

Level trigger
A trigger that always updates the data display timing only when the specified bit is ON or when it is OFF.

Library
A library comprises figures and objects and is a group of information having one meaning.
The individual group information becomes a template.
A screen can be created by pasting the templates on the screen in the appropriate combination.

Maximize button
The maximize button is at the right of the window title bar. Clicking this button expands the GT Designer3 or other 
application to be displayed over the entire screen (maximized display).

Maximize display
This is the act of displaying GT Designer3 or some other application over the entire screen or the state in which 
the application is so displayed.

Menu bar
The menu bar is positioned one row beneath the application window title bar.

Message display
Displays explanations of operations, functions, etc. for the processing (function) selected by the user.

Momentary
This is a function that switches ON the specified bit device only during touch switch input.
This function can also switch ON specified bits of buffer memory or word devices.

Multi-language type
A GOT supports about 26,000 different characters for the writing systems of various nations as standard, so it can 
be used in the nations of the world. For example, Japanese users can use the KANA-KANJI conversion function 
to input text.

Multi-task real-time OS
A multi-task OS executes multiple tasks on a computer simultaneously.
Through the use of such an OS, a GOT can control communications, display, input, etc., all in real time.

Number keys
These are the keys for inputting numbers 0-9.
A GOT has system number key windows, so there is no need to set (create) the number keys on the screen.

K

L

M

N
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Object
This is the general term for the targets which are placed on a screen and operate according to the PLC device 
memory (bit, word).

Object gesture function
This is a function to scroll or zoom in and out the displayed contents of objects with gestures such as a flick.

Operating ambient temperature
This is the operating ambient temperature range after the device power is switched ON.
Since the PLC is normally installed in a control panel, the temperature mentioned above means in the control 
panel.
Pay attention to the fact that part of the GOT is in the control panel and part is outside the control panel, and those 
parts have different operating ambient temperature. (See below.)

Display section: 0 to 50 C
Other than display section: 0 to 55 C

Operating condition
Only when a setting condition is satisfied, an operation is performed.
The condition type includes "Ordinary", "ON", "OFF", "Range", and "Multiple Bit Trigger".

Operating System (OS)
Generally, this means the basic software for computers, etc. This is the software for running programs created by 
the user.
In the PLC, the OS is for running the sequence programs and in the GOT, the OS is the program for operating the 
screen or touch switches as set and is supplied by Mitsubishi Electric.

Ordinary trigger
A trigger that constantly updates the data display.
Output (Y)
This signal outputs PLC calculation results to external devices with ON/OFF.
The device name is expressed with Y.
The PLC output module has relays, triacs, and transistors.

Ordinary write
To update the contents displayed when there is any change in the data, rather than using a
trigger in the display or input state as the trigger for data display or input.
See "Trigger write".

Overlap window
A pop-up screen that appears over the base screen.
Up to five overlap window screens can be displayed on one base screen.

Package data
This data consists of a project, standard system application, extended system application, communication 
driver, and special data.

Parts
Parts comprise figures and are used with the "parts display" and "parts movement" functions.
The figures that can be used in parts include text and image data.

Parts movement (locus display)
This operation erases the parts (figures) displayed just before, moves the parts to the specified new position 
(according to the coordinate device value), and displays it there.
With parts movement, it is also possible to remain the parts displayed just before the movement.
Such display is called parts locus display.

Password
The GOT2000 has three types.

Screen security password
Functional operation security password
Data transfer security password

O

P
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PNG
This is a file format for storing pixel images and is indicated with the extension (.PNG). In a GOT, PNG format files 
can be used as figures or part data.
PNG format files can be output with image scanners or commercially-available graphics software.

Project (file)
The collection of all the information displayed on a single GOT is called a project.
A project comprises screen information, parts information, etc.
This information (project) is created in one file.

Read
This is an operation to read project data from the GOT with GT Designer3.
The read project data can be re-edited before the retransfer (write) to the GOT.

Recipe
The recipe function writes and reads the values of devices specified by the PLC CPU according to the 
specification conditions (device ON/OFF). The read data can be stored in a binary, Unicode text, or CSV file in a 
data storage. Thus, the data can be edited on a personal computer.

Rising (trigger)
This is the status when the devices goes from OFF to ON.
With a GOT, the condition established just once at the rise is called a rising trigger.
Be aware that after the device rises, if the time until it goes OFF is short, sometimes the rise cannot be detected 
and display is not possible.
When [Display objects immediately after the screen is switched regardless of display conditions] is selected, data 
can be displayed even if the trigger condition is not satisfied when the screen is switched.

RST (Reset)
To switch OFF the bit device or the specified bit of the word device of the PLC.

Screen
There are two types of screens: the base screen and the window screen.
The screen comprises objects and figures.

Screen gesture function
This is a function to zoom and scroll a user-created screen while the screen is displayed on the GOT.
Even though many objects are placed on a screen, zooming the screen can prevent erroneous operations.

Screen preview
This function can reproduce the screen display image or other displays on GT Designer3.

Screen saver function
This is a function that turns off the display on the GOT display if it goes untouched for a certain period of time.
While the display is OFF, the display can be switched to ON by touching any on the screen.
In this case, the touch switch being pressed does not operate.

Screen switching
This switches between the GOT base screen and window screen.
To switch between the screens, the word device for base and for window screen switching must be set.
In addition to the PLC word devices, GOT dedicated devices (GD) in the GOT can also be used.

Script function
The script functions are functions designed to control the GOT display with the GOT’s original programs.
Controlling the GOT display with the GOT side script drastically reduces the load on the system side (example 
PLC CPU, microcomputer) display.

Self check
This is a function with which the GOT (CPU) detects its own errors.
This function tests the GOT hardware, communications, memory, display, etc.

Serial communication
This is a method of communication that sends the data per bit along one line as the time goes by.
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Serial communication unit
The module that provides the functions for connecting with the PLC and a computer (GOT or personal computer) 
and for reading/writing PLC devices.
Connect the serial communication module to the GOT built-in interface or the communication unit.

SET (Set)
To switch ON the bit device or the specified bit of the word device of the PLC.
The signal switched ON remains ON until it is reset.

Shift JIS code
Shift JIS is a Kanji-character encoding, which is commonly used and practically standardized for expressing 
Japanese characters in the personal computer.

Shortcut keys
Shortcut keys are keys or combinations of keys that allow operations without opening the menu.
Shortcut keys operate combining alphanumeric keys with  key or  key.

Special (D)/(SD)
These are registers with determined applications in the PLC.
A variety of information can be viewed, including PLC CPU information and MELSECNET information.
The QCPU and QnACPU have dedicated SD devices.
With the ACPU, these are D9000- .

Special internal relay (M)/special relay (SM)
These are internal relays (M) with determined applications in the PLC.
A variety of information can be viewed, including PLC CPU information and MELSEC information.
QCPU and QnACPU have dedicated SM devices.
With the ACPU, these are M9000- .

Standard System Application
The basic system application is used to operate the GOT and display the utility.

Status display bar
The status display bar is the bottom line of the GT Designer3 display. It displays guidance, cursor information, 
position information, etc.

Superimpose window
A window superimposed on a base screen and displayed as a part of the base screen.
Up to two (superimpose window 1 and 2) superimpose windows can be displayed simultaneously.

System information
This function transmits the GOT status (screen number being displayed, error number, etc.) to the PLC, and 
outputs information (GOT error resets etc.) from the PLC to the GOT. This function is set to a word device.
A read device reads information to the GOT.
A write device writes information from the GOT.

Template
Templates are for easily saving and editing figures and objects.

Text Display
Character string data is input and displayed.
Character string data can be written to the word devices and the buffer memory in a special function module.

Text file
This is a file containing only letters, numbers, and symbols.
A comment can be output to a text file, edited with an editor, and the edited file can be input.
Since object settings and other GOT screen information can be output to a text file with the print function, it is also 
possible to read this file into a word processor and create an original document.
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TFT
A color liquid crystal display using TFTs (Thin Film Transistors).
Thin-film transistors are laid out at the intersection of transparent electrodes lined up vertically and horizontally. 
This is an active-matrix type of LCD in which the liquid crystal is driven by these thin-film transistors so laid out.
The response is fast. For color display, there are three TFTs for each pixel, and the light from each TFT is passed 
through a red, green, or blue color filter.
Compared to simple matrix LCDs, there is no tendency to low contrast, and the number of scanning lines can be 
increased, and intermediate tone expression is also easy, so this type of LCD can display with high quality. On the 
other hand, the structure is complex, resulting in high cost.
On the GOT2000, display is 65536 colors.

Timer (T)
This is a device that has the function of operating the timer coil after the specified time (timer setting value). The 
objective is to delay or hold an operation.
The timer has a variation range of 0.01 msec to 1000 msec.
The timer has a contact, coil, current value, and setting value. On the GOT monitor screen, all of these except the 
setting value can be monitored and written.
The setting value can be monitored/written with the system monitor function.

Title
With GT Designer3, a project title and a screen title can be set.
Project title: Consists of title information, detailed information, and creator's name.
Screen title: Consists of title information and detailed information.

Tool bar
This is a list of buttons etc. for menu items used relatively frequently.
The following types of GT Designer3 toolbars are available.
Tool bar (Standard) : The standard group of functions such as New or Save
Tool bar (Window display) : A group of functions for displaying or hiding windows
Tool bar (View) : A group of functions for setting the display, such as screen zoom or 

grid color
Tool bar (Screen) : A group of functions for creating a new screen or setting the display of 

a screen being edited
Tool bar (Edit) : A group of functions for editing a selected figure
Tool bar (Figures) : A group of functions for setting figures such as straight line or text
Tool bar (Objects) : A group of functions for setting objects such as touch switches
Tool bar (Alignment) : A group of functions for arranging the positions of figures and objects
Tool bar (Draw) : A group of functions for setting display attributes such as the line style 

or pattern foreground color
Tool bar (Communications) : A group of functions for data transfer between a GOT and personal 

computer card
Tool bar (Simulator) : A group of functions for starting up and setting GT Simulator3
Tool bar (Coordinate/size) : A group of functions for setting the coordinates of a selected figure
Tool bar (My favorites) : A group of functions for displaying the registered favorite figures and 

objects in the [Library] window.
Touch switch

By pressing the screen, screen switching or writing to a device can be performed.
The minimum size is a unit of 2-by-2 dots.

Transparent function
When connecting a GOT and PLC CPU with direct CPU connection, a bus connection, or Ethernet connection,  
connecting a personal computer or other peripheral device allows the sequence programs of the CPU to be read, 
written and monitored.

Trigger write
Operating (displaying or writing) only when the set conditions are met.
These conditions are called trigger conditions. 
See "Ordinary write".
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Unicode
Unicode is an international standard for character codes.

USB connection
A personal computer and a GOT are connected using the USB cable.

Window screen
A pop-up screen that appears over the base screen.
To move a window screen to any other position on the base screen, touch the window title bar and then touch the 
desired position on the base screen within three seconds.
A window screen can be closed by touching the [] button at the top right of the window screen.
If a touch switch on the base screen is overlaid by the window screen, that switch is disabled.

Wireless LAN
This is a LAN (Local Area Network) that transfers data using a wireless distribution method.
To set up wireless LAN, a wireless LAN master device (access point) and a wireless LAN slave device (station) 
are required. When a wireless LAN communication unit is mounted on the GOT, wireless communication between 
a GOT and a personal computer via the access point is enabled using the wireless LAN communication unit as a 
station.
With the FA transparent function, wireless communication between a PLC and a personal computer is also 
enabled.

Word device
Of the PLC devices, word devices are those that transmit information with 16 bits (one word).
With a GOT, word devices can be handled with 16 bits or 32 bits.
As data types, word devices support signed integers, unsigned integers, and real numbers.

Word set
This is a function that writes the specified value to a word device when there is input at a touch switch.
The specification type can be selected from fixed value, value of another word device, and fixed value added to 
(or subtracted from) the current device value.

Write
GOT package data is written to a GOT from GT Designer3.
This function is called "Write". To execute the function, select [Communication] - [Write to GOT] from the menu.
Although the data necessary for a package data is automatically written at the package data writing, only the data 
that the user requires can be written.
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